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OpenWay® Tools is a group of applications used to program, read, and diagnose Itron OpenWay 

CENTRON® meters. It consists of several major software tools that are explained in the following sections: 

 OpenWay Field-Pro™ 

 OpenWay Shop Manager 

 ZigBee® Device Manager 

 OpenWay CENTRON Validation Tool 
 

 

 

Using OpenWay Tools Help 

You can display a help topic for any window in OpenWay Tools by clicking the Help button  on the 

window or by pressing F1. You can display help for the Field-Pro application by selecting Index from the 

Help menu on the menu bar.  

In the help window, use the Contents, Index, and Search tabs to find the information you need quickly and 

easily.  
 

Itron Secure Website 

The Itron Access website provides a convenient way to obtain software and product literature. 

If you have never logged into Itron Access, you must first set up your user account. Itron authorizes you to 

perform specific functions on the secure web site based on your login ID.Contact Itron Customer Support at 

(877) 487-6602 or support@itron.com if you have questions. 

To locate files on Itron Access 

1. Log into Itron Access (https://access.itron.com). If you do not have an account, click Create a New 

Account. 

2. Click Support Services, then Product Downloads. 

3. Click the drop down arrow in the Product drop down box to see your entitlements (the products 

associated with your customer account).  

4. Select a product and wait for the page to refresh. 

5. Scroll down to see all available software and documentation for the selected product. 

Note  Not all software releases are appropriate for all utility companies. Before proceeding, read the 

release notes or contact Itron Customer Support. 
 

 

C H A P T E R  1  

Introduction to OpenWay® Tools 
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OpenWay Field-Pro allows you to log into OpenWay meters and view and retrieve OpenWay meter data. It 

provides tools to directly communicate and program OpenWay electricity meters at the metering site or shop. 

Field-Pro is used to: 

 Create OpenWay meter data files (EDL files). 

 View meter data (includes displays, register values, demand reset values, and self read data). 

 View meter status (includes configuration, activity, time of use, events and load profile data). 

 Complete meter operations (manipulate registers, communication operations, HAN operations, pending 

tables, device resets, and device operations). 

 Program meters (initialize the device, validate programs, reconfigure TOU, and load new firmware). 

 

OpenWay Field-Pro generates activity logs to identify the meters, dates, and times of each OpenWay Field-

Pro operation and the type of actions performed. 

Session Timeouts 

If the Session Timeout function has been enabled, all Field-Pro windows display the number of minutes and 

seconds remaining in the session (the display is in the bottom frame of the window). The timer begins again 

each time you navigate to a new window. If you remain in a single window it counts down to expiration, then 

logs out of the meter. To set up the Session Timeout function, go to Shop Manager > System Settings panel > 

General Settings tab > C12.18 Security Settings window. 

Meter Summary 

The Meter Summary window is the main window in OpenWay Field-Pro and displays basic information about 

the meter you are currently logged into.  

Field Description 

Meter ID The utility company's unique ID for the meter. This ID can be set in the meter at the time of manufacture (by 

arrangement when purchased) or you can set it manually using the Unit ID field in the Initialize Device 

window of Field-Pro. 

C H A P T E R  2  

OpenWay Field-Pro 
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Field Description 

Serial Number A unique number assigned to the meter; it is the last section of the electronic serial number and is used as a 

device name in the system. Generally, this number is assigned by Itron and used for tracking purposes. 

Meter Type The common name of the meter such as "OpenWay CENTRON Advanced Poly" 

Comm Module MAC 

Address 

If the meter is connected to an RFLAN network, the last characters of the meter's MAC address display. These 

are also printed on a sticker on the face plate of the meter above the display. 

If the meter is connected to an RF Mesh (IPv6) network, The meter's physical address displays: the address of 

the endpoint which begins with the IPv6 address of the CGR (connected grid router) and ends with the last six 

digits of the device's MAC address. 

ZigBee (HAN) MAC 

Address 

The full MAC address of the meter; includes "000781" which identifies it as an Itron device. 

Hardware Version A value assigned to a meter platform and type that allows the meter to determine which firmware is 

appropriate. 

2.000    HW 2.0 singlephase 

2.050    HW 2.0 polyphase 

3.000    HW 3.0 singlephase 

3.050    HW 3.0 polyphase 

3.060    HW 3.1 singlephase 

3.080    HW 3.1 polyphase 

Register Firmware 

Version 

The version number of the firmware loaded on the meter which controls the meter register. 

Comm Module 

Firmware Version 

The version number of the firmware loaded on the meter which controls the communication module. 

ZigBee (HAN) 

Firmware Version 

The version number of the firmware loaded on the meter which controls the ZigBee HAN module. 

Comm Module IP 

Address 

This field appears only if you are logged into a meter with register firmware v5.0 or later and the meter is 

connected to the RF Mesh network. 

If the meter is synchronized with the network and a valid IP address exists, this field displays the short IP 

address. 

If the meter is not yet synchronized, a message displays "Meter is not synced to the network." 

If the meter has been configured to use the fatal error recovery feature, and if a recoverable fatal error is 

detected, a message appears at the bottom the Meter Summary window. For more information, see Fatal Error 

Recovery. 
 

Starting OpenWay Field-Pro 

OpenWay Field-Pro's function is to log onto an individual meter, get information from it, and perform 

modifications to it. Logging onto a meter is done either physically attached to the meter with an optical probe 

or at a distance using a ZigBee dongle. 

1. From the Windows Start menu, select Programs > OpenWay Tools > OpenWay Field-Pro. 
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2. To logon via ZigBee, insert a ZigBee dongle in the USB drive of your PC, then go to the Options menu 

and verify that "Logon via ZigBee" is checked. To log on with an optical probe, go to the Options menu 

and verify that "Logon via ZigBee" is not checked. You also should confirm the Optical Probe Selection, 

Communications Port and the Maximum Baud Rate. For more information, see the Options Menu on page 

6. 

 

The meter is configured to ask for either a Primary / Previous security code, or Signed 

Authorization. These options are set in Shop Manager, the System Settings section. The 

system includes these settings in the Replica file. For more information, see Override 

Security Code on page 9. 

3. When logging on to a meter via ZigBee, a secondary logon window appears. Enter the Radio ID and 

channel or you can select from the list of all available networks. Once the meter is selected, click F1 - 

Continue Logon. For more information, see ZigBee Logon on page 14. 

4. The OpenWay Field-Pro Meter Summary window displays. 

 

5. Use the keyboard's function keys or use the mouse to choose from the options displayed.  

 

The options you see and the F key associated with each option are fully customizable 

and are determined at your company. To make changes, use OpenWay Shop Manager, 

System Settings: OpenWay Field-Pro Customizable User Interface. 

6. To exit the OpenWay Field-Pro system, press F9 or click Logoff or use the Escape key. 
 

 

General Navigation 

You can navigate in Field-Pro with function keys and/or mouse clicks. Some or all of the following buttons 

are available in the upper-right corner: 

Field Description 
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Field Description 

 
Export to Excel. Use this icon to export the data on the current window to Microsoft Excel. 

 

Print. Use this icon to print the current window. 

 

Logoff. Use this icon to log off of a meter. 

 

Help. Use this icon to open the help system.  

Once logged onto the device, you can navigate to every function that the device supports (as long as it has 

been set up in the user interface using Shop Manager). If a function that you need is disabled, check the help 

topic for an explanation. 

On every window, F9 is reserved for navigating to the previous menu (or to log off if you are at the main 

menu). This allows for easy navigation through menus. There is also a quick logoff icon which allows you to 

log off from any window. 

On some windows, columns can be resized in case a description or value is too long to fit into the default 

column width provided.  The "+" and "-" buttons on the window allow a user to expand or contract the shown 

values. 
 

 

File Menu 

The File menu contains options related to program files, as well as an option to exit from Field-Pro. 

Field Description 

Export Export the data to a Microsoft Excel Worksheet. Selecting this option displays a dialog which allows 

you to choose a file name and location. 

Print Preview See an image of the way the currently open window will print. 

Print Choose a printer and print preferences. 

Exit Log off the meter and close the Field-Pro application. 
 

 

View Menu 

The View Menu contains the following options: 

Field Description 

Font Size Choose small, medium, or large text. 

Communications Log View the Communications Log. 
 

 

Font Size 

This option allows you to change the size of the text between Small, Medium, and Large. To change the font 

size, go to View > Font Size and select the desired value. You may need to resize the Field-Pro window and 

scroll to see all data. 
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Communications Log 

The Communications Log displays all raw data of the optical communications between the meter and 

OpenWay Field-Pro, and is helpful when trying to diagnose problems. It is a record of activity during the most 

recent Field-Pro session with the time expressed as minutes, seconds, and milliseconds from the beginning of 

the session. The amount and type of data depends on the options selected under Communications Logging. It 

is accessible only when you are not logged onto a meter. Each time you log onto a meter, the previous log is 

deleted and a new log is created.  

To access this window, start at the Logon window and select View > Communications Log.  

 
 

 

Options Menu 

The Options menu provides functions to select device-specific options for Field-Pro functions. 

Field Description 

Optical Probe 

Selection 

Select the default optical probe to be used for connecting to devices.  

Communications Port   Select the default communications port for the optical probe. 

Maximum Baud Rate   Select the maximum baud rate setting to use for the serial port. 

Communications 

Logging 

Select the serial communications for debugging purposes. From the options below, select the level of 

logging. 

 Disabled. No data is recorded. Any data existing in the Communications Log is not cleared. 

 Log function summaries. Higher-level functions are recorded with no detail. 

 Log all communications. Records all data detail if logged on optically. 

 Log ZigBee details. Records all data detail if logged on via ZigBee. 

Logon via ZigBee This option is enabled when there is a ZigBee dongle in the PCs USB port. 

To view the Communications Log, go to View > Communications Log when you are not logged on to a 

meter. 
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Optical Probe Selection 

Users must select the Optical Probe Model to be used to connect to metering devices. Some optical probe 

cables are powered from the PC by turning on the voltage to pins on the PC’s serial port. The model that you 

select determines the voltage on the PC’s RS-232 serial port connector pins to the optical port cable. It also 

determines how RTS (Request-to-send) and DTR (Data Receive) are set for communications. If the model 

used at your location is not listed, try Generic 1 or Generic 2. The following table shows the data values and 

optical port head types for the different optical probe models. 

Optical Probe Model RTS Value DTR Value Optical Port Head Type 

US Microtel 300 0 0 DIN 

US Microtel 500 0 0 ANSI 

US Microtel 600 0 0 ANSI 

GE SmartCoupler SC1 0 0 ANSI 

Generic 1 - Non-powered 0 0  

Generic 2 - Powered 0 1  

Schlumberger 0 1 ANSI 

Schlumberger France 0 1 DIN 

Schlumberger Spain 0 1 DIN 
 

 

For the Abacus Electrics A6Z cable, select the Generic 2 model. For the Abacus 

Electrics A7Z cable, select the Generic 1 model. 

1. From the Field-Pro main menu, go to Options > Optical Probe Selection. 

2. Select the appropriate model. 
 

 

Communications Port 

Field-Pro communicates with meters using an optical probe connected to a PC COM port. Before you can 

communicate with a meter, you must define for Field-Pro the PC COM ports (serial ports) that Field-Pro will 

use to communicate with metering devices. 

You normally configure ports when you install the Field-Pro software. After you have configured the ports, 

you do not need to change these resources unless you make changes to your PC’s ports or modems. 

The COM ports used by Field-Pro must be available for use and not dedicated for another application. If 

another device, such as a PDA (Personal Digital Assistant) has dedicated a COM port for its application, the 

COM port may appear to be available for use by Field-Pro, but errors may occur. If a PDA application is 

running on your PC, it may show up in the active programs area of the Windows Status Bar. 
 

 

Maximum Baud Rate 

This option allows the user to select the maximum baud rate for the ANSI devices.  

1. From the Field-Pro main menu, go to Options > Maximum Baud Rate. 

2. Select the appropriate rate. 
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Communications Logging 

This option allows the user to change the level of output in the communications log. The Disabled option 

means that nothing is output to the log file. The Log Functions Summaries option writes a summary of what is 

being done; however, there is no hex protocol output. The Log All Communications option shows the entire 

function summary and is useful for debugging communication problems. The Log ZigBee details option 

shows the function summary if the user is logged in via ZigBee. 

1. From the Field-Pro main menu, go to Options > Communications Logging. 

2. Select one of the following: 

 Disabled 

 Log Function Summaries 

 Log All Communications 

 Log ZigBee Detail 
 

 

Logon via ZigBee 

If there is a ZigBee dongle in the USB drive of your PC when you start OpenWay Field-Pro, the Logon via 

ZigBee selection is enabled in the Options menu. Choose this option, then click F1–Logon to open the ZigBee 

Logon window. For more information, see ZigBee Logon on page 14. 
 

 

Help Menu 

This menu allows you to access the online help and to see the version of the software currently installed as 

well as copyright information. 

Field Description 

Index Launches the help system's default topic "OpenWay Field-Pro." Begin typing to search the index. 

About Displays the version of Field-Pro software and copyright information. 
 

 

Clicking the blue help button launches the help system open to the topic for the window 

you are currently in. 
 

 

Security Overview 

Enhanced Security includes local communication. This allows the utility to maintain the same level of security 

when communicating over the air or locally via the optical port or ZigBee.  

Based on customer preference, all OpenWay meters are configurable to use either C12.18 or Enhanced 

Security for local meter communications via the optical port or ZigBee. This configurable setting is part of the 

meter’s configuration as defined in the OpenWay Collection Engine. An option on the Security tab allows 

customers to choose the method for securing optical communications. Descriptions of each of the two options 

available are provided below. 
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HAN Security Keys 

The OpenWay Tools software package always installs with the Marketing Default HAN Security Key. If 

another HAN key is needed, a separate install is provided by Itron. Separate instructions are provided to the 

end customer describing how to load the additional HAN key onto the computer so it can be used. 
 

Override Security Code 

When you are logging on to a meter, OpenWay Field-Pro tries the primary password, the previous password, 

and then NULL. If all three attempts fail, you are prompted for an override password. You can enter the 

password or cancel if you do not know the password. Once you click OK, then there is only one security 

attempt with the override password. 

 

Note  If you continue to see this dialog, you may want 

to consider setting the Current Security Code in Shop 

Manager System Settings. 
 

 
 

 

Standard C12.18 Optical Security 

If standard C12.18 security is selected, the meter continues to allow access via the optical port using the meter 

passwords. When logging on to the meter via OpenWay Field-Pro, the password used in the replica file will 

be used to logon to the meter or the user will be prompted to enter the password. 

OpenWay Tools supports up to five levels of meter passwords: 

 Level 4 – Full Access 

 Level 3 – Limited Access 

 Level 2 – Read Only + Access 

 Level 1 – Read Only Access 

 Level 0 – No Access 
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Enhanced Optical Security 

If Enhanced Security is selected, the meter requires valid credentials prior to allowing local communications.  

Prior to use, these credentials must be obtained from the CE by OpenWay Field-Pro, via a web service 

command. The credential defines: 

 Optical Password to use during communication 

 Meter number(s) the credential is valid for; either the individual meter, or all meters 

 Time period the credential is valid 

The figure below shows the exchange between OpenWay Field-Pro and the Collection Engine to obtain the 

credentials. 

 
 

OpenWay Signed Authorization for Meter Access 

The Signed Authorization security feature enhances the security posture of ANSI C12.18 meter access 

(optical). This method requires the user to have digitally signed credentials to gain C12.18 access to the meter 

optically or via ZigBee. These credentials have a limited duration set in hourly increments up to 90 days. A 

meter only requires Signed Authorization if this is enabled in the meter program. This feature is unrelated to 

"over the air" or "over the network" security; it is limited to local meter access. When configured, meter 

passwords are not required/used unless the feature is temporarily disabled, or if the meter’s program has 

changed (OpenWay configuration download with Signed Auth set to disabled).  

The OpenWay Field-Pro user requests these credentials over the network from the OpenWay Collection 

Engine.  

Note  Use of this feature requires Itron’s OpenWay Enhanced Security. It cannot work with ANSI C12.22 

"Standard Security."  

The credentials that are passed back have been digitally signed with the active Command Key. They indicate 

the user's "Optical ID," the level of access that is being provided, and the time period for which the credential 

is valid. This value defaults to 24 hours, but can be changed in the OpenWay Collection Engine user interface. 

The validity period time begins 10 minutes before current time on the Collection Engine server to ensure that 

a time difference in the meter or server does not prevent immediate access by the operator.  

This 10-minute difference may create some unusual results if the Collection Engine is set up to provide very 

short durations for the credentials. Itron recommends that the duration setup in the Collection Engine be no 

less than 30 minutes.  

Upon gaining access into the meter, the feature can be temporarily disabled to allow a meter technician to use 

a tool on the meter that does not support Signed Authorization. Maximum period is 45 minutes, but this can 

be refreshed.  
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Signed Authorization method 1: HTTPS with Username and Password 

Also known as "Username over TLS," this method involves Public Key cryptography (PKI) in that RSA 

X.509 certificates are used for authenticating the server and to provide data encryption on the link. 

Authorization is accomplished by prompting the Field-Pro user for a username and password. These have 

been predefined in the Collection Engine for each user for requesting Optical Signed Authorizations. The 

protocol is similar to Secure-Socket Layer (SSL), but recent implementations are using Transport Layer 

Security (TLS). In order for a Field-Pro instance to support this feature, the Shop Manager application must 

first be configured for it and a Replica file must be created for the target Field-Pro host.  

This method requires User IDs and passwords to be defined for Field-Pro users in the Collection Engine. At 

the time the user is configured, the Collection Engine operator also selects the meter access level for the user 

(1 to 4). The credential validity period is also set in the Collection Engine user interface. 

Users can be defined as limited "Service Managers" which allows them restricted access to the Collection 

Engine for only one purpose: obtaining Optical Signed Authorization credentials. Service Manager groups do 

not have access to the Collection Engine user interface, with the exception of having the ability to change their 

password.  
 

 

Signed Authorization method 2: Active Directory Validation 

This method requires the use of an Active Directory. The active directory users must be uniquely defined in 

the OpenWay Collection Engine role-based security: one user name for each active directory entry. With this 

implementation, passwords are managed by the Active Directory and are not required in the Collection 

Engine. For each user defined, a meter access level must be assigned (1 to 4).  
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Operational Scenario 

The feature is configured in the Collection Engine user interface (CEUI). Users with access privileges to 

request the credentials file are defined in the CEUI. OpenWay configuration files must be edited to support 

these WSDL/SOAP requests and this can include binding certificates to machine ports. For more information 

see the Collection Engine User Guide.  

Early in the deployment phase, or just prior to enabling the feature in the meter program, an administrator 

configures Shop Manager to support one method of Signed Authorization. The Shop Manager (role) creates 

Replica files and provides these for use with Field-Pro host application installations. This file enables the 

Field-Pro instance to be able to make SOAP requests over the enterprise network, into the Collection Engine, 

where the credentials file is dynamically setup and returned to the requester.  

The meter technician picks up a Field-Pro host, logs in, accesses the OpenWay network and opens the 

application. They click a button on the logon page to obtain a new Signed Authorization credential file. When 

returned, current credentials data is displayed on the Logon window (validity period, username, password 

level and optical ID). If Username over TLS is the selected secure method, they receive a prompt for 

username and password before the request goes to the Collection Engine.  

With an active valid credentials file in the runtime application, meter access is granted without need to enter 

passwords. Only meters with the utility’s unique Command Keys allow this credentials file to provide meter 

access.  

Just prior to the expiration of the current credentials, the meter technician can re-request the Signed 

Authorization credentials, or they may elect to wait until just before they must access the next meter, allowing 

credentials to expire. This is fine as long as the work has ended for the period.  

If the meter technician enters a service area where the feature is not enabled, the stored passwords continue to 

work for these meters. The meter program dictates the method and Field-Pro supports both, concurrently. 
 

Log into the Signed Authorization Server 

Enter the OpenWay Collection Engine Logon information if you have elected not to use your Windows Logon 

information to obtain a Signed Authorization Key. This User Name and Password also need to be setup in the 

OpenWay Collection Engine. This applies to both OpenWay Field-Pro and the OpenWay CENTRON 

Validation Tool. 
 

 

Collection Engine Settings 

Once the utility decides the exchange methodology, the Collection Engine must be configured to define which 

of the two methods are to be used. 

In addition, when creating the User IDs, the utility must define which of the optical passwords to use when 

communicating via OpenWay Field-Pro. This optical password information is passed to the requesting 

computer as a part of the credential. 
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OpenWay Tools Settings 

After the Collection Engine has been properly configured, the OpenWay Tools Administrator configures 

OpenWay Field-Pro using OpenWay Shop Manager. In Shop Manager, if Enhanced Security is required, the 

Enhanced Security option being used is selected and the Authorization Server for that desired methodology is 

entered. These values are used in the replica file and loaded upon execution.  

This setting must match the setting configured in the Collection Engine or credential exchange fails. 

Each credential request generated by OpenWay Field-Pro includes a validity duration of 24 hours. This allows 

the certificate to be used for up to 24 hours. If the default duration in the Collection Engine is less than 24 

hours, the default duration is used. 
 

 

Enhanced Security Business Process 

Once implemented, each utility should define the business process around loading each computer with 

credentials as needed. Below is a general outline of the process once Enhanced Security over Optical is 

enabled. 

1. Connect a laptop to the utility VPN. This can be accomplished by hard connection locally at the utility, or 

wireless outside of the utility. 

2. Run the OpenWay Field-Pro Application and request credentials. 

3. If Windows login is not used, enter the Collection Engine's User ID and Password. If Windows login is 

used, skip to Step 4. 

4. Once the credentials are loaded, disconnect from the VPN. 

5. Resume normal OpenWay Field-Pro operations. 
 

 

Security Procedure for Return Material Authorization (RMA) 

Meters being returned on RMA must include valid credentials to allow Itron to access the meter for analysis. 

OpenWay Tools allows the creation of these credentials. The web service call used to request the credentials 

for RMAs differs from the web service call used for requesting credentials for OpenWay Tools. The valid 

duration of the RMA credentials is for a period of up to 90 days (or the maximum period as defined in the 

Collection Engine). These credentials are valid for Itron internal software only and are not used by OpenWay 

Field-Pro. RMA credentials must be generated individually by meter serial number. 

Only the RMA credentials have a duration longer than 24 hours; RMA credentials can only be generated by 

individual meter serial number. 
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ZigBee Logon 

Several steps are required before ZigBee logon can work. For more information, see ZigBee Logon Setup. 

If there is a ZigBee dongle in the USB drive of your laptop when you start OpenWay Field-Pro, the Logon 

via ZigBee selection is enabled in the Options menu. Choose this option, then click F1–Logon to open the 

ZigBee Logon window. 

 

The window displays a list of all the networks that can be heard and the channels that the networks are using 

to communicate. This list is constantly updating. Each network corresponds to an Itron ZigBee coordinator, 

limiting the list to only OpenWay electric meters. The Radio ID (MAC Address) is located on the meter's face 

plate above the meter display. 

When you select a meter, the Radio ID and Channel text boxes automatically display the selected data. 

Alternatively, you can type in both the channel and the radio ID (you only need to type the right-most non-

zero part of the radio ID). "000781" is common to all Itron meters and is provided by the software. Clicking 

the Refresh button clears the list of networks and allows OpenWay Field-Pro to rebuild the list. Depending on 

the density of radios in the area, several scans may be needed to find the meter in question. 

Continue Logon tells OpenWay Field-Pro to attempt to get a radio (Integration Associates dongle, Telegesis 

dongle, or Itron Belt Clip Radio) to use to log on to the meter and to pass the radio ID and channel of the 

selected meter to that radio. Once logon is complete, the main OpenWay Field-Pro window opens. 

 

If you are using an Integration Associates dongle, you must use the Enable HAN 

Joining window to temporarily turn on the HAN Joining Flag. 
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ZigBee Logon Setup 

Before logging onto a meter via ZigBee, the following conditions must be set up in the meter.  

1. Log onto the meter optically with Field-Pro. Navigate to the HAN Module Configuration window (on 

page 19). Check for the following: 

 ANSI C12.18 over ZigBee Enabled = Yes (You can change this value to Yes with the Reconfigure 

C12.18 Over ZigBee function.) 

 ZigBee Enabled = Yes (You can change this value to Yes with the Form Network function.) 

 ZigBee Private Profile Enabled = Yes (To change this value to Yes, you must create a new 

configuration file in the OpenWay Collection Engine and re-initialize the meter.) 

2. For Integration Associates ZigBee dongles only, check for the following (also on the HAN Module 

Configuration window): 

 HAN Joining = Enabled (You can change this value with the Enable HAN Joining function.) 

3. Navigate to the Validate HAN Keys window and click F1–Validate. If the validation fails, contact Itron 

Customer Support to get a supplemental install that overwrites the default network key with a customer 

specific network key. 
 

If Options > Logon via ZigBee is disabled, the problem may be with the ZigBee dongle. 

 Make sure the dongle is fully engaged in the USB port. 

 Make sure the correct drivers are installed for the dongle. 
 

 

Canadian Meter Overview 

All electric smart meters that are deployed in the Canadian market are sealed in accordance with Measurement 

Canada's requirements of the Electricity and Gas Inspection Act and Regulations. Measurement Canada 

requires two types of seal on Canadian smart meters: 

 One is the physical seal which prevents physical tampering to the interior, adjustments, or controls of a 

meter. 

 The other is the software seal which prevents reprogramming, resetting, or modifying billing registers. 
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Only demand quantities can be reset on a physically sealed meter.  

Once a Canadian meter is sealed, you cannot perform the following tasks: 

 Set Energy  

 Configure Demand (even if identical to current) 

 Configure Energy (even if identical to current) 

 Configure Load Profile (even if identical to current) 

 Clear Billing Registers 

 Clear Base Values 

 Enter/Exit Test Mode 

 Clear Self Read 

 Clear Event Log 

 Clear History Log  

 Clear Load Profile 
 

Canadian sealed meters load the register with base values at every power up. (U.S. meters load the register 

with the energies out of EPF.) This is to ensure the register matches the base. 
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Gas Meter Operations 

The OpenWay CENTRON meter can communicate with other devices (in this case a gas module), store data 

from it, and store configuration commands to send to it. 

The HAN Client Configuration Table limits the number of commands that can be stored per client to three. 

Therefore, when a request is received to add another command to the table, a check is made on the number of 

commands already present. If there are already three commands for the specified client, a message is 

displayed stating that no more commands may be added and the command is not to be written to the table. 
 

 

Gas Meter Readings 

The OpenWay CENTRON meter can have up to 10 gas modules connected to it through ZigBee. These gas 

modules may be configured to record hourly or daily readings. The readings can be requested using Itron 

Private Profile or Smart Energy Profile commands that are passed down to the gas modules through the meter. 

The daily or hourly reading data for each connected gas module is displayed in this window. 

 

The daily reading data is displayed in a Command Response node within the meter's node. 

When there are multiple responses to a command, responses are numbered 1, 2, etc. in the Description 

column. The Value column displays the text of the command or the meter's response to the command. The 

time of each reading is displayed in Greenwich Mean Time. 
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Gas Meter Queued Commands 

The Gas Meter Queued Commands window shows any commands that have been queued in the OpenWay 

electric meter. These commands are sent to the gas module when it next wakes up. The OpenWay meter can 

store commands for up to four gas clients. Therefore, this window displays data in up to four data sets.  

 
 

 

Set Data Delivery Configuration 

This command configures when the gas meter wakes up and sends its meter data to the electric meter when 

the frequency of the readings needs to be modified. 
 

 

Set Collection Configuration 

The Set Collection command configures how the gas meter is to collect its meter data. You select the hour at 

which the daily freeze time reads are captured and determine whether the consumption readings are current, 

hourly interval data, or daily interval data.  

Only the current consumption reading is supported in the OpenWay CENTRON meter. After the set collection 

configuration command is processed, the command result is sent back to the OpenWay CENTRON meter and 

is available in the Gas Meter Readings window. 
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HAN Operations 

A Home Area Network (HAN) is a residence or commercial-based local area network providing 

communication between a Smart meter and one or more digital devices, for the purpose of observing, 

controlling, or modifying electrical usage.  

The OpenWay HAN implementation allows utilities to collect data from, communicate with and control 

various energy-using appliances throughout the home such as air conditioners and hot water heaters. It also 

provides two-way communications with the utility. 
 

 

HAN Module Configuration 

This window displays current details about the HAN Module.  

Field Description 

Module Version The version of the ZigBee stack code.  

 HW 2.0 meters – the ZigBee stack code is contained in the HAN firmware. (The HAN firmware 

and the register firmware are separate from each other.) 

 HW 3.x meters – the ZigBee stack code and HAN firmware are contained in the register 

firmware. 

Radio ID (MAC 

Address) 

A unique number assigned to a network device by the manufacturer to identify the device’s Internet 

Protocol (IP) network adapter. A MAC address is 48 bits long and is usually represented by a 16-digit 

hexadecimal number. The first few digits of a MAC address typically identify the manufacturer. The 

remaining digits uniquely identify the device’s specific interface. The last 10 digits are displayed below 

a bar code on the face plate of the OpenWay CENTRON meter. 

Channel Number Meters automatically select from among four channels, 11, 15, 20, or 25. The purpose is to minimize 

cross-talk between the HAN and other devices in the home that communicate in the same bandwidth 

(2.4 GHz). Once a HAN device is provisioned to the meter, it scans till it finds the channel that the 

meter has selected. The meter and all the HAN devices remain at that channel. 

Note  If 255 displays, it means that HAN has been disabled. 

PAN ID The meter’s ZigBee Personal Area Network (PAN) ID connects the meter with the HAN devices it is 

joined with. It is a 16-bit value (expressed as four hexadecimal characters), and is generated by the 

meter: it creates a value (HW 2.0 tries to match the last four digits of the ZigBee MAC Address, HW 

3.x uses a random number generator), then "listens" to make sure no other nearby meters have the 

same PAN ID. The PAN ID can change if the meter's ZigBee network is restarted. 

HAN Multiplier The value shown is the (HAN Multiplier * 1000) / HAN Divisor which matches the value set in the 

Set HAN Multiplier window (on page 27).  

HAN Joining To change the setting, use the Enable HAN Joining window. 

 Enabled. The meter can join with a new HAN device being installed at the premises. 

 Disabled. New HAN devices cannot join the meter. 

ANSI C12.18 Over 

ZigBee Enabled 

To change the parameter, use the Reconfigure C12.18 Over ZigBee window. 

 Yes. The meter is configured to allow Field-Pro users to log in via ZigBee. 

 No. Field-Pro users can only log into this meter optically.  
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Field Description 

ZigBee Private 

Profile Enabled 
 Yes. The meter is configured to disable communication with all IPP (Smart Energy) devices. 

 No. The meter is configured to communicate with all its HAN devices. 

ZigBee Enabled All OpenWay meters are equipped with ZigBee radios, but some OpenWay customers have not yet 

implemented HAN programs. Those customers configure the meters to disable the ZigBee radio. 

 Yes. The meter is configured to keep the ZigBee radio on. 

 No. The meter is configured to turn the ZigBee radio off.  

Quiet Mode Active The ZigBee radio automatically goes into and out of Quiet Mode depending on whether HAN devices 

are provisioned to the meter. 

 Yes. The meter has no HAN devices in the HAN Registration Table, so the meter is in Quiet 

Mode. For more information, see below. 

 No. The HAN Registration Table has one or more HAN devices, so the ZigBee radio is 

performing routine communication tasks with those devices. 

HAN State This field displays the current operating status of the HAN. 

 Running. The ZigBee stack and radio are functioning. 

 Halted. The ZigBee stack and radio have been shut down due to reset limiting. Use the Clear 

HAN Halt Condition function to restart the HAN. 

Startup Option Indicates the method by which the HAN Module started. 

 Coordinator Only. The HAN Module is in its normal operation mode. 

 Router/Coordinator. This is a special mode which is not normally used. 

 Router Only. This is a special mode which is not normally used. 

 HardCoded Form. The HAN Module is configured to support factory test mode. 

 HAN Disabled. The meter is configured to keep the HAN Module off. 

ZigBee Output Power 

Level 

The ZigBee radio's power level ranges from negative 30 to positive 3 (dBm). 

 

Quiet Mode 

When the ZigBee radio is enabled and the meter has no HAN devices provisioned to it, the radio 

automatically goes into Quiet Mode. In this operational mode it does not perform any of the routine 

messaging that a meter normally does with its HAN devices. 

The ZigBee radio continues to monitor beacon requests so that if a gas module attempts to join, the meter can 

respond to it.  

If the meter's configuration has a RIB schedule, the meter collects data so that when a HAN device is joined to 

the meter, historical data is available. 

As soon as a HAN device is provisioned to the meter, the ZigBee radio automatically comes out of Quiet 

Mode and begins normal communications such as the link status messages that are sent every 15 seconds. 

The HAN Registration Table contains the list of HAN devices joined to the meter. To see its contents, use the 

OpenWay Field-Pro HAN Client Information window. 
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HAN Event Overview 

HAN Events are communications between the utility company, the meter, and in-home HAN devices. These 

messages are for the purpose of controlling load to make sure that demand does not exceed what the utility 

company can generate. 

Examples of in-home HAN devices could be the thermostat, refrigerator, dryer, gas meter, and the in-home 

display that allows consumers to see and control energy usage. 

Use Field-Pro to see recent HAN events when you are logged into the meter, or create a data file and use Shop 

Manager's Data File Viewer. 
 

 

HAN Event Log Summary 

This window displays the total number of each type of HAN event stored in the meter, both upstream (from 

the HAN device to the meter) and downstream (from the meter to the HAN device). 
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Supported HAN Upstream Events 

Device Added. The meter logs this event when a new device is provisioned to the meter. This event only 

happen when a new device is added. 

Device Dropped. The meter logs this event when an existing device is dropped from the meter. 

Device EUG Changed. This event is logged when a UEG (Utility Enrollment Group) change for a device is 

requested by the Collection Engine, and that device has successfully confirmed that its UEG was changed 

accordingly. 

Device Joined. This event is logged when a device successfully conducts CBKE and is regularly 

communicating with the meter. 

DRLC Delivery Failed. This event is logged if the head-end is unable to deliver a DRLC event to a HAN 

device. The event includes the MAC address of the individual device that did not respond to the DRLC event. 

HAN Communication has Exceeded Defined Threshold. The meter expects to hear from each of the HAN 

devices at regular intervals. When this interval is exceeded, an event is logged. This event is logged after one 

day for powered devices and three days for sleepy devices. The event is only logged once until 

communications are reestablished. Once the meter hears from the device again it is allowed to log this event 

again the next time the conditions are met. 

Load Control Opt Out. Many enrollment programs give consumers flexibility to choose not to participate in 

a load control event. Each time the consumer opts out, an event is logged upstream to the meter so that the 

utility company can track the number of times it happens. This event is logged for each HAN device that opts 

out of a DRLC event. The meter could have up to one opt-out event for each HAN device that supports 

DRLC. 

Load Control Status. The meter logs one event each time a HAN Device indicates that a Load Control Status 

has been triggered on the device. Since this event covers several conditions there could be several of these per 

DRLC event per HAN device, depending how HAN events are configured at your utility. 

Message Confirmation. The meter logs one event each time it receives a confirmation message from a 

device. The meter could receive several confirmations for every message sent, since there could be multiple 

devices in the home that display and confirm messages. 

Message Delivery Failed. The meter logs this event if the head-end is unable to deliver a text message to a 

HAN device. The event includes the MAC address of the specific device that did not respond to the text 

message. 

Ping Event. The meter logs this event to indicate that a device was pinged. The argument data indicates the 

result of the ping operation. One event is logged per device pinged. 

Price Acknowledgment. The meter logs one event each time it receives a price acknowledgment from a HAN 

device. For every price that is published to the meter, several confirmations could be logged depending on 

how many devices are present that support price acknowledgment. 
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Price Delivery Failed. The meter logs this event if the head-end is unable to deliver a new price to a HAN 

device. The event includes the MAC address of the individual device that did not respond to the publishing of 

data by the head-end. 

State Changed. The meter logs this event when the state of a HAN device changes. These state changes 

usually occur during the joining process. Once the devices are successfully joined, this event rarely occurs. 

Submetering Bubble-up Data Missing. This event is logged when the meter notices that part of the interval 

data that the submetering device (gas module) sends at the bubble-up is missing. This event is logged only if 

the submetering device is using a collection configuration which includes interval data (daily or hourly). 

Supported HAN Downstream Events 

Diagnostic System Events. This is one event that has several associated sub-events that provide helpful 

information about the HAN system. 

 Channel Change. This event is logged whenever the network is restarted and the channel changes. The 

Argument Data reports both current and previous channels. 

 PAN ID Change. This event is logged whenever the network is restarted and the Personal Area Network 

(PAN) identifier changes. The Argument Data reports both current and previous PAN IDs. 

 ZigBee halted due to Reset Limiting. This event is logged if the Home Area Network (HAN) ever 

experiences eight resets in a four hour period. All HAN operations cease. For more information, see 

ZigBee Stack Reset Limiting. 

 Config Change. This event is logged whenever any of the HAN configuration values is updated. The 

Argument Data reports the updated value. 

 Gas module told to leave. This event is logged whenever a gas module is commanded to leave the 

network. The gas module is identified in the Argument Data by the last four bytes of its EUI64. 

 Management Leave Requested. This event is logged whenever the meter receives an inbound message 

from a device commanding it to leave the network. 

 Meter has been cold started. This event is logged whenever the meter is cold started. 

DRLC Data Published. The meter logs this event when the head-end system publishes a new DRLC event to 

the meter and the meter publishes the DRLC list out to the appropriate HAN Devices. This event is logged 

even if there are no HAN devices connected to indicate that the DRLC event was received. 

Existing DRLC Event Dropped. The meter logs this event to indicate that the DRLC queue was full when a 

new DRLC event was received and it was one of the existing DRLC events that was dropped. This means that 

the new event occurred before at least one of the already queued events. 

Message Published. The meter logs this event when it receives a new text message from the utility and 

publishes the message out to the appropriate HAN devices. This event is logged even if there are no HAN 

devices connected to indicate that the message was received. 

Meter Network Changed. The meter logs this event when something changes about the meter's HAN 

network. This would occur because of a decommission, the stopping of the stack (happens with Cert Updates) 

or if the network is restarted. 
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New DRLC Event Dropped. The meter logs this event to indicate that the DRLC queue was full when a new 

DRLC event was received and it was the new DRLC event that was not added to the queue. 

Price Tier Changed. The meter logs this event when it receives new pricing data from the head-end system. 

Pricing Data Published. The meter logs this event when the head-end system publishes a new price to the 

meter and the meter publishes the full price list out to the appropriate HAN Devices. This event is logged even 

if there are no HAN devices connected to indicate that the price was received. 

Security Profile Update Notification. The meter logs this event when it receives a command that would 

require the meter to change the security profile of a device. The meter is not permitted to make security profile 

changes without a decommission/re-commission event so the Collection Engine must be notified of the 

meter’s rejection of the command. 
 

HAN Event List 

Use the two tabs of this window to see detailed information about the HAN Events stored in the meter's 

memory.  

Upstream Events tab 

HAN upstream events are communications from a home's HAN devices to the meter. 

Field Description 

Time The date and local time on the meter when the event occurred. 

Event The supported events. For more information, see HAN Event Log Summary. 

User ID Reserved for future use. 

HAN Event ID An ID number that uniquely identifies this event at this meter at this date and time. 

MAC Address Identifies the HAN device that sent the event to the meter, such as the thermostat, dryer, or pool pump. 

Argument Data Additional information about the event. 

Downstream Events tab 

HAN downstream events are communications from the meter to HAN devices in the home. 
 

Field Description 

Time The date and local time on the meter when the event occurred. 

Event The supported events. For more information, see HAN Event Log Summary. 

User ID Reserved for future use. 

HAN Event ID An ID number that uniquely identifies this event at this meter on this date and time. 

Argument Data Additional information about the event. 
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HAN DRLC Messages 

DRLC (Demand Response Load Control) messages are sent from the head-end system at the utility company 

through the meter to in-home HAN devices. The in-home device responds to the message by turning 

appliances down or off, according to the program in which the consumer is enrolled. DRLC messages state 

the start time and duration of the event so that in-home devices can return the appliances to their normal 

operations afterward. 

Use this window to see a log of DRLC Messages the meter has received.  
 

 

Drop Node 

This option decommissions a single node in a Home Area Network (HAN). The decommission takes effect 

very quickly and can be verified by checking the HAN Module Configuration window to determine that the 

node is no longer on the network. This option is used if one of the gas modules had to be changed out. By 

dropping the node, the OpenWay meter stops listening to that node and the gas module must then try to rejoin 

the network. Without the Drop Node procedure, it could take up to three days for the gas module to join the 

network. 

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
 

 

HAN Client Information 

The HAN Client Information window shows network statistics about communication between the meter and 

directly connected, short range devices (over ZigBee) such as in-home displays. 

The meter can support up to ten HAN devices; this window shows the following for each device connected. 

Field Description 

Device ID The MAC Address of the HAN device. 

Status Includes the following: not registered, registration failed, registration successful, or invalid certificate. 

Status Changed The date the status was last changed. 

Last Message Signal 

Strength 

The signal strength of the last message received and the average signal strength of all messages from the 

device. The color of the indicator changes based on the following values: 

 Green: -46 dB and up 

 Yellow: -64 dB to -45 dB 

 Orange: -81 dB to -63 dB 

 Red: -82 dB and below 

Average Message 

Signal Strength 

Messages Sent The number of messages sent to the device. 

Messages Received The number of messages received from the device. 

Number of Send 

Failures 

The number of send message failures to the device. 
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Update HAN Security Keys 

Use this procedure if you need to change the HAN Security Keys in the meter. 

 

At the time your utility company first became an OpenWay customer, Itron generated Global Link Key and 

Network Key values specific to your utility. Itron inserts the two values into all devices manufactured for your 

company. When you place orders for additional devices, you must enter the two values in the Meter Spec 

Form under the heading "ZigBee Encryption." The two values must also reside in the registry files on all PCs 

that are used to log into meters with Field-Pro. 

For each PC used to log into meters with Field-Pro, install the HAN Security Keys using the file provided by 

Itron. Then use the Updated HAN Security Keys window to insert the new values into the meters. Encryption 

is used to prevent this connection from being a security risk. 

This window is disabled if the Link Key in your PC's registry is empty or is the PC's default value. 

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
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Enable HAN Joining 

HAN joining allows ZigBee devices to connect to OpenWay meters. This feature is handled at two different 

levels in the OpenWay system.  

 The Collection Engine allows you to enable and disable HAN joining for any period of time for any or all 

meters in the network. For security reasons, most utility companies choose to keep HAN joining disabled 

network-wide. 

 Field-Pro allows you to temporarily enable joining for a single meter when network joining is disabled. 

Use the Enable HAN Joining window when you are installing ZigBee devices at a premises. Set a time period 

of up to 60 minutes to allow the devices and the meter time to recognize each other and join. When the time 

period expires, HAN joining is disabled but the devices and the meter remain connected and new devices 

cannot join.  

If there is a power outage, the meter and the device automatically reconnect upon resumption of power. 

 

The way that the meter permits connection via dongle varies by maker. 

Itron part number K514148-001 (Integration Associates dongle): HAN joining must be 

enabled either optically or with the Collection Engine before this dongle can join the 

meter's network. 

Itron part number K514148-002 (Telegesis dongle) and Itron part number AMI-0100-

201 (Itron Belt Clip Radio): The "secure rejoin" function allows these devices to join the 

meter's network without HAN joining being enabled first.  

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
 

 

Set HAN Multiplier 

The value set in this window is used to derive values for the Multiplier and Divisor, which are ZigBee/HAN 

Simple Metering Cluster attributes used by the Register board’s ZigBee/HAN code. The attributes are queried 

by the ZigBee/HAN devices allowing them to show the demand and energy usage values correctly on their 

displays.  

For example, if the value is set to 1.0, it translates to the values 1 and 1000 in the meter’s ZigBee/HAN code 

and it tells the meter to send all demand and energy values to the ZigBee/HAN devices in kilos (kW, kWh). 

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
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HAN Pricing Data 

This window displays the price of electricity per tier as sent to the meter over the OpenWay network by the 

Collection Engine. The meter sends the information to the in-home display which shows consumers the 

electricity rates they are paying, allowing them to make smarter choices in their energy use. 

Each Price contains the following information: 

 Provider ID. A unique identifier for the commodity provider 

 Rate Label. A label containing commodity provider specific information regarding the billing rate. 

 Price Tier. The tier from the list of tiers given that corresponds to this price. 

 Register Tier. The TOU Rate that corresponds to this price. 

 Price Signal Start Time. The time that the price becomes valid. 

 Price Duration. The amount of time after the start time that the price is valid. 

 Price. The price of the commodity measured in a unit of currency per a unit of measure when the 

commodity is delivered to the premises. 

 Generation Price. The price of the commodity measured in a unit of currency per a unit of measure when 

the commodity is received from the premises. 
 

Each Tier contains the following information: 

 Tier ID. The value of the tier; values range from 1 to 6 with greater values indicating a greater price. 

 Tier Label. A label describing the tier assigned by the commodity provider. 
 

 

Validate HAN Keys 

Use this function to compare the Network Key and Global Link Key in the meter with the same values in 

your PC's registry. 

 

ZigBee Logon does not work unless both of these keys pass validation. 
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Click F1 – Validate to perform this procedure. 

For additional help with Network and Global Link Keys, contact Itron Customer Support. 

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
 

 

Add HAN Device 

Use this window to connect up to ten HAN devices to the meter. 

 

For security, Itron meters are manufactured with the HAN Joining Flag turned off. In 

order to add HAN devices you must use the Enable HAN Joining window to 

temporarily turn the flag on. 
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Field Description 

Registered HAN 

Devices 

Lists the MAC addresses of HAN devices that have already been provisioned to the meter. 

Select HAN Key 

Type 

Choose Install Code. 

Install Code Locate this code on the label of the HAN device. The meter and the device use this code to validate 

and secure communications between the device, the meter, and the network. The code is created by the 

device manufacturer. Enter only letters and numbers; do not enter extra characters (such as colons) that 

might appear in the string. Not case sensitive. 

Once you click F1 – Add HAN Device this number displays in the Registered HAN Devices field. 

Device EUI The HAN device's MAC address. Locate this code on the label of the HAN device. 

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
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Reconfigure C12.18 Over ZigBee 

This parameter controls whether or not the meter allows Field-Pro to log in via ZigBee. 

This window allows you to set this parameter to Enabled or Disabled without having to reconfigure the meter. 

Once disabled, Field-Pro cannot talk to the meter by ZigBee, only by optical probe. Other ZigBee 

communications, such as in-home HAN devices, are not affected. 

In order to use this feature, your User Access Policy must give you permission to reconfigure meters. 

Field-Pro forces you to log off the meter after you enable or disable the parameter. 

To see a complete list of configuration parameters for the meter you are logged into, see Device Configuration 

on page 43. 

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
 

 

HAN Move Out 

Use this function when a customer moves out of a residence. It decommissions all HAN devices and locks 

access to all load profile data of the previous resident. In order to access this function, the User Access Policy 

must be enabled that grants HAN Operations to your User Group. 

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
 

 

Disable HAN Pricing 

This feature allows utilities to offer flexibility to their customers in the type of pricing model they are enrolled 

in. Use this function to disable RIB pricing and return to regular scheduled pricing. 
 

 

Active RIB Schedule 

This window shows the customer's current consumption and where that puts them within the RIB schedule. It 

also shows the start time and duration of the billing period and block period, along with the prices and 

thresholds of all the blocks defined for the current block period. 
 

 

Current RIB Data 

This window summarizes the RIB data that will be sent to a HAN device. This feature is enabled whenever 

the meter is configured to use block pricing even if no HAN devices are actively registered with the meter. 
 

 



OpenWay Field-Pro 

 
 

OpenWay Tools User Guide 32 

 Proprietary and Confidential 
 
 
 

Clear HAN Halt Condition 

This window allows you to restart the ZigBee stack and radio if they have been shut down due to reset 

limiting. For more information see ZigBee Stack Reset Limiting.  

When the ZigBee stack is shut down, the HAN State field in the HAN Module Configuration window 

displays "Halted." In addition, most of the Field-Pro windows that provide HAN functionality are disabled. 

 

If you clear the HAN halt condition and the ZigBee radio immediately turns off again, 

the HAN code in the meter is experiencing a condition from which it is unable to 

recover. Contact Itron Customer Support. 
 

 

ZigBee Stack Reset Limiting 

Reset limiting is a feature of hardware 3.x meters that protects the meter from premature aging due to 

excessive writes to flash memory. 

Resetting 

The ZigBee stack is code (provided by a third-party vendor) that manages ZigBee radio functionality. Itron 

incorporates the code into the HAN firmware (HW 2.0) or register firmware (HW 3.x) for OpenWay 

CENTRON meters. The ZigBee stack can lock up for various reasons; the meter resets the stack allowing 

ZigBee message traffic to continue.  

Reset Limiting 

Each time the ZigBee stack is reset, there is a write to meter flash memory. Flash memory has a limited 

number of writes, thus an excessive number of writes due to the ZigBee stack resetting would likely cause the 

meter to prematurely age. To preserve flash memory the reset limiting feature turns off the ZigBee radio if the 

meter experiences eight or more ZigBee stack resets in a four hour period. 

 

The meter continues all other metering functions without interruption. 
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The meter logs a Diagnostic System Event with the argument data "ZigBee Halted Due To Reset Limiting." 

This event appears on the HAN Event List window on the Downstream Events tab. 

The HAN Module Configuration window displays "Halted" in the HAN State field. 

Most HAN event logging ceases and the following Field-Pro windows are disabled: 

 Add HAN Device 

 Drop Node 

 Enable HAN Joining 

 Update HAN Security Keys 

 Set HAN Multiplier 

 Validate HAN Keys 

 Reconfigure C12.18 Over ZigBee 

 HAN Move Out 

 Reform Network Immediately 

 Reform Network after Delay 

 Form Network 

 Halt Network 
 

To restart the ZigBee radio 

Navigate to the Clear HAN Halt Condition window and click F1 to restart the radio. 

 

If the ZigBee radio immediately turns off again, the HAN code in the meter is 

experiencing a condition from which it is unable to recover. Contact Itron Customer 

Support. 
 

OpenWay M2 Gateway meter 

The Landis+Gyr Focus AX singlephase meter can operate on the OpenWay network when equipped with the 

Itron M2 Gateway communications module. This module shares some hardware features and 

software/firmware functionality with the CENTRON HW 3.0 register, including ZigBee HAN functionality. 

The system behavior and correction described above apply to the M2 Gateway meter. 
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Decommission Options 

Use the four Decommission features to manage the meter's HAN network. 
 

Reform Network Immediately 

Reform Network Immediately corresponds to the Decommission and Commission manufacturer’s procedure. 

Reform Network after Delay calls the Decommission and Halt procedure. Form Network and Halt Network 

correspond to the Enable HAN and Disable HAN procedures. Each of these options display a confirmation 

message before executing the procedure. 

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
 

Reform Network After Delay 

The Decommission process applies to the Home Area Network (HAN). It shuts down the ZigBee 

communications either entirely or to a specific node, depending on the selection. A Decommission brings 

down the HAN network and reforms the network after a delay. This gives you time after the meter repair is 

complete to power down the meter while the network is decommissioned.  

There are several situations when you might need to take down a HAN. For example, if an OpenWay 

CENTRON meter has been taken to the meter shop for repairs, the meter must reform its HAN network when 

it is returned to the field.  

When the meter is returned to the field and powered up, it goes through the steps to reform the network. 

Among the things it needs to do is to check for a conflict with the Personal Area Network (PAN) ID. The 

PAN ID is created by the meter and connects it with the HAN devices it is joined with. This cannot be 

completed in the meter shop. After the network is initialized, the meter is ready for the gas modules to join its 

network. 

The decommission process should take at most a few seconds to occur, and the network reforms within a 

minute.  

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
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Form Network 

This function turns on the meter's ZigBee radio causing the meter to form a HAN network. To do this, the 

function reconfigures the meter with the parameter ZigBee Enabled = Yes. All other configuration items 

remain the same. 

The meter creates a HAN network by selecting a channel number and generating a PAN ID. HAN devices in 

the home that are provisioned to the meter then join the network. Nearby gas modules may also join the 

network. 

To stop the HAN network, use the function Halt Network. 

For more information about channels, PAN IDs, and other HAN parameters, see HAN Module Configuration 

(on page 19). 

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
 

 

Halt Network 

This function turns off the meter's ZigBee radio to stop the meter's HAN network. To do this, the function 

reconfigures the meter with the parameter ZigBee Enabled = No. All other configuration items remain the 

same. 

With the network halted, the meter does not communicate with the HAN devices in the home or any gas 

modules that are joined with the meter (the modules automatically search for another meter to join). The 

function also prevents Field-Pro users from logging into the meter via ZigBee. 

To start the HAN network again, use the function Form Network. When the network forms, the meter creates 

a new PAN ID. 

Reasons for using this function include the following purposes. 

 The Field-Pro user is determining whether ZigBee communications are causing interference. 

 The home owner has no HAN devices. 

 The home owner is concerned about smart meter functionality and has chosen to Opt Out on page 90. 

 The utility company has not yet implemented a HAN program in this area. 
 

This window is disabled if the ZigBee radio has shut off due to reset limiting. For more information, see 

ZigBee Stack Reset Limiting. 
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Meter Data 

Use the functions in this group to retrieve data that exists in the meter. All of the windows are Read-Only: 

none of them allow any data to be modified or reset. 
 

Create Data File 

Use this window to create an EDL file (OpenWay's meter data file). When you click F1 to select "Create 

File," Field-Pro displays a confirmation message showing the EDL file name. Click F1 again to create the file.  

 
 

The data file automatically contains configuration and register data. Optionally you can include the following 

additional information. Select any combination of check boxes to include more data. Note that the more data 

that is included, the longer it takes to create the file. 

 History and Event Log Data 

 LAN and HAN Log Data 

 LAN and HAN Network Data 

 Load Profile Data 

 Voltage Monitoring Data 

 Instrumentation Profile Data (available only on Hardware 3.0 and 3.1 meters) 
 

Field-Pro saves the data file to the location specified in Shop Manager. To change this location, go to Shop 

Manager > OpenWay Data Files panel, then click Change Directory. Your selection appears at the top of the 

window in the Data File Directory field. 

Note  When creating a data file from an OpenWay ICM (cellular) meter, the inclusion of ERT-related data 

depends on the meter's configuration. If the meter is configured to support ERT data, the data is included in 

the file. Otherwise all ERT-related data is excluded from the file. 
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Create CRF File 

Use this window to perform contingency reads, a function provided for the situation where your meter 

network has lost the ability to communicate with an OpenWay meter and you must send field personnel to the 

premises to collect meter data for billing and evaluation. 

Creating the file quickly is a priority, especially in cases where meter tampering is suspected. A CRF 

(Common Reading Format) is a trimmed-down version of OpenWay’s normal meter data file format, allowing 

OpenWay Field-Pro to create it very quickly. 

The CRF file automatically contains current register data and self-read register data from the meter, along 

with gas meter register data if the meter is connected to gas modules. The other options, load profile and event 

data, are selected using OpenWay Shop Manager, the System Settings window, General Settings tab, Data 

File Creation Options field.  

Use a meter data management system such as Itron Enterprise Edition™ (IEE) to analyze the CRF file. 
 

Normal Display Registers 

The items that appear on the meter's display in Normal mode are determined by the configuration file created 

in the OpenWay Collection Engine, then loaded to the meter over the air from the Collection Engine or from 

Field-Pro using the Initialize Device function. 

The data shown in this window is retrieved from the meter and displayed in the same format that it is shown 

on the meter's display, along with a description and the display ID.  
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Test Display Registers 

The items that appear on the meter's display in Test mode are determined by the configuration file created in 

the OpenWay Collection Engine, then loaded to the meter over the air from the Collection Engine or from 

Field-Pro using the Initialize Device function. 

The data shown in this window is retrieved from the meter and displayed in the same format that it is shown 

on the meter's display, along with a description and the display ID.  

 

Test mode is only available on polyphase meters. 

 

 

Register Values 

The Register Values window displays the current value for each energy the meter is configured to measure. If 

demand is selected in the meter program, the window displays the Time of Occurrence of the peak demand. 

 
 



OpenWay Field-Pro 

 
 

OpenWay Tools User Guide 39  

 Proprietary and Confidential 
 
 
 
 

Extended Energy Registers 

If the meter is configured to measure a second set of register data, use this window to display these values. 

The window functions the same as the Current Register Values window. 

 
 

Values at Demand Reset 

This window displays all active register values at the time of the last demand reset in the form of a snapshot. 

The time of the last demand reset is also shown. For more information, see Reset Demand Registers on page 

58.  
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Instantaneous Values 

The Instantaneous Values window shows instantaneous readings when power monitoring is enabled in the 

meter. 

 

You can use this window to investigate high bill complaints. It allows you to see exactly how many watts are 

currently being used so you can help the customer identify an appliance that may need to be replaced or that 

the heating coil in the roof should be turned off most of the year. 

This window displays watts delivered (from the utility to the customer) and received (from the customer by 

means of solar panels, wind generator, etc) at the exact moment that you open the window. To refresh the 

information, click the Instantaneous Values menu item again; any values that have changed are updated and 

displayed. Values are reset to zero when you initialize the meter or reset demand. 

Singlephase meters show average, maximum, minimum, and current watt values along with the time of 

occurrence. Polyphase meters show average, maximum, minimum, and current watt values for phases A, B, 

and C, along with aggregates.  
 

Self Read Data 

A self-read includes register data that is captured in the meter at a programmed interval of time and is stored 

in non-volatile memory. The Self Read Data window displays all active register values at the time of the last 

Self Read. The time of the last self read is also displayed.  
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Extended Self Read Data 

The OpenWay Field-Pro Extended Self Read Data window displays instantaneous Watts, instantaneous VARs 

and instantaneous Volts when the meter supports and is configured to record the values on a self-read. For 

polyphase meters, instantaneous values per phase and all configured secondary energy values are shown. 

Since the number of extended self reads can differ from the number of traditional self reads, the extended self 

read data is reported separately. It is important to note that the self reads on each window are numbered 

independently. Self Read 1 on the Self Read Data window may not match the same time stamp as Extended 

Self Read 1 on the Extended Self Read Data window. 

 
 

12 Max Demands 

Each time a demand reset is performed, the register firmware stores the Max Demand along with the date and 

time when the peak occurred. Twelve records are stored, displaying a year of monthly max demands. 
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Meter Status 

The features in this group have to do with the meter's configuration and any incidents that have occurred in 

the meter. 
 

Device Status 

This window is accessible for all meters and lists the current status of many aspects of the meter. The data is 

read-only.  

 
 

Field Description 

Meter ID This field is set aside for customers who want to identify a set of meters with an ID number. This ID 

can be set in the meter at the time of manufacture (by arrangement when purchased) or you can set it 

manually using the Initialize Meter window of Field-Pro. 

Serial Number This field is set aside for customers who want to identify each individual meter with its own ID 

number. This ID can be set in the meter at the time of manufacture (by arrangement when purchased) 

or you can set it manually using the Initialize Meter window of Field-Pro. 

MFG Serial Number An ID that uniquely identifies this meter. It is created by Itron and set permanently in the meter at the 

time of manufacture. 

Software Revision The version of OpenWay Tools or OpenWay Collection Engine software used to program the meter. 

Firmware Revision The version number of the register firmware in the meter. 

Comm Module 

Version 

The version of firmware loaded onto the communications module. 

HAN (ZigBee) 

Module Version 

The version of ZigBee stack code in the meter. For hardware 3.0 and 3.1 meters, this code is contained 

within the register firmware. For hardware 2.0 meters, it is separate. 

Device Time The date and time on the meter. 

Time of Reading The date and time when this window was opened in Field-Pro. In the case of a data file, it is the date 

and time when the file was created. 

Operating Mode Normal or Test 
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Field Description 

Time Zone The time zone in which the meter was programmed, stated as hours plus or minus GMT (Greenwich 

Mean Time). 

DST Enabled Indicates whether the meter is programmed to adjust for daylight saving time. 

Minutes on Battery If power to the meter has failed, this displays the number of minutes since the meter switched to its 

battery. 

Service Limiting The following fields display the service limiting status of the meter. 

Current Switch State Connected. The service switch is closed. 

Disconnected. The service switch is open. 

Load Voltage Present True. There is voltage present on the load side of the meter. If the service switch is disconnected, it 

indicates that the consumer is using a generator to provide power. It is not safe to close the service 

switch when there is load side voltage. 

False. The meter does not detect any voltage on the load side. 

Last Connection 

Attempt Failed 

True. There was an attempt to connect or disconnect that failed. 

False. The previous connect / disconnect attempt was successful. 

Failsafe Mode Status The meter automatically switches to failsafe mode after a new configuration file or firmware is loaded 

to it. During this period, service limiting mode is disabled to prevent unnecessary disconnects. 

Time Remaining in 

Failsafe Mode 

The length of time the meter remains in failsafe mode is configured in the Collection Engine. This 

countdown field displays the time remaining till it returns to normal mode. 

Home Area Network 

(HAN) 

The following fields list a number of counts that the meter keeps regarding the HAN status. 

Tamper Tap Data The following fields show the state and history of tampers for the meter. 
 

 

Device Configuration 

The Device Configuration window contains configuration and tamper data for the meter. Some of the data is 

grouped under nodes that can be expanded and contracted. 
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Device Activity 

The Device Activity window shows a history of important events during the meter's life such as the number of 

demand resets, number of times the meter was programmed, and any tamper incidents. 

 
 

Device Errors 

The Device Errors window shows active Diagnostic, Non-Fatal or Fatal errors.  

Fatal Errors 

Error Message Description 

Fatal Error #1 The meter has detected a problem with the program memory. If this error occurs, program the meter 

and check for proper operation. If the error continues to exist, return the meter to the factory for repair. 

Fatal Error #2 The meter has detected a problem with the RAM. If the meter detects a problem with the RAM, return 

the meter to the factory for repair. 

Fatal Error #3 The meter has detected a problem with the data flash. If this error occurs, program the meter and check 

for proper operation. If the error continues to exist, return the meter to the factory for repair. 

Fatal Error #4 The meter has detected a meter processor communication failure. While this is displayed as a fatal 

error, it does not shut down the meter. This error occurs when communications are interrupted 

between the meter processors. 

Fatal Error #5 The meter has detected a power down error. If this error occurs, program the meter and check for 

proper operation through two complete power down and power up sequences. If the error continues to 

exist, return the meter to the factory for repair. 

Fatal Error #6 The meter has detected a problem with the file system. If the meter detects this problem, return the 

meter to the factory for repair. 

Fatal Error #7 The meter has detected a problem with the operating system. If the meter detects this problem, return 

the meter to the factory for repair. 
 

 

Some fatal errors are recoverable if the meter has been configured with this feature. For 

more information, see Recover from Fatal Error. 
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Non Fatal Errors 

Error Message Description 

Non-Fatal Error #1 Error Code. Err 1----- 

Possible Cause(s). Battery Voltage Low 

Recommended Action. Once a low battery is detected, the daily battery voltage tests are halted and a 

battery present test is run every second. A low battery continues to function, however its reliability 

decreases over time. As long as the meter is not powered down with a dead or missing battery, the 

meter continues to function as normal. 

If the meter is powered down with a dead battery, then, when power is restored, the meter's clock will 

be off by the duration of the outage, and Load Profile and TOU are halted. 

Non-Fatal Error #2 Error Code. Err -2---- 

Possible Cause(s). The voltage on one of the phases dropped below 96 volts. 

Recommended Action. SiteScan check. It runs every 5 seconds and must fail twice successively to be 

recorded.  

A Demand Reset after the voltage returns to normal range clears this error. 

Non-Fatal Error #3 Error Code. Err --3--- 

Possible Cause(s). Current Season is not programmed, Current Year is not programmed, TOU halted 

due to power down with dead battery. 

Recommended Action. This is tested at power-up, at midnight crossings, at season changes, upon 

reconfigures and upon set clocks. 

Depending on the cause of the error, it can be cleared with a corrective reconfigure or with a set clock 

with a good battery present. 

Non-Fatal Error #4 Error Code. Err ---4-- 

Possible Cause(s). The configured reverse power threshold has been reached. 

Recommended Action. Reverse power is tested every second and an accumulator for it is maintained. 

If power is delivered during the second, then the accumulator is cleared. If power is received during the 

second, then the accumulator is incremented. If the accumulator reaches the configured reverse power 

threshold, then the error is triggered. 

A Demand Reset clears this error. 

Non-Fatal Error #5 Error Code. Err ----5- 

Possible Cause(s). Clock or Load Profile error detected. 

Recommended Action. This is tested upon power-up. 

If the battery is good, performing the Adjust Clock function clears this error. Be sure to read the Load 

Profile data prior to setting the clock. A dead battery causes some invalid intervals at the end of the 

data. When the error is cleared, Load Profile is restarted from the beginning to purge the bad data. 
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Error Message Description 

Non-Fatal Error #6 Error Code. Err -----6 

Possible Cause(s). The calculated W delivered demand at an EOI exceeded the configured full scale 

value. 

Recommended Action. This error is checked upon every Demand EOI, set clock, demand reset, enter 

Test Mode, and power-up. If the meter is configured for Max W Del, then that value is compared to 

the programmed threshold. 

The full scale overflow error displays after the interval during which the overflow occurred. The 

maximum demand register continues to accumulate and display kW as long as the format limitations 

are not exceeded. 

If a full scale overflow occurs, check the installation to ensure that the current capacity of the meter has 

not been exceeded. A full scale overflow error in no way affects the existing billing data. 

This error clears when a demand reset is performed. 

Non-Fatal Error #7 Reserved 

Non-Fatal Error #8 Reserved 

Non-Fatal Error #9 The meter has detected a SiteScan error. 
 

 

Time of Use 

The Time-of-Use (TOU) functionality is designed for use in billing applications where multiple rates (bins) 

are required for energy and demand and supports Critical Peak Pricing (CPP). The TOU option provides 4 

Rates plus Total. It allows the energy provider to assign different rates to different times of the day. Daily 

TOU patterns can be assigned to different days of the week, seasons, and holidays. 
 

Time of Use Status 

This window displays the Time of Use (TOU) and Critical Peak Pricing (CPP) status of the meter you are 

logged into.  

Field Description 

Meter ID The utility company's unique ID for the meter. This ID can be set in the meter at the time of 

manufacture (by arrangement when purchased) or you can set it manually using the Unit ID field in 

the Initialize Device window of Field-Pro. 

Device Time The meter's date and local time when you opened this window. If the Device Time does not match the 

current date and time, the meter needs to be updated with a new configuration file, or you can use the 

Adjust Clock or Force Time Sync features. 

TOU Enabled Yes. This meter has been configured with a Time of Use schedule, though it may not currently be 

active. 

No. TOU is disabled. 

Day of Week If TOU Enabled = Yes, displays the current day of the week. 

If TOU Enabled = No, this field is not visible. 

DST Enabled Indicates whether the meter is programmed to adjust for Daylight Saving Time. 

Meter in DST If DST Enabled = Yes, indicates whether Daylight Saving Time is currently in effect. 

If DST Enabled = No, this field is not visible. 

Critical Peak Pricing 

(CPP) 

The remaining fields display the meter's CPP status. 
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Field Description 

Status Pending. A CPP event is scheduled and the meter is waiting for the Start Time to arrive. 

Waiting for EOI Sync. This status appears when the Start Time of the CPP event is between the 

meter's intervals. The Start Time has arrived but the meter has to wait for the end of the current interval 

before it switches to the CPP rate. 

Active. The meter is in CPP mode: there is a critical peak pricing event happening now and the meter 

has switched to the CPP rate. 

Done on End of Interval. This status appears when the Start Time + Duration of the CPP event is 

between the meter's intervals. Even though the full Duration has not elapsed, the meter returned to its 

normal rate at the end of the last interval. See note below. 

Done. The CPP event is over and the meter has returned to its normal rate. The CPP status remains as 

"Done" until the next CPP event is scheduled. 

Not Configured. The meter is not configured to participate in critical peak pricing events.  

Unknown. Field-Pro is not able to determine the meter's CPP status. 

Start Time (field not 

visible if the CPP 

Status = Not 

Configured) 

The date and time when the next CPP event is scheduled to start. The field remains unchanged after 

the event until the next CPP event is scheduled. 

Duration (field not 

visible if the CPP 

Status = Not 

Configured) 

The length of the CPP event (unless the Start Time is mid-interval; see note below). 

Rate (field not visible 

if the CPP Status = 

Not Configured) 

The rate that the meter uses during the CPP event. 

 

 

Recommended practice is to choose a CPP Start Time and Duration that allow the CPP 

event to match the meter intervals. If the Start Time is mid-interval, the actual length of 

the CPP event will be shorter than the selected Duration. 
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Time of Use Seasons 

A season is a period of weeks during the year when a particular rate structure is in effect. One active season is 

programmed into the meter at any given time. Additional seasons are stored in the pending tables of the meter 

configuration. 

Time of Use Seasons gives a graphical depiction of the rate and output assignments for all of the day types for 

each of the seasons defined in the Time of Use schedule. You can view the season change dates and advance 

the display to show each of the available seasons using "Next Season" and "Previous Season". This window is 

disabled if the meter is not configured for Time of Use.  

Rate E is reserved for Critical Peak Pricing. 

 

The TOU Reconfigure process can take up to a minute to appear in the meter. You must 

log off and log back onto the meter to see any more seasons or status values. 
 

 

Critical Peak Pricing 

Critical Peak Pricing (CPP) is an extension of Time-Of-Use (TOU) scheduling. From the meter's perspective, 

CPP is just another TOU rate. 

In OpenWay CENTRON meters, CPP is activated and deactivated through the use of pending tables. The 

Collection Engine activates CPP by sending an activation message. This message contains: 

 The day schedule information for the day, hour, minute and CPP rate for the activation. 

 The day schedule information for the day, hour, minute and normal TOU rate for the deactivation. The 

deactivation schedule is generally the original schedule data. 

If a duplicate CPP message is received, the duplicate is acknowledged, but rejected. 

 

CPP activation does not replace an entire day's schedule. To minimize network traffic, 

only the affected time periods are written into the TOU schedules when CPP is 

activated. 
 

 

Holiday Calendar 

The Holiday Calendar window is a calendar representation of the dates assigned as holidays within the time of 

use schedule.  

Holidays can be set up either as Fixed or Recurring. Fixed holidays are defined as a single date. Recurring 

holidays repeat every year. The Recurring Date Type options allow you to determine whether the holiday 

occurs on the same date every year or moves to another day if the date falls on a Saturday or Sunday. 

A maximum of 14 holidays can be set up per season. 
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DST Calendar 

The DST Calendar window is a list of all of the daylight saving time dates programmed into the meter in a 

tabular format. Although the DST dates are typically embedded in the Time of Use calendar, they are shown 

independently in order to better manage differing DST and TOU expiration dates. This display format also 

allows you to view the entire DST calendar on a single page.  

 

The DST Calendar window is disabled if the meter is not configured to use 

daylight saving time.  
 

 

Load Profile Status 

The Load Profile Status window shows information about the Load Profile in the active meter. Data such as 

Load Profile Running, Number of Channels and Interval Length can be found here. 
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KYZ Summary 

In addition to allowing the configuration of the KYZ board, OpenWay Field-Pro shows a summary of the 

configuration of the KYZ board. The summary shown is the same summary that is shown post KYZ 

configuration. It lists the Output Type, Pulse Width and Pulse Weight for each output if applicable. The 

window also indicates if the outputs are disabled in Test Mode. 

For more information, see Configure KYZ on page 74. 

 
 

Events 

The OpenWay Register has an Event Log that records historical events that have taken place in the meter.  

The OpenWay Register Event Log captures the most recent events in the meter at all times. The meter is 

capable of retaining 420 events before wrapping. 

Each event log record includes an event description, a time and date stamp, and additional information on 

certain events. For meters with batteries, all logged events are retained through a power outage. For meters 

without batteries, the Event Log is periodically written to non-volatile memory. Events that occur just prior to 

a power outage may be lost if they were not backed up. 

The OpenWay Register can monitor up to 26 C12.22 Exceptions. C12.22 Exceptions are sent to the Collection 

Engine as soon as possible after their occurrence, but are not stored in the meter as other events are. The 

contents of the event log are sent up to the Collection Engine daily.  

Any column on this window can be sorted by clicking on the column heading. 
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Events Summary 

This window lists all events that can occur in the meter from which the data file was created. The Action 

column indicates how many times the event has occurred. "Logging Disabled" indicates that the meter is 

configured to ignore that event. 

Field Description 

ANSI Security Failed An incorrect security code was provided during logon. 

Current Threshold 

Exceeded 
Definition 

This event is logged when the Instantaneous Phase Current (IPC) exceeds the 

maximum current load or threshold percentage for the meter at any moment. 

Another event is logged when the IPC returns to within tolerance. 

Configurable Items 

Utilities can use the following parameters to control the number of events that the 

meter logs. 

 Threshold. Valid values = 1-125. The percent of the meter's maximum load 

that, when exceeded, causes an event to be logged.  

 Hysteresis. Valid values = 0-125 (equal to or less than Threshold value). The 

percent of tolerance below the threshold within which the IPC can move 

without causing the event to be logged again as "returned to within tolerance." 

 Debounce. Valid values = 0-255. The number of seconds the IPC must 

exceed the threshold in order for the event to be logged.  

 Minimum Active Duration. Valid values = 0-65535. The lockout period (in 

seconds) from the time a "returned to within tolerance" event is logged 

(Threshold minus Hysteresis) until the next "exceeded tolerance" event can be 

logged. Each phase has a separate timer. 

 

Deregister The process of removing an endpoint's registration information from other cell members. For example, 

if an endpoint changes cells, it sends a message to all of its known cell members to remove it from their 

member lists. 

Demand Reset A meter event triggered when a demand reset occurs.  Demand resets can be configured to occur on a 

timed basis or when triggered by another event.  Checking the event log is a good procedure when 

troubleshooting meter symptoms. 

Event Tamper 

Cleared 

This event is logged when a tamper count is reset to zero. For more information, see the Reset 

Tampers window on page 60. 

Inversion Tamper The meter was turned 180 degrees upside down and power flowed backward. 

Load Profile Error A meter event indicating that a Load Profile error has occurred. 

Load Voltage Present Before the service switch is closed and service is reconnected, the meter checks for load-side voltage 

(consumer has engaged a separate source of energy such as a generator). When load side voltage is 

present, the service switch does not close and this event is logged. 
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Field Description 

Loss of Phase 

Restored 

Phase voltage was restored. 

Loss of Phase Error Non-Fatal Error 2: The voltage on each phase is checked every five seconds. A phase must fail twice 

in a row to cause an error. A Demand Reset or a Clear STD or MFG Status Flags after the voltage 

returns clears this error. 

Low Battery A meter event triggered when the battery voltage drops below a predetermined value. 

Magnetic Tamper 

Cleared 

The meter has detected that a high DC offset value has returned to normal. This event is logged one 

second after the value returns to normal. Only HW 3.1 singlephase meters display this event. 

Magnetic Tamper 

Detected 

The meter has detected a high DC offset value, which is caused by a magnet in the vicinity of the 

meter. This event is logged one minute after the high DC offset value is detected. Only HW 3.1 

singlephase meters display this event. 

Meter Firmware 

Download Failed 

The downloading of the meter firmware failed. This applies to all types of firmware, as well as 

downloading RF mesh configurations. 

Meter Firmware 

Download Succeeded 

The downloading of the meter firmware succeeded. This applies to all types of firmware, as well as 

downloading RF mesh configurations. 

Pending Reconfigure A meter event logged when any Pending Table (except Firmware) is activated. 

Primary Power Down A loss of power to an endpoint. 

Primary Power Up An indication that power is once again available at an endpoint.  This indication generally follows a 

power outage. 

Removal Tamper The meter has been removed from the socket. 

Table Written A given table has been written to (the number of the table is provided in the event message). 
 

 

Events List 

The meter configuration determines which incidents should cause the meter to log events. This window 

displays all events logged on the meter since the last time it was configured. 

Field Description 

Time The date and time that the event occurred. 

Event The name of the event. 

User ID If a user was logged into the meter when the event occurred, their User ID is recorded. If no one was 

logged in, 0 displays. 

Data Some events have associated details that are known about the event. 
 

 

Firmware Download Events 

This window displays records for each set of firmware that has been loaded to the meter. The records are 

grouped by the date and time of each download.  

Note  Firmware downloads are logged as events regardless of the configuration file's event logging 

settings. 
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The log file that holds firmware download events is 48 records long, which should be adequate for the life of 

the meter under normal circumstances. If the 48 records are filled, unsealed meters drop the oldest record and 

add the new record to the log file. Sealed meters do not accept additional firmware downloads. 

Field Description 

Firmware Type Indicates the target processor for the firmware, such as RFLAN, RF Mesh, or register. 

Source Indicates whether the firmware was loaded to the meter through the optical port, ZigBee, or through 

the network. 

Hash All meters with the same firmware set have the same hash value in this field. 

CRC  The Cyclic Redundancy Check is an error-detecting code that ensures that the firmware file was not 

corrupted during download.  "0" indicates that the firmware download was for the comm module. An 

eight-digit number indicates that the firmware download was for the register.  

Previous Firmware 

Version 

The firmware version that was replaced with this download. 

Current Firmware 

Version 

The firmware version that was loaded with this download. 

User ID The identification of the individual or work group that performed the firmware download. 
 

 

Toolbox 

The toolbox option is only available for meters that support SiteScan. Toolbox contains two windows: 

Toolbox Vector Diagram and Toolbox Data. When toolbox is first loaded the Toolbox Vector Diagram 

window is displayed to the user. The user can switch between the two toolbox views and the Previous Menu 

button returns the user to the menu which contains the Toolbox option. 

For more information see Toolbox Vector Diagram and Toolbox Data. 
 

 

Toolbox Vector Diagram 

The Toolbox Vector Diagram window contains a vector diagram, the meter's service type, and instantaneous 

quantities. This window is refreshed automatically so that user can watch dynamic changes to the meter.  

This window can be printed using the Print option on the File menu or the print button. This window cannot 

be exported. Export is only available on the Toolbox Data window. 

 

For information about plotting a phasor diagram directly from the meter display’s 

Toolbox data, refer to the Technical Reference Guide for the meter.  
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Toolbox Data 

The SiteScan Diagnostic Toolbox displays all the metering information used by the meter for individual phase 

measurements including per phase items and diagnostic counters. The information in the Toolbox represents 

the actual electrical signals seen by the meter. The per-phase Volt and Amp readings are Root-Mean-Square 

(RMS) values. The combination of a diagnostics and other information in the Toolbox display enhance your 

utility's ability to diagnose and resolve metering and tampering problems. 

While online with a meter, the phasor diagram shows amplitude and the direction and angle of both voltage 

and current for each of the three phases. The lengths of the voltage and current vectors are proportional to 

their values.  

For information about plotting a phasor diagram directly from the meter display's Toolbox data, refer to the 

Technical Reference Guide for the meter. 

Measurements 

The per-phase volt and amp readings, along with voltage and current angle readings, let you check the site's 

phase sequencing performance. The diagnostic counters alert you to the frequency of a metering or tampering 

problem. 

Instantaneous readings for kW, kvar, kVA, and power factor are displayed for each phase. 

The combination of a diagnostic error and the information in the Toolbox display enhance your utility's ability 

to diagnose and resolve metering and tampering problems. 

The phase notation used in the Toolbox identifies each meter element as phases A, B, or C as shown in the 

following table: 

Element in Meter Defined Phase 
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Element in Meter Defined Phase 

Left Element Phase A 

Center (or Rear) Element Phase B 

Right Element Phase C 
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Power Circle 

The Power Circle view displays watt, var, VA, and power factor data as a power circle graphic. Watts are 

displayed on the X axis with vars on the Y axis. VA is displayed as an angle between vars and watts. 

Power Circle quadrants Q1 and Q2 represent lag - the overlap of Vars delivered and Watts delivered; 

Quadrants Q3 and Q4 represent lead – the overlap of Watts delivered and Vars received. Therefore, the 

following is true: 

 Varh Net (while Watts are being) delivered = Vars Q1 minus Vars Q4 

 Varh Net (while Watts are being) received = Vars Q2 minus Vars Q3 

For more information, see Quantities and Directional Calculations on page 57. 
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Quantities and Directional Calculations 

The following diagram shows the power circle quadrants for watts and VARs received and delivered. The 

directional calculations in the meter are given below the diagram. 

 
 

Watts Net (Watts delivered) - (Watts received) 

Watts Delivered (Watts Q1) + (Watts Q4) 

Watts Received (Watts Q2) + (Watts Q3) 

Watts Uni-Directional or Watts Total (Watts delivered) + (Watts received) 

VA Delivered (VA while watts are in Q1) + (VA while watts are in Q4) 

VA Received (VA while watts are in Q2) + (VA while watts are in Q3) 

Var Net (Vars delivered) - (Vars received) 

Var Total (Vars delivered) + (Vars received) 

Var delivered (Lag) (Var Q1) + (Var Q2) 

Var received (Lead) (Var Q3) + (Var Q4) 
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Meter Operation 

The features in the Meter Operation group allow you to make changes to the meter. Most of the features clear 

or reset values that have accumulated. Several modify aspects of security. Two methods are provided for 

adjusting the meter's time, one offers limited recovery from fatal errors, and one allows you to trigger the 

remote disconnect/reconnect function. 
 

Reset Demand Registers 

The Demand Reset option allows you to perform a Demand Reset on the meter. The current demand values 

along with the number of Demand Resets and the Date and Time of the last demand reset are shown. When 

the demand reset is performed, all values in the window are refreshed. Once the Demand Reset has been 

performed, the option is removed and only the F9 - Previous option appears. This prevents accidentally 

performing two demand resets. 
 

Reset Billing Registers 

The Reset Billing Registers window allows you to clear all of the billing registers. The current register values 

are displayed. When the procedure is executed, the window is refreshed and the option is removed to prevent 

you from accidentally performing two resets. 
 

Reset Activity Status 

Use this dialog to set back to zero the number of: 

 Demand resets 

 Self reads 

 Power outages 

 Times programmed 

 Events in log 

If you are logged into a meter that has Site Scan, Diagnostic Counts also displays and will be reset. 

Once the reset is complete, all of the counters are refreshed. The menu no longer displays the reset option to 

prevent users from accidentally doing it twice. 
 

Enter/Exit Test Mode 

The Enter/Exit Test Mode window allows you to place the meter in test mode without requiring you to 

physically press the test mode switch. Once the meter is in test mode, it remains until the meter reaches its test 

mode timeout and switches back to normal mode. 

 

Test mode is only available on polyphase meters. 
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Connect/Disconnect 

Most OpenWay CENTRON meters have a service switch, a remote disconnect module which allows the 

utility to turn off the power to that service point remotely by sending a command from the Collection Engine; 

the majority of connects and disconnects are performed this way. 

If you must perform a connect/disconnect on site, use this function. 

Note  This function does not work on meters that do not have a service switch. The meter technician must 

use traditional methods of performing the connect or disconnect. 

Field Description 

Current Switch State Connected. The disconnect switch is closed. 

Disconnected. The disconnect switch is open. 

Load Voltage Present True. There is voltage on the load side of the meter. If the Current Switch State = Disconnected, this 

could indicate a problem. 

Last Connection 

Attempt Failed 

True. There was an attempt to connect or disconnect that failed. 

False. The previous connect / disconnect attempt was successful. 

Failsafe Mode Status The meter automatically switches to failsafe mode after a new configuration file or firmware is loaded 

to it. During this period, service limiting mode is disabled to prevent unnecessary disconnects. 

Time Remaining in 

Failsafe Mode 

The length of time the meter remains in failsafe mode is configured in the Collection Engine. This 

countdown field displays the time remaining till it returns to normal mode. 
 

 

It can take up to 15 seconds for the capacitor to charge up again after it has operated the 

service switch. 
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Disconnect 

You can use the Disconnect function any time the meter is running. The meter clicks when the relay opens 

and power is no longer delivered. If the Disconnect fails, OpenWay Field-Pro displays a message indicating 

the reason. 

Connect 

The meter displays "off" once the disconnect operation is successful. Using the Connect option turns the 

power back on to the site immediately. The meter clicks and power is restored. If the Connect fails, OpenWay 

Field-Pro displays a message indicating the reason. 

Connect with Intervention 

Use this option when you want customers to determine that their appliances are in a satisfactory state before 

the power is restored. When the meter is armed, "ready" flashes on the display until reset button is pushed. 

The meter clicks and power is restored. If the Connect with Intervention fails, OpenWay Field-Pro displays a 

message indicating the reason. 

The "User Intervention Required After Disconnect" option in the Collection Engine is independent of the 

"Connect with User Intervention" option in OpenWay Field-Pro. 
 

Reset Tampers 

OpenWay CENTRON meters have several ways of detecting when someone has tampered with the meter. 

This window displays the number of times each type of tamper has been detected.  

 

The meter keeps a count of tampers even if it is not configured to log tamper events. 

An Inversion Tamper is counted when the meter has been turned 180 degrees upside down and power 

flowed backwards. Click F1 to reset the value to zero. 

A Removal Tamper is counted when the meter is removed from the socket. Click F2 to reset the value to 

zero. 

A Magnetic Tamper Detected is counted when the meter has a high DC offset value, which is caused by a 

magnet in the vicinity of the meter. A Magnetic Tamper Cleared is counted when the high DC offset value 

returns to normal. Only HW 3.1 singlephase meters can detect these two tampers. Click F3 to reset both these 

values to zero. 

If the meter is configured to do so, a "Tamper Cleared" event is logged one time for each tamper you reset. 
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Adjust Clock 

Click F1 to adjust the meter's clock. This synchronizes the meter's time with your PC's system time. 

 

When the meter is synced with the network, this window is disabled and the Force Time Sync window is 

enabled. 

When the meter is not synced with the network, this window is enabled and the Force Time Sync window is 

disabled. 

When the meter is not registered with the Collection Engine, both windows are disabled. 
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Force Time Sync 

Use this window to adjust the meter's time when it differs from the network time by two seconds or more. The 

meter checks the current network time and adjusts to match. 

 

Time adjustments cause meter intervals to be shorter or longer than normal, and large time adjustments can 

cause whole intervals to be skipped. The meter logs a Time Change event (if configured to do so) in the meter 

history log, which can be seen in the Field-Pro Events window.  

When you use the Shop Manager Data File Viewer to look at a data file for this period, the time change is 

shown with Interval Status Codes in the Load Profile Data window, the Voltage Monitoring window, and the 

Instrumentation Profile window. 

 

Time differences from 20 to 120 seconds are automatically corrected by the OpenWay 

network. Time differences less than 20 seconds are ignored. 
 

 

When a meter has been in storage for a long time, time can drift by several minutes. To 

prevent having to log into each meter and perform a Force Time Sync, the meter checks 

to see how long the power outage lasted. If the outage was between one month and three 

years, the meter automatically adjusts to the network time. 

For additional information refer to the meter's Technical Reference Guide section on time adjustments in the 

Meter Register Operations chapter. 

When the meter is synced with the network, this window is enabled and the Adjust Clock window is disabled. 

When the meter is not synced with the network, this window is disabled and the Adjust Clock window is 

enabled. 

When the meter is not registered with the Collection Engine, both windows are disabled. 
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Clear All Meter Data 

The Clear All Meter Data option removes the following information from the meter: 

 Billing data 

 Counters (including Number of Outages, Times Programmed, and Number of Demand Resets) 

 Tamper Counters (Inversion and Removal) 

 Event Log 

Click F1 to clear all the meter data. 
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Service Limiting Mode 

Service Limiting is based off the demand threshold alert (kW, kVA). The meter switch is opened 

(disconnected) when present demand (kW or kVA) exceeds the threshold. The switch remains open for the 

remainder of the current interval, plus one complete interval following the opening of the switch. The switch 

is closed (reconnected) based on a configured setting, either automatically or upon user intervention. 

 
 

Disable Signed Authorization 

Click F1 to Disable Signed Authorization. You can only perform this operation if Signed Authorization is 

currently enabled in the meter. You can range the amount of time that this feature will be disabled from 1 to 

60 minutes using the option on the right side of the window. 
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Recover from Fatal Error 

This window is enabled when the meter is in Fatal Error Recovery mode or if a Core Dump is available in the 

meter.  

For more information, see the description of the feature Fatal Error Recovery. 

The window displays the number of the last fatal error type and reason. 

Select from the following check boxes: 

 Clear Fatal Errors (available only if the fatal error has not yet been cleared) 

 Read Full Core Dump 

 Create Data File 

When creating a data file during this process, OpenWay Field-Pro does not include load profile or voltage 

monitoring data because this data is no longer valid once a fatal error has occurred. All history log and 

communications log data are included so that this information is available for debugging fatal errors. 

Once the fatal recovery bits have been cleared from the meter, Field-Pro no longer says that a fatal error has 

occurred and you can no longer retrieve the full core dump.  
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Fatal Error Recovery 

All OpenWay meters with register firmware v3.0 and up can be configured to utilize the Fatal Error Recovery 

feature. This feature is not enabled by default at the register; it must to set up in the meter configuration. In the 

OpenWay Collection Engine when creating the configuration file, go to the Register Operation tab and select 

the check box Enable Fatal Error Recovery.  

If the meter experiences a recoverable fatal error the following happens: 

 Fatal Error Recovery mode status is set, which indicates to the Collection Engine that the meter has 

entered fatal error recovery.  

 "Fat rECory" displays on the meter between every configured display item until the fatal error is cleared.  

 A core dump is saved (retrievable at the meter using the Recover from Fatal Error window). This 

information must be collected and sent to Itron for evaluation. Only the most recent core dump data is 

stored in the meter. For more information, see Recover from Fatal Error. 

 Meter enters failsafe mode and internal (service limiting) disconnect/reconnect commands are prevented 

until fatal error recovery status is cleared.  

 Fatal Error Occurred event is logged in the meter's Event Log and a Fatal Error Exception is sent 

upstream.  

 Energy data is maintained during Fatal Error Recovery. Event log data is maintained when possible. Time 

is restored or updated. Disconnect/reconnect switch maintains its current state during the recovery process. 

Load profile, demand, voltage monitoring data and all ZigBee bindings are lost.  

 The fatal error must be cleared prior to the next recoverable fatal error. If the meter has not been cleared 

and subsequent recoverable fatal error occurs, the meter will not be recoverable and will enter default fatal 

error state.  
 

 

M2 Optical Lockout 

OpenWay security protects the OpenWay M2 Gateway meter. The security that is set up in OpenWay Shop 

Manager is the security that is required of anyone attempting to log into the M2 meter, even with the 

Landis+Gyr field tool application. 

This window, M2 Optical Lockout, controls what users can do once they are logged in with the L+G field tool 

application. L+G has five tiers of functional groups. M2 Optical Lockout allows you to control whether users 

can perform the top level functions. 

Locked = No level 5 functions are permitted. A user with level 5 permissions is logged in as if they have only 

level 4 permissions. 

Unlocked = Users with level 5 permissions are allowed to perform level 5 functions. 

Field Description 

Lock Port Click this button to prevent all users from performing level 5 functions, as defined in L+G software.  

Unlock Port Click this button to permit qualified personnel to perform level 5 functions. 

Unlock Port for ___ 

minutes 

Enter up to 65534 minutes (45+ days) to unlock the port for that length of time. 
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Clear Firmware Download Event Log 

Click the F1 key to clear all entries from the Firmware Download Event Log. Your security level must be set 

up correctly for this task in Shop Manager. 
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Pending Table Operations 

Pending Tables contain a set of software or firmware locations that store temporary information about a 

transaction. Once the transaction has taken place, the table is cleared. If the transaction does not occur within a 

configurable period of time, or within a configurable number of attempts, the table will also be cleared. 
 

Activate Pending Table 

Meters have several pending tables designed to hold different types of firmware: register, display, ZigBee, 

OEM, etc. 

When data is being downloaded to a meter, it is initially loaded into a pending table.  

If Pending Table is set to be activated by a non-time trigger, then the Activate Table operation can be used. 

An example would be a Firmware Download that is completed, but not immediately activated for some 

reason. Selecting Activate issues a command to the meter to tell it that the selected table should be activated.  

In some cases this process can be time consuming; verification that the new table was activated must be done 

independently. 

Select a row then click F1 – Confirm Activate Table to proceed or F9 – Previous Menu to cancel. 
 

Clear Pending Table 

The Clear Pending Table command removes the pending table from the pending list. This may be needed if 

the activation fails and a new table needs to be loaded. Another example would be where a new TOU schedule 

needs to be loaded and there is already one pending. The previous version is removed prior to loading the new 

version.  
 

Clear All Pending Tables 

The Clear All Pending Table command removes all the pending tables from the pending list. This may be 

needed if the activation fails and a new table needs to be loaded. Another example would be when a new TOU 

schedule needs to be loaded and there is already one pending. The previous version is removed prior to 

loading the new version.  
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Programming Functions 

Initialize Device 

The Initialize Device option allows you to select a meter program and configure a meter with it. Only 

programs that are currently tagged as "Active" in Shop Manager appear on the list. In addition, the window 

only displays programs that can work with the meter you are logged into.  

Once you select the program and click Initialize, you are prompted to enter a Serial Number and a Unit ID. 

These values are optional and are used to differentiate one meter from another. These values are displayed on 

the Meter Summary window. 

After the Configuration is attempted, the window is updated with either a confirmation message or an error. 

Upon successful initialization of the device you must log off the meter and then log on before continuing. This 

is to ensure that the meter is returned back to a proper state and verifies that the meter was properly initialized 

with the requested changes. 

If initialization fails, you are not forced to log off the meter. You can attempt another initialization or return to 

the previous window and continue. 

 

The programming options for each device type are associated with each program file at 

the time the program file is exported from the OpenWay Collection Engine. If 

programming options are changed in the System Setting in the Shop Manager after a 

program file is exported, you must export the program file again to implement the new 

initialization items when Field-Pro initializes devices. 
 

 

Reconfigure TOU/DST 

The Reconfigure TOU option allows you to select a new TOU schedule to program into the active meter. The 

TOU schedules are part of the replica file and are all stored in a common location and can identify what 

devices they support. The Reconfigure TOU window has a list of all supported TOU Schedules and a 

Reconfigure TOU button. Once the operation is complete, the success or error message appears on the right 

and the Reconfigure TOU button is removed. Only programs that are currently tagged as "Active" in Shop 

Manager appear on the list. In addition, only programs with the appropriate device class appear.  

Use the Browse option to select a different location for the file. 

 

The TOU Reconfigure process can take up to a minute to appear in the meter. You must 

log off and log back onto the meter to see any more seasons or status values. 
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Firmware Load 

Firmware can be downloaded to OpenWay devices via several methods: 

 from the OpenWay Collection Engine over-the-air 

 from OpenWay Field-Pro logged in optically 

 from OpenWay Field-Pro logged in via ZigBee 

If the download is done with Field-Pro, ensure that the correct firmware has been imported to Shop Manager. 

If a firmware download is unsuccessful, the meter continues to run the previous firmware version. 

 
 

 

If the meter is HW 3.1, it has register firmware version 005.005.xxx and its comm module has 

RFLAN firmware, this window displays both RFLAN and RF Mesh firmware, allowing the meter to 

be migrated to the IPv6 network.  

Register firmware version 005.005.xxx is dual stack firmware, able to communicate with comm 

modules loaded with either RFLAN firmware or RF Mesh firmware. 

Once a meter’s comm module is switched to RF Mesh firmware, no mechanism is provided to switch 

back to RFLAN. 

For more information, see Migrating a Meter from RFLAN to RF Mesh on page 72. 
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Select the firmware file to be downloaded by selecting the check box: 

 Register Firmware 

 RFLAN Firmware 

 RF Mesh Firmware 

 ZigBee (HAN) Firmware (HW 2.0 meters only) 

 Display Firmware (HW 2.0 meters only) 

 2.4 GZ Firmware (the meter passes the firmware to this device) 

 Gas Range Extender Firmware (the meter passes the firmware to this device) 

In order to appear on this window, firmware files must be marked as "Active" in Shop Manager, and they 

must match the device class of the component in the meter you are logged into. 

If a fatal error exists in the meter, the following message displays: "Meter has Fatal Error. Please contact 

customer support." Firmware loading is disabled until the fatal error is resolved.  
 

Downloading firmware to a meter using OpenWay Tools 

In most circumstances utility companies use the OpenWay Collection Engine to download firmware to meters 

over-the-air. When you need to load firmware locally, either by optical probe or ZigBee, use this procedure. 

Note that firmware download via ZigBee is extremely slow. 

1. Open Shop Manager and import the firmware files. Select the Active check box of all files to be 

downloaded. For more information see Importing Firmware on page 146. 

2. If OpenWay Field-Pro is located on a separate computer, create a Replica File. Exit Shop Manager. 

3. If necessary, load the Replica File. 

4. Log onto the meter with OpenWay Field-Pro. 

5. Go to the Firmware Load window (located under Programming Functions by default). 

6. Select a firmware file to download and click F1 to continue. 

7. Click F1 to begin downloading the firmware into the meter. Field-Pro displays a message when firmware 

download is complete.  

The firmware load is not complete until the CRC check is complete and the meter's display has returned to 

its normal operating state. Depending on the type of firmware that is being downloaded, you may see 

several things flash across the meter's display (such as CrCCALC, SEnd, Rfinit). 

In most cases, you must wait several minutes for the activation of the new firmware to complete. When 

you log back onto the meter the Meter Summary window displays the firmware versions. This indicates 

whether the download was successful. If it was unsuccessful, the meter continues to run the previous 

firmware version. 

8. You may need to re-initialize the device in order to take advantage of new features in the firmware. For 

more information see the OpenWay Field-Pro topic Initialize Device. 
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The firmware file name is recorded in the Activity Log. Hardware 3.1 meters create a 

record in the Firmware Download Event List. 
 

 

Migrating a Meter from RFLAN to RF Mesh 

Though most migration will be carried out using the OpenWay Collection Engine, individual meters can be 

migrated using OpenWay Tools. 

Migration is accomplished by downloading two sets of firmware to the meter.  

 Register Firmware Version 5.005.071 must be loaded first. 

 Comm Module Firmware Version 5.002.xxx (the build provided to your utility by Itron) is loaded 

second; within minutes after successful download the meter locates the RF Mesh network and joins it. 

Note  This release of the comm module firmware contains Global Certification code, which 

configures meters with global security information. You must then run the Mesh Certificate 

Replacement job (Collection Engine > Tools > Operations) to give each meter its own unique security 

certificate.  
 

1. After logging into the meter with OpenWay Field-Pro, use the Meter Summary window to see what 

firmware is loaded to the meter. For more information, see Meter Summary on page 2. 

If the firmware version fields do not display the build number (the final three digits), you must change the 

following setting in Shop Manager and load a new replica file to your PC.  

 System Settings > General Settings tab: select the Show Debug Information check box in the Data 

Display Options block. For more information, see General Settings (on page 156). 

2. If the register firmware version is not correct, download version 5.005.071 to the meter. For more 

information, see Downloading Firmware to an OpenWay CENTRON Meter on page 71.  

When the meter's register has firmware version 5.005.xxx and its comm module has RFLAN firmware, 

the Firmware Load window displays both RFLAN and RF Mesh firmware, allowing the meter to be 

migrated to the IPv6 network. Register firmware version 5.005.xxx is dual stack firmware, able to 

communicate with comm modules loaded with either RFLAN firmware or RF Mesh firmware. For more 

information, see Firmware Load on page 70. 

Note  Once a meter’s comm module is switched to RF Mesh firmware, no mechanism is provided to 

switch back to RFLAN. 

3. Download comm module firmware version 5.002.xxx (the check box on the Firmware Load window is 

labeled RF Mesh Firmware). 

4. After the comm module firmware is loaded, the meter syncs up with the RF Mesh network. To verify the 

stack change, go to the Comm Module Configuration window.  

The following fields indicate that the stack switch was successful: 

 Comm Module. RF Mesh 

 Stack Type. IPv6 

 Last Stack Switch. The date when the comm module firmware was loaded to the meter. 
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For more information, see Comm Module Configuration (on page 77). 

If the fields do not display the values shown above, contact Itron Customer Support. 
 

 

Validate Program 

Once the device is configured, this feature allows you to ensure that the correct values were programmed into 

the device. Only programs that are currently tagged as "Active" in Shop Manager appear on the list. In 

addition, only programs with the appropriate device class appear. 

Use F1 to select a program EDL file to validate against. The program data in the meter is compared to the 

program data in the external file. 

 

If an item fails to validate and one of the values is blank, it means that the program or 

meter does not support that value. 
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Configure KYZ 

The advanced OpenWay CENTRON Polyphase register supports an optional output board for a total of 2 

KYZ and 1 KY output. The configuration of this board is performed using OpenWay Tools on a site by site 

basis; KYZ functionality is managed entirely by OpenWay Field-Pro. The configuration of these fields is not 

provided by the Collection Engine. 

The pulse weight multiplier is 0.01. Pulse weights can range from 0.01 to 655.35 in increments of 0.01.  

Customers using these boards must configure all KYZ boards the same. OpenWay Field-Pro does not have 

different configuration files for the KYZ board. Current values are pulled out of the meter to use as the 

defaults on the UI for KYZ Configuration.  

The list of supported output types for the KYZ has been reduced to a set that applies to the OpenWay 

Polyphase meter. The list is as follows: 

 Configured Energy Quantities (Ke and Pulse Width) (Only on KYZ) 

 Demand Reset (Pulse Width) 

 End of Interval (EOI) (Pulse Width) 

 Rate Change (Pulse Width) 

The Output Type drop down box shows the applicable output types. Configured Net energy quantities are not 

shown. Rate Change is only shown if TOU is enabled. 

Pulse Weight and Pulse Width values allow you to type in a specific value or use the up or down buttons to 

increase or decrease the value by a increment corresponding to the selected Output Type. Any value entered 

that does not fall on the increment boundary is changed to the next lowest value that falls on the increment 

boundary. The values are also limited to a maximum and minimum value corresponding to the selected 

Output Type. Any value entered above the max is changed to the maximum value or any value entered below 

the minimum is changed to the minimum value. 

The Pulse Weight and Pulse Width items are enabled when a quantity is selected. Only the Pulse Width option 

is used for the Demand Reset, End of Interval and Rate Change types. When the Pulse Width or Pulse Weight 

controls are disabled, they revert to their default values. For the Pulse Width is 10 msec. and for the Pulse 

Weight this is 1.800 Ke.  

The KYZ outputs can support all output types. The Low Current (KY) Output can support all items except for 

the Energy Quantities. 

At the bottom of the window is a check box that allows you to disable the Outputs while the meter is in Test 

Mode. The default state is unchecked. 

After configuring KYZ a summary window displays with the existing KYZ configuration in the meter and the 

result of the operation at the top. 

For more information, see KYZ Summary on page 50. 
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Reconfigure SiteScan 

The OpenWay CENTRON meter can perform site and service checks based on the thresholds and parameters 

configured for each diagnostic. The SiteScan Diagnostics feature allows field technicians to immediately 

obtain crucial meter site information without using external equipment or disturbing a sealed installation. You 

can view diagnostics while communicating with a meter through OpenWay Tools or by viewing the meter’s 

display. 

Use the SiteScan Configuration component to define which diagnostics the meter monitors, counts, and 

displays. Diagnostic counters store the number of occurrences of each configured diagnostic condition.  

The meter checks every five seconds for configured diagnostics. A diagnostic condition must exist for 15 

seconds (three checks) to be counted as a diagnostic event and displayed, if configured for display. The 

diagnostic condition must be clear for ten seconds (two checks) before the diagnostic alert is cleared and 

removed from the meter display. 

A clock and battery are required for OpenWay CENTRON meters that record and/or display time of 

occurrence values such as SiteScan Diagnostics data. 

SiteScan Diagnostics 1-4 can be configured to be enabled or disabled. When a diagnostic is enabled, you can 

choose to display it on the LCD or not display it.  
 

Validate Optical Passwords 

Optical security levels in the OpenWay meter register are: 

 Primary. Access to the device is not restricted, including read and write functions, and programming and 

firmware updates. New security codes can be programmed. 

 Secondary. read, limited write access, and the ability to reset demand is permitted. The ability to change 

the time in the device, and reconfigure the device is permitted. The ability to clear billing data, change 

display modes or change security codes is NOT permitted. 

 Tertiary. Provide read-only and reset capability to the device. Reset Demand Registers and change the 

device time is permitted. 

 Quaternary. Provides read-only access to the meter. No write access to the device is permitted. 

Click F1 to Validate Optical Passwords. Click F9 to return to the previous menu. 
 

Reconfigure LED Quantity 

The light emitting diode (LED) in the top of OpenWay meters can be configured to pulse different quantities 

using this window. Your choices depend on the register's device class the meter you are logged into. 

Singlephase Register Device Class Available Quantities 

ITR1 (singlephase HW 2.0 and 3.0) Wh d 

VAh d 
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Singlephase Register Device Class Available Quantities 

ITRD (singlephase HW 3.1) Wh d 

varh d 

. 

Polyphase Register Device Class Available Quantities 

ITR3 (polyphase basic HW 2.0 and 3.0) 

ITR4 (polyphase advanced HW 2.0 and 3.0) 

ITRE (polyphase basic HW 3.1) 

ITRF (polyphase advanced HW 3.1) 

The same nine options are available for all polyphase meters: 

Wh d 

Vh r 

Wh (Wh d & Wh r) 

varh d 

varh r 

varh (varh d & varh r) 

VAh [Arith | Vec] d 

VAh [Arith | Vec] d 

VAh [Arith | Vec] (VAh d & VAh r) 

[Arith | Vec]: the window offers either arithmetic or vectorial 

calculation, based on what the meter is configured to use (selection in 

the Collection Engine). 

For more information, see the OpenWay Technical Reference Guide for the device. 
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Comm Module Operations 

Several options exist for OpenWay meters to communicate with the utility company. When Field-Pro logs 

onto a meter, it determines what communication method the meter uses, then offers options appropriate to that 

method. 
 

Comm Module Configuration 

This window displays relatively static information about the meter's communication module: any updates to 

the data are in response to user actions. The fields that display vary depending on the communication mode of 

the meter. 

 
 

Field Description 

Comm Module The type of communication module in the meter: Cellular, RF Mesh, RFLAN, RFLAN Master, 

PLAN or third party. 

Comm Module 

Utility ID 

If the communication module is RFLAN (and the RFLAN is enabled), this field displays a numerical 

identifier (one byte) assigned by Itron to an OpenWay customer and embedded in all meters and cell 

relays manufactured for them; it associates all the parts of that utility company's RFLAN network. 

Comm Module 

Version 

The version number of the firmware loaded on the meter which controls the communication module. 

Comm Module MAC 

Address 

If the meter is connected to an RFLAN network, the last characters of the meter's MAC address 

display. These are also printed on a sticker on the face plate of the meter above the display. 

If the meter is connected to an RF Mesh (IPv6) network, The meter's physical address displays: the 

address of the endpoint which begins with the IPv6 address of the CGR (connected grid router) and 

ends with the last six digits of the device's MAC address. 

Comm Module 

ApTitle 

The RFLAN or RF Mesh communication module destination address (in C12.22 terminology, the 

called ApTitle). 

Master Relay ApTitle The unique Master Relay destination address; in C12.22 terminology, the called Application-process 

title (ApTitle). 

Native Address Endpoint address outside of the application naming scheme that can be used by the underlying 

transport protocol. For example, a native address in the LAN is an internet socket address. 
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Field Description 

Relay Native Address The Cell Relay Native Address also known as the Network Address. A unique address that enables the 

cell relay to send and receive data packets to communicate on the network. 

Multicast Addresses An address used to target a group of meters. By broadcasting to a multicast address, the Collection 

Engine can simultaneously send firmware updates, messages, jobs, or configuration data to all meters 

in the multicast group. The Collection Engine builds multicast addresses dynamically, by appending a 

group number to a cell relay or Connected Grid Router broadcast port. 

Stack Type The type of OpenWay network the meter is currently communicating in: RFLAN or IPv6 (RF Mesh). 

Last Stack Switch If the meter has been switched one stack type to the other, this field displays the date and time when the 

switch occurred. (If "1970" displays, it means that the meter stack type has not been switched.) 

Stack Switch Count The total number of times the meter has switched from one stack type to another. 

Exception Hosts This is the means by which a meter sends exception messages to the utility. If the meter is configured 

to do so, events that have been marked as exceptions cause an exception message to be sent to the 

Exception Subscriber Web Service using the ApTitle address shown.  
 

 

Communication Status - RFLAN 

The Communication Status window gives information on network or cellular statistics. Some of the 

information is dynamic, responding to fluctuating changes in the network. This window displays different 

fields depending on what kind of communication module the meter has.  

 Below are the fields that display if the meter communicates via RFLAN.  

 If the meter communicates via RF Mesh, go to Communication Status – RF Mesh.  

 If the meter communicates via cellular, go to Communication Status – Cellular on page 81. 
 

Field Description 

ESN Electronic Serial Number. A number assigned to each device when it is manufactured. ESNs are 

unique across all manufacturers and product lines.  

Comm Module Level The Level refers to the meter's level in the RFLAN cell. It is useful for troubleshooting the meter's 

communication. 

Level 0. Not in communication with the RFLAN; should only be seen during the initial installation 

process. 

Level 1. The cell master meter is communicating with (and most likely is attached to) the cell relay. 

Level 2-32. Only applicable to non-cell master meters. 

Synchronization 

Status 

Not Sync. The meter is looking for neighbor meters.  

Sync. The meter is talking to neighbor meters. 

Sync Net. The meter is part of a cell; this is the desired state. 

Registration Status Not Reg. The meter is not yet registered with the OpenWay Collection Engine. 

Reg. The meter is registered with the Collection Engine; this is the desired state. 

Registration Lifetime Each network registration packet contains a value that indicates when the registration expires. If 

registration has not been completed by the expiration time, the packet dies and is not transmitted any 

further in the system. If the meter has not received a registration acknowledgment from the Collection 

Engine within a configurable period after it has sent a registration packet, the meter sends another 

packet and retries the registration process. This continues until the meter is successfully registered with 

the Collection Engine. 
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Field Description 

Expiration 

Countdown 

Countdown occurs for all packets that are time critical. When the countdown time expires, the packet 

dies and is removed from the system. Generally, time critical packets have a number of retries and 

retry delay times configured. 

Registration Delay This value is the amount of time the meter waits between retries when attempting to register with the 

Collection Engine. 
 

Network Statistics (RFLAN) 

Number of Bytes 

Received 

The comm module has received this number of bytes of data from the RFLAN network. When the 

comm module is reset, this value clears and begins counting up again. 

Number of Bytes 

Sent 

The comm module has sent this number of bytes of data to the RFLAN network. When the comm 

module is reset, this value clears and begins counting up again. 

Comm Module 

Current Level 

The number of hops the meter is from the Cell Master. 

Number of Comm 

Module Level 

Changes 

The meter keeps track of the number of times that the number of hops has changed. 

Core Dump State 0. No core dump is currently saved. 

5. A core dump has been saved.  

Network State Not Synch. The meter is looking for neighbor meters.  

Synch not ACK. The meter has synchronized but has not yet heard from neighbors. 

Synch. The meter is talking to neighbor meters. 

Synch Net. The meter is part of a cell; this is the desired state. 

Broadcast State A meter is in "Broadcast State" during the time window in which it is handling or repeating a multicast 

message. At all other times, this field displays "No Active Broadcast." 

Outage ID A unique identifier assigned to track an outage event. 

Is Synchronized Now Yes. Is currently synchronized. 

No. Is not currently synchronized. 

GPD Global Average Propagation Delay (GPD) values are used to sort and select neighbors. They are used 

to select the best access for synchronization or to make a choice between different available cells. The 

network layer uses these values to choose the best path for routing packets. 

Father A network node hierarchically above a child node that may be used for routing information to and 

from the child. A network end point which when compared to another end point of the same cell is at a 

level N+x, where x1.  Therefore, within a cell each node builds a list of other nodes that it can 

communicate with and contains routing information which allows it to determine the best routing up to 

the Collection Engine. Any node that is one level above the current node in the path back to the 

Collection Engine is that node's father. There can be several categories of fathers, such as potential 

synchronization fathers and healthy fathers. 

Comm Module 

Synch Father MAC 

Address 

The MAC address of the RFLAN device's synchronization father: the node it uses to pass data through 

the RFLAN. 

LPD Local Average Propagation Delay (LPD) values are used to sort and select neighbors. They are used to 

select the best access for synchronization or to make a choice between different available cells. The 

network layer uses these values to choose the best path for routing packets. 

RXI The Reception Rate Indicator provides an indication of the rate at which messages are heard from a 

neighbor, although it is not an exact measurement of the actual reception rate. 
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Average RSSI The Average RSSI gives an indication of the received signal quality, even in environments with 

Rayleigh fading. Average RSSI participates in the choice of the best synchronization father. 

Comm Module MAC 

Monocast Rx Count 

A MAC layer packet is referred to as a Monocast. This field is a count of the number of Monocast 

messages that have been received by a meter. 

Comm Module Net 

Downlink Packet 

Count 

The number of times an RFLAN Net Download Packet has been received. 

Comm Module 

Uplink Packet Count 

The number of times an RFLAN Net Download Packet has been sent. 

Comm Module Net 

Routing Count 

The number of meters that route through this cell relay. 

 
 

Communication Status – RF Mesh 

Field Description 

ESN Electronic Serial Number. A number assigned to each device when it is manufactured. ESNs are 

unique across all manufacturers and product lines.  

Comm Module MAC 

Address 

The unique number assigned to the meter by its manufacturer to identify the device’s Internet Protocol 

(IP) network adapter.  

Comm Module PAN 

ID 

16-bit unique number that identifies each PAN (Personal Area Network).  This number is used by 

devices to decide which network to join out of the list of available networks. Devices can only join a 

network if the PAN ID matches.  

SSID Service Set Identification. RF Mesh networks use SSID (instead of Utility ID as RFLAN networks do) 

to commonly identify all devices in the network. 

Comm Module IP 

Address 

The address of the endpoint begins with the IPv6 address of the CGR (connected grid router) and ends 

with the last six digits of the device's MAC address. 

Comm Module 

Current Time 

The date and time on the RF Mesh network at the moment this window was opened. 

Registration Lifetime Each network registration packet contains a value that indicates when the registration will expire. If 

registration has not been completed by the expiration time, the packet dies and is not transmitted any 

further in the system. If the meter has not received a registration acknowledgment from the Collection 

Engine within a configurable period after it has sent a registration packet, the meter sends another 

packet and retries the registration process. This continues until the meter is successfully registered with 

the Collection Engine. 

Expiration 

Countdown 

Countdown occurs for all packets that are time critical. When the countdown time expires, the packet 

dies and is removed from the system. Generally, time critical packets have a number of retries and 

retry delay times configured. 

Registration Delay This value is the amount of time the meter will wait between reties when attempting to register with the 

Collection Engine. 

IEEE 802 1x Status A networking protocol that provides an authentication mechanism to meters wishing to attach to the 

RF Mesh network. Open the node to display information about network access control. 

The fields indicate whether the certificates are valid, allowing the meter to get on the network. New 

certificates may be required if the meter cannot attach to the RF Mesh network. 
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Network Statistics (RF Mesh) 

Number of 

Registrations Sent 

Number of registration request packets sent by a device. When a device tries to join a network it has to 

send a registration request packet. This is either accepted and the device is connected to the network, or 

it is rejected and the device can try registering again. Reasons for rejection can be low signal strength, 

permissions / security clashes etc.  

Number of 

<acse_pdu> Sent 

An ACSE application data unit with the Calling ApTitle set to the ApTitle of registering node and the 

Called ApTitle set to the ApTitle of the registration authority (C12.22 master relay). This <acse_pdu> 

carries a list of ApTitles to be registered to the network. 

Number of 

Registrations Failed 

Number of registrations requests packets that were not successful / rejected. Usually a device has a 

preset threshold for registration fails. If this threshold is reached, the device attempts to join another 

network (if available) or generates an error and stops trying to join. This prevents a device from falling 

into an infinite loop when trying to join and always failing. 

Field Area Router 

Field Area Routers (FARs) are akin to repeaters in that they can be installed in remote areas to allow RF 

signals to be relayed to suburban area networks without the need for additional infrastructure. They also have 

the ability to connect to other forms of communication (3G, 4G, Wi-Fi etc.). This allows a FAR to be installed 

at secondary sub-station and interrogated remotely by the utility as well as providing the relay service to the 

network.  

RPL Hops Number of hops from this meter to the CGR. 

RPL Path Cost This is a figure calculated from the "Spanning-Tree Protocol" (STP) which is detailed in 802.1d. Every 

device that joins a network goes through the STP upon joining. The system calculates the bandwidth 

of all possible pathways leading to the new device. A path cost value is then derived from these 

bandwidth figures. The algorithm for determining the path cost is 1Gb/s ÷ bandwidth. 

Once all paths costs are determined for a new device, the system uses the path with the lowest 

figure. All paths are continuously monitored; if a different path becomes faster (has a lower cost than 

the current path), data is streamed through that path instead. 

RPL Link Cost Same as above but only for connections between adjacent nodes. 

RSSI Forward The strength of the signal from this meter out to its neighbor endpoints or the CGR. 

RSSI Reverse The strength of the signal back to this meter from its neighbor endpoints or the CGR. 
 

 

Communication Status - Cellular 

ICM 

The Itron Cellular Module (ICM) is a communications board in the meter that interfaces with the cellular modem which provides two-

way communications between the meter and the head-end system. The values in this window refresh only when you log off then log back 

onto the meter. 

Field Description 

Hardware Version The version number of the ICM communications board. 

Firmware Version The version number of the firmware that manages the ICM. 

Number of Super 

Capacitors 

If a meter loses power, the capacitors provide the electricity needed to send a message to the utility 

regarding the outage. 

Module Serial 

Number 

The unique ID for the ICM, assigned by the manufacturer. 

CPU Identifier The unique ID for the Central Processing Unit; assigned by the manufacturer. 
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Field Description 

Boot Loader Version The version number of the program that runs the startup sequence when power is switched on to the 

CPU. 

Last Power Failure 

Date & Time 

If the ICM has shut down due to power failure, the date and time of the most recent shutdown displays.  

Super Capacitor 

Status % 

Capacitors should display 100% (fully charged) most of the time. After an outage, they may take a few 

seconds to return to 100% when power is restored. 

Reboot Count The number of times the ICM has been restarted. 

Up Time (seconds) The number of seconds since the last time the meter powered up. 

Module Status/State Initial status.  

Prior to contacting configuration server.  

Auto-configured and attempting to auto-register.  

Auto-registered with TMS waiting to be provisioned.  

Provisioned by TMS.  

Module Temperature 

(Celsius) 

To protect sensitive hardware, the ICM contains a thermometer and monitors the temperature in order 

to shut down if the temperature becomes too extreme. 
 

Cellular 

The meter contains a cellular modem that interfaces with the ICM and communicates point-to-point between the meter and the head-end 

system. 

Field Description 

Manufacturer The name of the company that manufactured the cellular modem. 

Model The manufacturer's model number for the cellular modem. 

IMEI (GSM)/ESN or 

MEID (CDMA) 

The electronic ID of the cellular modem. 

2G (GSM) modems display IMEI (International Mobile Equipment Identification). 

3G (CDMA) modems display ESN (Electronic Serial Number) or MEID (Mobile Equipment 

Identifier), depending on manufacturer. 

SIM ICC-ID (GSM) The unique serial number of the modem's SIM card, which securely stores the modem's IMSI and the 

related authentication key used to identify and authenticate subscribers. 

IMSI (GSM) / MIN 

(CDMA) 

The unique ID that wireless carriers use to identify an individual cell phone or modem. 

2G (GSM) modems display the modem's International Mobile Subscriber Identity. 

3G (CDMA) modems display the modem's Mobile Identification Number. 

Signal Strength (dbm) A measurement of the power present in the cellular signal. It is measured in decibels per milliwatt. 

 -100 is very poor; the hardware may have trouble turning the transmission into meaningful data 

and there will be many dropped packets. 

 -70 is average. 

 -50 is approaching saturation. 
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Field Description 

Registration Status All of the states below apply to 2G (GSM) modems. 

Only the first two states apply to 3G (CDMA) modems. 

 not registered, modem is not currently searching a new operator to register to 

 registered, home network 

 not registered, but modem is currently searching a new operator to register to 

 registration denied 

 unknown 

 registered, roaming 

 registered for "SMS only," home network 

 registered for "SMS only," roaming 

 attached for emergency bearer services only 
 

Last Successful 

Communication with 

Tower 

The date and time when the modem most recently communicated successfully with the cell tower. 

Hardware Version The manufacturer's designation for the cell modem's hardware version. 

Firmware Version The version number of the firmware that manages the cell modem. 

Tower Identifier The Base Station ID of the cell tower that this modem uses. 

Sector Identifier The Base Station transceiver/antenna ID. 

Number of Cell 

Tower Changes 

The number of times the modem has switched from one cell tower to another. 

Link Connection 

State 

Link Up. The modem's connection to its radio link is operational. 

Link Down. The modem's connection to its radio link is not operational. 

Network Connection 

Up Time (seconds) 

The number of seconds since the last time the network connection became operational. 

IP Address The Internet Protocol address of the cell modem. 

Gateway Address The Internet Protocol address of the Gateway. 

Cumulative Kilobytes 

Sent 

The cellular modem has sent this number of kilobytes of data during its lifetime. 

Cumulative Kilobytes 

Received 

The cellular modem has received this number of kilobytes of data during its lifetime. 

Bytes Sent The cellular modem sent this number of bytes of data in the most recent session. After the session ends, 

this number is added to the cumulative counter and cleared. 

Bytes Received The cellular modem received this number of bytes of data in the most recent session. After the session 

ends, this is number is added to the cumulative counter and cleared. 

Traffic Channels - 

Good CRC Count 

Cyclic Redundancy Check (CRC) is a method for ensuring that transmitted data is identical to what 

was sent. Possible reasons for failure include technical malfunction and attempted tampering. 

This field displays the sum of good CRC counts over the 15 traffic channels. 

Traffic Channels - 

Bad CRC Count 

The sum of bad CRC counts over the 15 traffic channels. 

Control Channels - 

Good CRC Count 

The sum of good CRC counts over the 2 control channels. 
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Field Description 

Control Channels - 

Bad CRC Count 

The sum of bad CRC counts over the 2 control channels. 

Figure of Merit 

(Good CRC 

percentage) 

The sum of good CRC counts divided by the sum of total CRC counts. 

Number of Link 

Failures 

The number of times the cellular modem has failed to link. 

Modem Temperature To protect sensitive hardware, the cell modem contains a thermometer and monitors the temperature in 

order to shut down if the temperature becomes too extreme. 

Last Modem 

Shutdown Due to 

Extreme Temperature 

If the modem has shut down due to extreme temperatures, the date and time of the most recent 

shutdown displays.  

Last Modem Power 

Up after Extreme 

Temperature 

Shutdown 

If the modem has shut down due to extreme temperatures, the date and time the the meter powered up 

displays.  

MDN Radio Phone 

Number 

The phone number of the cellular modem. The head-end system sets the value when the ICM auto-

registers. 
 

 

Neighbor List 

The Neighbor List window displays the radio signals of all endpoints that are within range of the meter you 

are currently logged into. The number of endpoints within range is influenced by a number of factors such as 

distance, number of hops to the connected grid router (RF Mesh) or cell relay (RFLAN), latency, and signal 

strength. 

 
 

Neighbor List (RFLAN) 

Field Description 

MAC Address The unique number assigned to the meter by its manufacturer to identify the device’s Internet Protocol 

(IP) network adapter.  

Synch Merit Indicates which neighbors are good to synchronize with, lowest being the best. The values used to 

calculate the Synch Merit are GPD, LPD, Level, Cell Size Indicator, and Receive Rate. 
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Field Description 

RSSI  Received Signal Strength Indicator is a measurement of the power present in a received radio signal. It 

is formatted as a single signed byte and is measured in decibels per milliwatt (dBm).  

 -100 is very poor; the hardware may have trouble turning the transmission into meaningful data 

and there will be many dropped packets. 

 -70 is average. 

 -50 is approaching saturation. 
 

LPD Local Average Propagation Delay (LPD) values are used to sort and select neighbors. They are used to 

select the best access for synchronization or to make a choice between different available cells. The 

network layer uses these values to choose the best path for routing packets. 

Level The number of hops from this neighbor to the cell relay. Cell relays display "1" in this column. 

Transmit Window The time slot when this neighbor is to send its next packet. It is measured in units of 150 milliseconds. 

The purpose is to randomize the timing of transmissions. 

Receive Rate Counts the number of good messages the meter has received from this neighbor, to a maximum of 

255. This value is reset to zero when the endpoint is powered down, reconfigured, or its RFLAN is 

reset. 

 
 

Neighbor List (RF Mesh) 

Field Description 

Physical Address The address of the endpoint begins with the IPv6 address of the CGR (connected grid router) and ends 

with the last six digits of the device's MAC address. 

RSSI Received Signal Strength Indicator is a measurement of the power present in a received radio signal. It 

is formatted as a single signed byte and is measured in decibels per milliwatt (dBm).  

 -100 is very poor; the hardware may have trouble turning the transmission into meaningful data 

and there will be many dropped packets. 

 -70 is average. 

 -50 is approaching saturation. 
 

RSSI Forward The strength of the signal from this neighbor out to its neighbor endpoints or the CGR. 
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Field Description 

RSSI Reverse The strength of the signal back to this neighbor from its neighbor endpoints or the CGR. 

Last Heard The last date and time when this neighbor heard from the CGR or any of its neighbors. When meters 

are new, this field updates frequently. When the network is stable, days may go by between updates. 

 
 

Reset Comm Module 

This window is accessible when you are logged into a meter that communicates via RFLAN or RF Mesh, 

though the window appears differently for the two communication methods. 

The function of this window is to reboot the comm module. If communicating via RFLAN there are three 

options, if RF Mesh there is just one.  

To Reset Comm Module without Parameter Change (RFLAN, RF Mesh) 

On occasion, the communications module may stop sending the appropriate messages to the register board. 

Use this function when the meter is not connected to the network or not synchronized with it. Indications that 

this process is needed include (but are not limited to): 

 Network Statistics showing no data being transferred or received 

 Neighbors List window is empty 
 

To perform this function, select F1 without modifying any of the fields. The comm module reboots, performs 

calculations to determine cell merit, and re-establishes connections to the network. Both the Neighbors List 

and Communication Status windows to clear and then begin rebuilding the data as the comm module re-

establishes its connections. 
 

To Reset Comm Module with Preferred Cell ID (RFLAN only) 

If you know which cell you want the meter to use, specify the ID, then click F1 to reboot the comm module 

with that specification. 

Field Description 

Current Cell ID The default is zero which means "no selection." It permits the meter to select a cell relay based on cell 

merit calculations. 

Set Preferred Cell ID Check the box in order to specify one particular cell relay that this meter must use. Enter the cell's ID in 

the field. 

Use the Collection Engine to determine a cell relay's ID. Choose System Management > Device 

Management > Field Area Routers. Select the router to open the Field Area Router Details window. 

The cell ID is the last node of the ApTitle. 
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To Reset Comm Module with Alternate Cell Merit Calculation Method (RFLAN only) 

The default cell merit calculation works well in most circumstances even though it does not include RF Level 

in the formula. (RF Level correlates to the number of hops from the utility to the meter. A lower value is 

usually better.) Occasionally a "sticky meter" condition may occur, where the meter remains with a cell relay 

that causes it to have a higher RF Level. In this case you can switch the meter to use an alternate cell merit 

calculation that incorporates RF Level.  

Field Description 

Current Cell Merit 

Calculation 

Displays the calculation method currently in use. 

Set Cell Merit 

Calculation 

Check this box to switch to the other calculation method. 
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Register with Host 

Use this function to force the meter to send a registration request immediately. By default a meter does not 

send a registration request immediately when it first powers up. The first one is sent at a random time between 

10 and 50 minutes after a meter joins a cell. Time to join a cell is variable based on network conditions.  

The timing of the registration process depends on network conditions and the meter's configuration. Using 

default settings and an idle, functioning network, the registration process should be a matter of seconds or 

minutes from the time you send the request. Typically, this value would be a minute or less. If many meters 

are trying to register at once, getting the whole population into a registered state can take much longer. It 

depends in large part on how heavy the cell loading is across the population. 

To initiate the registration procedure, click F1 Confirm Registration. Note that the Register with Host 

option is only available if the meter is not registered. 
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Deregister from Host 

This option initiates the Deregister procedure and is only available if the meter is registered.  

The timing of the deregistration process depends on network conditions and collection engine parameters that 

are set. Using default settings and an idle, functioning network, the deregistration process should be a matter 

of minutes at the most from the time the request is sent. Typically, this value would be a minute or less. In the 

case where there is a large volume of meters trying to register at once, getting the whole population into a 

deregistered state can take much longer. It depends in large part on how heavy the cell loading is across the 

population. 

To initiate the Registration procedure, click F1 Confirm Deregistration. Note that the Deregister with Host 

option is only available if the meter is not deregistered. 

 
 

Validate Enhanced Security Keys 

An Enhanced Security Key is used in the meter to authenticate a message that is received from the Collection 

Engine. The Validate Enhanced Security Keys option allows you to validate that the correct security keys 

are configured in the meter based on the given configuration file. 

Click F1 to Validate Enhanced Security Keys. Click F9 to return to the previous menu. 
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Validate DES Keys 

DES (Data Encryption Standard) Keys are used in the meter. DES Keys are used in the meter to decrypt 

messages that are received from the Collection Engine, and to encrypt messages that are transmitted from the 

meter to the Collection Engine. The Validate DES Keys option allows you to validate that the correct DES 

keys are configured in the meter based on the given configuration file. 

Click F1 to Validate DES Keys. Click F9 to return to the previous menu. 
 

Opt Out 

This window provides the ability to disable and enable the communications module in the meter.  

 

In response to the public's concern about smart meter functionality and radio transmissions, some utility 

companies provide customers the option of turning off the radio in their meter's communication module. 

When disabled, all network related functionality is also disabled including display of network statistics and 

registration features. Once disabled, the only way to read the meter or make any changes is to log into the 

meter optically or via ZigBee. 

To re-enable the communications module, return to this window and click the F1 button, which is now labeled 

Enable. 
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TLV Request 

This feature is available only if you are logged into an IPv6-enabled meter, an OpenWay CENTRON 

Hardware 3.1 meter that communicates via an RF Mesh network. 

The TLV Request window allows you to request diagnostic information from the comm module. (TLV stands 

for Type Length Value, which describes the way that information is presented in the raw packet.) 

Select the check box of one or more categories of information. When you click F1, the meter register requests 

the information from the comm module. The comm module sends back a packet of data and Field-Pro 

displays it in a table. 

Note  This function requires that a TLV Definition File be loaded on your PC. Contact Itron Customer 

Support for additional information. 
 

Download RF Mesh Configuration 

This window allows you to configure meters with required security information before they begin 

communicating via RF Mesh. The process looks similar to firmware download, but unlike a firmware file 

which can be downloaded to any number of meters, an RF Mesh configuration file is created for only one 

meter. The two fields are automatically populated if the RF Mesh configuration file and PPP key file have 

been imported using Shop Manager and have file names which contain the last six characters of the meter's 

MAC address. Browse buttons are provided to allow you to browse to the desired files if Field-Pro can't find 

them. 

 



OpenWay Field-Pro 

 
 

OpenWay Tools User Guide 92 

 Proprietary and Confidential 
 
 
 

The RF Mesh Config file is downloaded through the register to the comm module. It contains the security 

certificate that authenticates communication onto the IP network, giving the meter permission to talk to the 

OpenWay Collection Engine. 

The PPP Key file tells the register what key to use to encrypt and decrypt information exchanged between the 

comm module and the register. 

Both files must be downloaded at the same time. If only one field is populated, the window displays an error 

message when you try to start the download. 

When you click F1 – Download Files, the window displays a message asking you to verify that the comm 

module firmware on the meter is compatible with this configuration file. If you are not sure, contact Itron 

Customer Support. 

Click F1 to complete the download. 

For more information about the transition to RF Mesh, see Migrating a Meter from RFLAN to RF Mesh on 

page 72. 
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Change Utility ID 

This window allows you to change the Utility ID of the meter you are logged into. The window is accessible 

for meters that communicate via RFLAN. The feature must first be set up in Shop Manager. 

A Utility ID is a numerical identifier (one byte) assigned by Itron to an OpenWay customer and embedded in 

all meters and cell relays manufactured for them; it associates all the parts of that utility company's RFLAN 

network. The purpose is to prevent two utilities with adjoining service areas from "hearing" each others' 

meters. Utility companies may choose to change the Utility ID in some of their hardware for testing purposes. 

It is essential that only Itron-assigned numbers are used. 

 
 

To change the meter's Utility ID, select one of the rows in the box and click F1 - Change Utility ID. The 

process takes several seconds. The window then displays the previous and current Utility IDs. You must log 

off the meter after this process. 
 

 

Change Cellular Gateway 

When you are logged onto an OpenWay ICM (cellular) meter, this window allows you to change the meter's 

cellular gateway. 

 Note  Shop Manager's Utility Identification Settings must include at least two groups with 

Cellular Gateway values. For more information see Utility Identification Settings on page 

160. 
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When the window opens, the meter's current cellular gateway is highlighted. To change it, select another row 

and click F1 – Change Cellular Gateway. The window's heading changes to "Updating Cellular Gateway..." 

and the progress bar advances till completion. Once complete, the window's heading changes to show success 

or failure of the operation. If successful, the window lists the previous and current gateways. 

You must now log off the meter and log back on before performing any additional operations. 
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Change ERT Utility ID 

When you are logged onto an OpenWay ICM meter, this window allows you to change the meter's ERT 

Utility ID. 

 
 

ERT Utility IDs are used in OpenWay networks where 100G gas meters have ERT Modules to send their 

consumption data. OpenWay ICM meters with ERT Readers "hear" the transmissions if they contain the 

correct ERT Utility ID. The meters ignore transmissions that do not contain this matching identifier. Utility 

companies generally have one Utility ID for their production environment and one or more additional Utility 

IDs for testing purposes. For more information see Utility Identification Settings on page 160.  
 

 Caution  Where two utility companies have adjoining service areas, the Utility ID 
is responsible for ensuring that the two companies' devices are not 
communicating with each other. Therefore it is imperative that you only use Utility 
IDs that Itron has assigned to your company.  

 

When the window opens, the meter's Current ERT Utility ID displays above the table. To change the ID, 

select a row in the table and click F1 – Change ERT Utility ID. The window's heading changes to "Updating 

ERT Utility ID..." and the progress bar advances till completion. Once complete, the window's heading 

changes to show success or failure of the operation. If successful, the window lists the previous and current 

IDs. 

After updating the ERT Utility ID, you must log off the meter and log back on before performing any further 

operations. 
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ERT Statistics 

This window is accessible only when you are logged into an OpenWay CENTRON ICM meter with ERT 

Reader. This window displays the transmission data of all ERT transmissions it has heard in the past 24 hours. 

It does not display the consumption data contained in the transmissions. 

OpenWay 100G gas meters have ERT modules which send out "chirps" containing their encrypted data. 

Nearby OpenWay ICM meters with ERT Readers listen for these transmissions and pass them along to the 

Collection Engine via cellular data transmission. It is possible for multiple ICM meters to hear and pass along 

the same ERT transmissions. The Collection Engine is responsible for deleting duplicates. 

 
 

Field Description 

ERT ID The unique identification of the ERT module in the gas meter. 

ERT Type The type of meter whose consumption data is contained in the ERT transmission. 

Time Recorded The date and time that the ICM meter received the ERT transmission. 

# Recent Reads The number of times during the past 24 hours that the ICM has heard from each nearby gas meter. 

Average RSSI Received Signal Strength Indicator is a measurement of the power present in a received radio signal. It 

is formatted as a single signed byte and is measured in decibels per milliwatt (dBm).  

-100 is very poor; the hardware may have trouble turning the transmission into meaningful data and 

there will be many dropped packets. 

-70 is average. 

-50 is approaching saturation. 
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Send Diagnostic Command 

This window is enabled only when you are logged into an OpenWay ICM (cellular) meter. 

The Send Diagnostic Command function allows Field-Pro users to send commands to the Itron Cellular 

Module. Contact Itron Customer Service for instructions, syntax, and commands. 

 
 

 

Diagnostic Events List 

For GE meters with Itron Cellular Modules, this window displays events that can help diagnose issues related 

to the cellular module. The meter configuration determines which incidents cause the meter to log events. This 

window displays all events logged on the meter since the last time it was configured.  

For OpenWay ICM meters, refer to Events List (on page 52). 
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Field Description 

Time The date and time that the event occurred. 

Event The name of the event. 

User ID If a user was logged into the meter when the event occurred, their User ID is recorded. If no one was 

logged in, 0 displays. 

Data Some events have associated details that are known about the event. 
 

 

Diagnostic Events Summary 

For GE meters with Itron Cellular Modules, this window displays all possible cellular module events. The 

Action column indicates how many times the event has occurred. "Logging Disabled" indicates that the meter 

is configured to ignore that event. 

For OpenWay ICM meters, refer to Events Summary (on page 51). 
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CENTRON Bridge Meter 

CENTRON Bridge meters are a class of AMR/AMI meters that allow utility companies to bridge the gap 

between their current mobile collection systems and their future Smart Grid systems. 

CENTRON Bridge meters have two communication modules. They have an ERT module allowing them to be 

read by ChoiceConnect® Mobile software. They also have an OpenWay comm module, ready to begin 

communicating with either an RFLAN or RF Mesh network. 

When you log into a CENTRON Bridge meter, the Meter Summary window displays some additional 

information not present in other meters.  

 

ChoiceConnect ERT ID. Displays the 8- or 10-digit unique identifier for the ERT 

(encoder/receiver/transmitter) module. The ERT ID is permanently assigned to the meter at the time of 

manufacture and allows the meter to be read by ChoiceConnect Mobile meter reading software. 

Register Firmware Version. 3.032.xxx and 5.008.xxx are the only versions of OpenWay register firmware 

that support communication with ChoiceConnect Mobile meter reading software. 

ChoiceConnect Firmware Version. Displays the version and build number of the ChoiceConnect firmware 

loaded to the comm module in the meter. The word "Active" appears after the number if the meter is currently 

in ChoiceConnect mode. If it is in OpenWay mode, "Active" appears after the Comm Module Firmware 

Version. 

CENTRON Bridge meters with ChoiceConnect comm module firmware version 0.21.xx must have register 

firmware version 3.032.xxx. Meters with ChoiceConnect comm module firmware version 0.30.xx must have 

register firmware version 5.008.xxx.  
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Special Note on CENTRON Bridge Meters 

CENTRON Bridge meters that began with ChoiceConnect firmware v0.21.xx were injected with security keys 

supported by Certicom security and will remain in ChoiceConnect mode. OpenWay Field-Pro does not allow 

these meters to be reconfigured: the Initialize Device function is disabled. If a change is required, contact Itron 

Customer Support to have a custom configuration file created. 

Meters that began with ChoiceConnect firmware v0.30.xx were injected with security keys supported by Itron 

Security Manager (ISM) and can migrate forward to AMI smart grid meters on RFLAN or RF Mesh 

networks. OpenWay Field-Pro allows these meters to be reconfigured if the configuration is ChoiceConnect 

compliant: 

 If Time of Use is enabled, it supports 25-year TOU Schedule 

 no self reads on season change 

 all demand resets on season change are set consistently 

 If load profile is included in configuration, interval length must be 15 minutes. 
 

Upgrading firmware 

OpenWay Field-Pro enforces the following sequence when upgrading firmware in CENTRON Bridge meters. 

1. Upgrade the register firmware. 

2. Load a configuration file that is ChoiceConnect compliant. 

3. Upgrade the ChoiceConnect firmware. 
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ChoiceConnect Comm Module Configuration 

This window is accessible when you are logged into a CENTRON Bridge meter. It displays information about 

the ChoiceConnect communication module. 

 
 

Field Description 

Comm Module Displays the mode that the Comm Module is currently in: ChoiceConnect or OpenWay. 

ChoiceConnect 

Comm Module 

Version 

Displays the version and build number of the ChoiceConnect firmware loaded to the comm module in 

the meter. 

ERT ID Displays the 8- or 10-digit unique identifier for the ERT (encoder/receiver/transmitter) module. The 

ERT ID is permanently assigned to the meter at the time of manufacture and allows the meter to be 

read by ChoiceConnect Mobile meter reading software. 

ChoiceConnect 

Energy Selection 

The energy selection is chosen when the meter order is submitted to Itron and is permanently set in the 

meter at the time of manufacture. If a change is required, contact Itron Customer Support to have a 

custom configuration file created. 

Security State The security state is selected when the meter order is submitted to Itron and is permanently set in the 

meter at the time of manufacture. 
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Last Season Register Values 

This window displays select Time of Use information, including the last season end date and all register 

values recorded at the end of the previous season. 

 

This window is accessible when the meter you are logged into meets the following requirements. 

 CENTRON Bridge in ChoiceConnect mode 

 ChoiceConnect Comm Module firmware version 0.030.xxx  
 

Time of Use functionality in CENTRON Bridge Meters 

Traditional OpenWay meters rely on regular updates from the OpenWay Collection Engine to maintain TOU 

data. CENTRON Bridge meters in ChoiceConnect mode have no connection with the Collection Engine, so a 

different design manages TOU. 

CENTRON Bridge meters are manufactured with an entire TOU schedule resident in the meter. They use the 

same pending table mechanism used by traditional OpenWay meters to change seasons, however the meter’s 

register firmware takes responsibility for loading the next TOU season into the TOU pending table based on 

the configured 25 year TOU schedule. While the schedule is initially loaded in the meter at the factory, Field-

Pro also supports configuring the schedule through full meter initialization and reconfiguring just the TOU 

schedule.  
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Switch Comm Mode to OpenWay 

This window is accessible when the meter you are logged into meets the following requirements. 

 CENTRON Bridge meter in ChoiceConnect mode 

 ChoiceConnect Comm Module firmware version 0.030.xxx 

 Security keys supported by ISM. For more information see Special Note on page 100. 

To take the meter out of ChoiceConnect mode and move it into the OpenWay network, select the F1 key. The 

window may display a "Success" message; however this indicates that the register has received the request 

and the process has begun. A complete transition to OpenWay mode may take a minute or more to complete. 

When you log back onto the meter after running the process, check the Meter Summary window. If the 

transition to OpenWay mode was successful, the word "Active" appears in the Comm Module Firmware 

Version field and the Comm Module MAC Address field displays the meter's MAC address. If it says 

"Unavailable - ChoiceConnect Mode" the transition was not successful. 
 

 

Switch Comm Mode to ChoiceConnect 

This window allows you to switch the communication mode of a CENTRON Bridge meter from OpenWay 

(RFLAN) to ChoiceConnect without reconfiguring the meter. Press the F1 key to take the meter out of 

OpenWay mode and return it to ChoiceConnect mode. 
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This window is accessible when the meter you are logged into meets the following requirements. 

 CENTRON Bridge in OpenWay mode 

 OpenWay Comm Module firmware version 0.13.xxx (RFLAN communication) 

 ChoiceConnect Comm Module firmware version 0.030.xxx  

 Security keys supported by ISM. For more information see Special Note on page 100. 
 

If the meter's configuration does not support ChoiceConnect firmware, the window displays the following 

error message: "Meter does not have a ChoiceConnect compatible configuration and cannot be switched to 

ChoiceConnect mode." 
 

 

Switch to ChoiceConnect Mode with Programming 

This window is accessible when the meter you are logged into meets the following requirements. 

 CENTRON Bridge in OpenWay mode 

 OpenWay register firmware v3.032.xxx 

 OpenWay Comm Module firmware version 0.13.xxx (RFLAN communication) 

 ChoiceConnect Comm Module firmware version 0.021.xxx  

 Security keys supported by Certicom. For more information see Special Note on page 100. 
 

To remove the meter from the OpenWay Network and return it to ChoiceConnect mode, click the F1 key. The 

window may display a "Success" message; however this indicates that the register has received the request 

and the process has begun. A complete transition to ChoiceConnect mode may take a minute or more to 

complete. 

When you log back onto the meter after running the process, check the Meter Summary window. If the 

Comm Module MAC Address field says "Unavailable - ChoiceConnect Mode" the transition was successful. 

If it displays the meter's MAC address, the transition to ChoiceConnect mode was not successful. 
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OpenWay Shop Manager is a tool for viewing Meter Programs, Data Files, and the Activity Log. OpenWay 

Shop Manager supports the following features: 

 Importing and Viewing Meter Programs 

 Viewing and Managing OpenWay Data Files 

 Importing and Selecting Firmware Files 

 Viewing shop and field activities 

 Managing System Settings 

 

The upper left of the window displays the options available for the currently selected data type. Some of the 

options are visible when an item is selected on the right side.  

The upper right of the window contains buttons for Export, Print, and Help. The buttons relate to the window 

that is visible on the right side of the Shop Manager. The Export button displays a dialog to browse for the 

location to save the data as a Microsoft Office® Excel® Workbook. The Print button prints the contents of 

data in the grid control of the Shop Manager. The Help button displays the help topic that matches the current 

window's data. 

A progress bar is displayed on the bottom left of the status bar for any actions that require time to be 

performed. 
 

Starting the Shop Manager 

To start the Shop Manager application: 

1. Go to Start > Programs > OpenWay Tools > Shop Manager. 

2. Shop Manager opens to the default window. 

For more information, see: 

 Using the Itron Button on page 106 

 Customizing the Shop Manager on page 106 

 Navigating the Shop Manager on page 107 
 

C H A P T E R  3  

Shop Manager 



Shop Manager 

 
 

OpenWay Tools User Guide 106 

 Proprietary and Confidential 
 
 
 

Using the Itron Button 

The Itron button allows a user to perform basic operations. The Online Support includes a link to the Itron 

User Forum (Knowledge Exchange) as well as Technical Support and the Itron Metering website. 

 
 

Customizing the Shop Manager 

To customize the Shop Manager, click the >> button in the lower left part of the window.  

 

The following menu displays: 

 

To add or remove buttons from the menu bar, click Add/Remove buttons. Click an object to select or de-

select it from the list. Objects marked with  are included in the menu. 
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To move an item either up or down the list on the left, click Navigational Panel Options. Highlight the 

object to be moved and click either Move Up or Move Down. To return the menu back to its original state, 

click Reset. Once complete, click OK. To return to the main window without making any changes, click 

Cancel. You can also remove an item from the list by un-checking the check box next to the item. 

 
 

Navigating the Shop Manager 

Navigation in the Shop Manager is mouse-driven. Hyperlinks allow you to automatically open existing 

programs, schedules, or displays. 

The following buttons are available on all windows: 

Icon Description 

 

Field-Pro. Launches Field-Pro to communicate with meters. 

 

ZigBee Manager. Launches the ZigBee Device Manager. 

 

Export. Click this icon to export the current data. 

 

Print. Click this icon to print the current window.. 

 

Online Help. Click this icon to open the online help. 

 

Itron Metering Website. Click this icon to automatically go to the Itron Metering website. 

Some windows allow you to resize columns in case a description or value is too long to fit into the default 

column width provided. To expand a column, use the mouse to drag the column width to the desired width. 

The "+" and "-" buttons allow you to expand or contract individual sections. 
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Meter Programs 

A meter program file controls the operation of the meter and the meter's display. You can configure any 

number of meters using the same program file. 

OpenWay CENTRON meter programs are created using the OpenWay Collection Engine. Meter programs are 

exported from the Collection Engine, viewed in Shop Manager, then activated for use in OpenWay Field-Pro. 

Shop Manager does not provide support for editing meter programs. The program files reside in a fixed 

directory that is displayed at the top of the Meter Programs window; you cannot edit this path. 

Programs marked as Active are available for selection in OpenWay Field-Pro for configuring meters. The file 

names are hyperlinks that open the program in Data File Viewer when clicked. The version of the Collection 

Engine that was used to create the meter program is displayed in the CE Version column.  

 

The check box to the left of the program name allows you to perform specific operations to the selected item. 

Depending on the number of items checked, different operations are available. For more information, see the 

following topics: 

 Opening Existing Programs on page 109 

 Comparing Programs on page 110 

 Importing Programs on page 113 

 Deleting Programs on page 110 

 Validating Data File Configurations on page 112 
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Opening an Existing Program 

To open an existing program, click on the name of the program using the hyperlink. You can also open a 

program by selecting it and then using the Open option on the menu on the left side of the window. 

Once a program is selected, the OpenWay Data File Viewer is launched with the selected program open. 

The list of meter programs in the Shop Manager is refreshed when focus is returned after opening/editing a 

program. 

 

OpenWay programs are created in the OpenWay Collection Engine. 

 

 

Exporting a Program from the Collection Engine 

To export a program from the OpenWay Collection Engine, go to Meter Management > Configuration 

Management. From there, locate your program on the Configurations tab. You can sort any of the columns 

by clicking on the column heading.  

Once you locate the program, click the Export icon located on the far right. When asked if you would like to 

Open or to Save the file, click Save and provide the Save location.  

 
 

Icon Description 

 
Edit. Allows you to edit the configuration. 

 

Copy. Copies the selected configuration. 

 

Export. Exports the selected configuration; allows you to save it as an XML file. 
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Comparing Programs 

Program comparison allows you to compare the configuration details of up to four meter programs. This 

allows you to: 

 Manage existing programs 

 Reduce duplicates 

 Check existing files for accuracy and consistency 

To Compare Programs 

1. Open the Shop Manager application (Start > Programs > OpenWay Tools > Shop Manager). If 

prompted, enter your User ID and Password. 

2. Go to the Meter Programs tab. 

3. Select up to four programs to compare.  

4. Under Program Options menu on the left side of the window, click Compare. 

5. The Meter Program Comparison dialog appears. 
 

 

Delete Program Dialog 

The Delete Program option is available if one or more meter programs are selected. When you click this 

option, you are prompted to confirm the deletion of the meter programs. After the confirmation, the meter 

programs are removed and the list is updated. 

 

For OpenWay systems, you are only deleting the program from Shop Manager view. 

You cannot delete a program (configuration) from the OpenWay Collection Engine. 

Based on the selections on the previous window, this dialog shows the programs(s) that were chosen for 

deletion. 

 

To return to the previous window without deleting a program, click Cancel. To delete the selected programs, 

click OK. 
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Meter Program Comparison 

The Meter Program Comparison dialog shows the differences between two, three, or four programs. Meter 

functionality is listed in the first column and the selected meter programs are listed in the rest of the columns. 

Differences in the programs are noted with red italicized text. This allows you to: 

 Manage existing programs 

 Reduce duplicates 

 Check existing files for accuracy and consistency 
 

To Compare Programs 

1. Open the Shop Manager application (Start > Programs > OpenWay Tools > Shop Manager). If 

prompted, enter your User ID and Password. 

2. Go to the Meter Programs panel. 

3. Select the check boxes of  two, three, or four programs to be compared. 

4. Under the Program Options menu, click Compare. 

The Meter Program Comparison dialog appears. 

5. You may check the Display Differences Only box to display only the rows that have differences. 

6. To return to the main window, click OK. To print the results, click Print. To export the results, click 

Export. 
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Validate Data File Configuration 

This feature allows you to compare a meter program with up to four OpenWay data files. The Validate Data 

File option is available when you select one program only in the Meter Programs view of Shop Manager. 

To Validate Data Files 

1. Open the Shop Manager application (Start > Programs > OpenWay Tools > Shop Manager). If 

prompted, enter your User ID and Password. 

2. Go to the Meter Programs tab. 

3. Select one program against which to validate data files.  

4. Under Program Options menu on the left side of the window, click Validate Data File. 

The Data File Selection dialog appears. The Data File Directory field displays the fixed location where 

you must put the data files. The lower block displays all OpenWay data files that match the device class of 

the selected meter program. If the Data File Directory location does not contain any data files with 

matching a device class, and error message displays. 

 

5. Select up to four data files to validate and click OK. 

The Validate Data File Configuration window appears. The left column displays the meter functionality 

that is being validated. The second column (and any subsequent column) shows the configuration values 

for the program file(s). Configuration data differences are highlighted with red italicized text. 
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6. You may check the Display Differences Only box to display only the rows that have differences. 

7. To return to the main window, click OK. To print the results, click Print. To export the results, click 

Export. 
 

Import Programs 

The Import Program option is used to import meter programs into the programs database. For example, a 

metering expert can create program files and TOU schedules which are exported for use in the meter shop 

where meters are programmed. The meter shop technician can then import the program file into OpenWay 

Tools. 

A program does not need to be selected for this option to be available. When Import is selected, the Import 

Programs dialog is displayed. You can sort on any of these columns by clicking on the column header. The 

Source Directory is where import files are located. You can browse to the files, select the files, and click OK 

to import them. The import status is displayed on the bottom of the window. Results of the import are given 

after the import is completed. The Shop Manager is refreshed to show the new programs. 

When you import a program file, the following information is imported as part of the program file: 

 System default values 

 Programming options 

 TOU schedules 

To Import a Program 

1. Open the Shop Manager application. If prompted, enter your User ID and Password. 

2. Go to the Meter Programs panel. 

3. Under Program Options menu on the left side of the window, click Import. 

The Import Programs dialog opens. 

4. Click the Browse... button and navigate to locate the import files. Click OK. 

5. Check the programs to be imported (or use the Select All feature). To clear all selections, click Clear All. 

To return to the main window without making any changes, click Cancel. To import the selected 

programs, click OK. 
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6. If you attempt to import a program file that has the same name as a program file that already exists on 

your system, you are prompted to overwrite the existing program or cancel the import. 

 

7. Click OK to begin the Import. A progress bar displays. 

8. When the process is complete, a Program Import Status box appears. 
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OpenWay Data Files 

An OpenWay data file is an .xml file of a meter's configuration and register data (along with other optional 

data). Field-Pro users create Data files while they are logged onto meters.  

The OpenWay Data Files window displays all data files in the selected directory and allows you to view and 

modify these files. This directory is remembered from one session to another and is independent of the 

Program directories.  

 

The Data File Directory field shows the location where Shop Manager is currently looking for the OpenWay 

Data Files. You can modify the location by clicking Change Directory on the left side of the window. For 

more information, see Change Data Directory. 

 

Files are created in the Data Upload Directory as noted in the Current Directory on the 

Change Data Directory Dialog. 

The file name, Unit ID, and Date Created are displayed for the OpenWay data files. The file names are 

hyperlinks that open the data file in the Viewer when clicked. 
 

Opening OpenWay Data Files 

To open an OpenWay data file, do one of the following: 

 Click the check box next to the file in question and then click Open on the left side of the window. 

 Click on the hyperlink file name of the OpenWay data file. 

This opens the data file in the OpenWay Data File Viewer. 
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OpenWay Data File Viewer 

The OpenWay Data File Viewer is used to view OpenWay data files (EDL files) and OpenWay configuration 

files. 

 

The tabs that are visible in the Data File Viewer depend on the contents of the EDL file. 

For example, the Voltage Monitoring tab is only present if there is Voltage Monitoring 

data in the data file. 
 

Icon Description 

 

Export. Click this icon to export the current data. 

 

Print. Click this icon to print the current window. 

 

Online Help. Click this icon to open the online help. 

 

Itron Metering Website. Click this icon to automatically go to the Itron Metering website. 

For more information, see the following topics: 

 Device Status on page 117 

 Configuration Data on page 119 

 Register Data on page 119 

 Load Profile Data on page 120 

 Event Data on page 129 

 HAN Event Logs on page 132 

 Network Status on page 137 

 Voltage Monitoring on page 125 

 Communications Log on page 131 

 SiteScan Toolbox Data on page 141 
 

Move Files 

The Move option is only available when one or more files are selected. When the Move option is selected, a 

browse dialog is displayed for you to choose the location. After confirmation, the file is moved to the 

specified location and the list is updated. If more than one file is selected, then all files are moved to the 

specified location. 

Use this dialog to move a file from one location to another location. Use the Browse... button to change the 

Destination Directory. To return to the main menu without making any changes, click Cancel. To move the 

files, click OK. 
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Confirm Deletions 

The Delete option is available if at least one file is selected.  

Based on the selections on the previous window, this dialog shows the data file(s) that were chosen for 

deletion. The Delete option prompts you to confirm the deletion of the file. After confirmation, the files are 

removed and the list is updated.  

Click Cancel to return to the main window without making any changes. Click OK to delete the selected files. 
 

Change Data Directory 

The Current Directory is the present location used by Shop Manager to locate external files. Click Browse... 

to change this location. 

The Data Upload Directory can only be changed when "Upload new data files to current directory" is not 

checked. To avoid confusion, it is recommended that these two locations remain the same. 

 
 

Device Status 

This window displays information about the meter at the time the data file was created. 
 

Field Description 

Meter ID This field is set aside for customers who want to identify a set of meters with an ID number. This ID 

can be set in the meter at the time of manufacture (by arrangement when purchased) or you can set it 

manually using the Initialize Meter window of Field-Pro. 

Serial Number This field is set aside for customers who want to identify each individual meter with their own ID 

numbers. This ID can be set in the meter at the time of manufacture (by arrangement when purchased) 

or you can set it manually using the Initialize Meter window of Field-Pro. 

Manufacturer's Serial 

Number 

An ID that uniquely identifies this meter. It is created by Itron and set permanently in the meter at the 

time of manufacture. 

Date Last 

Programmed 

The date and local time that the meter was most recently loaded with a new meter program. 

Number of Demand 

Resets 

Demand resets can be configured to occur on a timed basis or when triggered by another event. An 

unexpectedly high number in this field could indicate meter tampering. 

Software Version The version of OpenWay Tools or Collection Engine software used to program the meter. 

Firmware Version The revision number of the register firmware currently in the meter. 

Hardware Version The revision number of the meter hardware. 
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Field Description 

Device Time The date and time on the meter when the OpenWay data file (EDL file) was created. 

Time Zone The time zone in which the meter was programmed, stated as hours plus or minus GMT (Greenwich 

Mean Time). 

DST Enabled Indicates whether the meter is programmed to adjust for daylight saving time. 

Meter in DST If DST is enabled in the meter, indicates whether daylight saving time was in effect when the data file 

was created. 

If DST is disabled, this field does not display. 

Meter in Test Mode Indicates whether the meter was in test mode when the data file was created. 

Device Errors If the meter was experiencing any fatal or non-fatal errors when the data file was created, they are 

displayed here. If not, field displays "None Found." 

Connect / Disconnect 

Status 

The following three fields indicate the connection status of the meter at the time the data file was 

created. 

Current Switch State Connected. The disconnect switch was closed when the data file was created. 

Disconnected. The disconnect switch was open when the data file was created. 

Load Voltage Present True. There was voltage on the load side of the meter when the data file was created. If the Current 

Switch State = Disconnected, this could indicate a problem. 

Last Connection 

Attempt Failed 

True. There was an attempt to connect or disconnect that failed. 

False. the previous connect / disconnect attempt was successful. 

Communication 

Modules 

The following fields display information about the communications modules in the meter. 

Comm Module 

(LAN) Version 

The version of the communication module's Local Area Network. 

Comm Module MAC 

Address 

The Media Access Control address of the communication module. 

HAN MAC Address The Media Access Control address of the Home Area Network. 
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Configuration Data 

In the Configuration Data area, the Configuration tab contains summary information for each of the 

configurable parameters in the meter.  

The TOU Schedule tab shows a graphical representation of the TOU Schedule (if used). 

 
 

Register Data 

Register Data contains a listing of measurement readings from the meter. The tabs that appear in Register 

Data are determined by the energies that the meter supports, along with the energies selected in the meter 

program. 

The Extended Self Read Registers tab displays instantaneous Watts, instantaneous VARs and instantaneous 

Volts when the meter supports and is configured to record the values on a self-read. For polyphase meters, 

instantaneous values per phase and all configured secondary energy values are shown. 

Since the number of extended self reads can differ from the number of traditional self reads, the extended self 

read data is reported separately. It is important to note that the self reads on each window are numbered 

independently. Self Read 1 on the Self Read Data window may not match the same time stamp as Extended 

Self Read 1 on the Extended Self Read Data window. 
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Load Profile Data 

Load Profile (mass memory) data is stored in blocks (records) of 128 intervals. The profile interval length is 

the same for all channels and is independent of the interval length for demand quantities. Each interval of load 

profile data is identified by date and time. Each interval contains status bits indicating the occurrence of 

outages, daylight saving time, and other significant events or errors. 

 

The Load Profile functionality is designed for use in billing and load research applications where multi-

channel high resolution data is needed. 

Load Profile Data contains two tabs: 

 Profile Summary 

 Interval Data 

Each of the tabs contains summary information about the load profile data using the following statuses: 

Status Definition Cause 

A Time Adjustment The meter time was adjusted during the specified interval. When A appears, you also 

see a status of K, L, or S, indicating whether the time adjustment caused an interval to 

be skipped or to be longer or shorter than normal. 

D In DST The interval occurred during Daylight Saving Time. 

K Skipped Interval The interval was skipped and no data was recorded. Intervals can be skipped due to 

either a power outage or a time adjustment during that interval. 

L Long Interval A time adjustment occurred during the interval causing it to be longer than the normal 

interval length. 

O Outage An outage occurred during the specified interval. The minimum outage length is 

recorded in seconds and is specified in the Collection Engine in the load profile 

section. 
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Status Definition Cause 

R Power Restoration Power was restored after a power outage during this interval. 

S Short Interval The interval was shorter than normal either because of an outage or a time adjustment. 

T Test Mode The meter was placed into test mode during the specified interval. 

V Overflow The value recorded in this interval was outside of the range that the meter is capable of 

storing. This could happen because there was a large amount of data stored or there 

was a time adjustment backwards. If this occurs frequently for load profile data, try 

using a smaller pulse weight. 

 
 

Capacity 

The load profile option is available in 144 Kbytes of memory. There are up to four channels available for 

interval load profile data. 
 

Bit Resolution 

The load profile operates with 16-bit data resolution. Equivalent pulse count resolution is as follows: 

Bits Pulse Counts 

16 65,535 

151 32,767 

1  When a Net quantity (such as Net Wh) is chosen as a load profile channel, all load profile channels will 

have 15-bit data resolution. 
 

Interval Lengths 

The load profile records data on a block interval basis. The interval length is programmable for 5, 10, 15, 30, 

or 60 minutes. The interval length is the same for all channels and is independent of the interval length for 

demand quantities. 
 

Power Outage 

The OpenWay Register flags an interval when a power outage exceeds a specified number of seconds. The 

range for power outage length is programmable from 0 to 255 seconds and must not exceed the programmed 

interval length. 

 During power outages the OpenWay CENTRON meter maintains all meter data as well as timekeeping 

functions (powered by the internal battery). 

 During an outage, billing data is stored in non-volatile memory. 

 When power is restored, data is returned to active memory and normal metering resumes. 

 The meter records the date and time of the power outage and the power restoration. 
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Channel Configuration 

The OpenWay Register can be programmed to have up to four channels of interval load profile data. Each 

channel corresponds to an energy register selected during the programming process. In order to profile a 

specific energy, the energy must first be selected as a quantity to be measured. 

Selection of channel configuration and pulse constants is accomplished through the programming software. 

Each data channel is programmed to record load profile data from a user-selected register. The energy 

registers allowed for load profile are listed in Energy Data. 
 

Data Storage 

The OpenWay Register uses non-volatile flash memory to record load profile data. Data is stored in load 

profile memory at the end of each interval. Each channel has 16 bits written to load profile memory. At the 

end of an interval, a 16-bit number is written into load profile memory for channel 1; a 16-bit number for 

channel 2 follows immediately. 

The process continues for each interval until 128 intervals (one block or record) have been recorded. In 

addition to the profile data, each interval contains eight types of status bits written into each data interval. The 

following are the status codes used when viewing data on OpenWay Field-Pro: 

Status Definition Cause 

A Time Adjustment The meter time was adjusted during the specified interval. When A appears, you also 

see a status of K, L, or S, indicating whether the time adjustment caused an interval to 

be skipped or to be longer or shorter than normal. 

D In DST The interval occurred during Daylight Saving Time. 

K Skipped Interval The interval was skipped and no data was recorded. Intervals can be skipped due to 

either a power outage or a time adjustment during that interval. 

L Long Interval A time adjustment occurred during the interval causing it to be longer than the normal 

interval length. 

O Outage An outage occurred during the specified interval. The minimum outage length is 

recorded in seconds and is specified in the Collection Engine in the load profile 

section. 

R Power Restoration Power was restored after a power outage during this interval. 

S Short Interval The interval was shorter than normal either because of an outage or a time adjustment. 

T Test Mode The meter was placed into test mode during the specified interval. 

V Overflow The value recorded in this interval was outside of the range that the meter is capable of 

storing. This could happen because there was a large amount of data stored or there 

was a time adjustment backwards. If this occurs frequently for load profile data, try 

using a smaller pulse weight. 

In addition to the interval profile data and the interval status data, each block contains a time tag specifying 

the month, day, hour, and second of the end of the data block. 
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Pulse Constants 

The Collection Engine allows the entry of a Pulse Weight (PW) between 0.01 to 50 in increments of 0.01 and 

limiting the decimal places to two.  

The load profile pulse constants apply to secondary readings only. 

Example: Calculation of pulse weight from Wh 

A meter, 1-element, 240 Volts, CL200 is programmed to record Wh in load profile with 15 minute intervals. 

First, calculate the maximum watt-hour accumulation during 15 minute intervals: 

)25.0()1()200()240(max hoursXphaseXAXVWh   

 

watthoursWh 000,12max   

 

The maximum number of pulses supported by the OpenWay CENTRON meter is 65,535; therefore, the 

smallest pulse weight (PW) that can be used is: 

pulseWh
pulses

Wh
PW /1831.0

535,65

000,12
min 

 

  

Since the pulse weight value must be a multiple of 0.01and is limited to two decimals places,  0.18 Wh/pulse 

could be programmed as the pulse weight (Ke) for the Wh channel in load profile in this example. However, 

Itron recommends using the immediate upper value multiple of 0.01. 

For this case, this value is 0.19. 
 

Recording Duration 

The following equation can be used to determine the recording duration of the load profile: 

Recording Duration (days) = (M x I x 1024) / (1,440 x [(2 x C + 2) + ((6 x C + 4) / 128)]) 

M = Memory size in kilobytes 

C = Number of channels 

I = Interval Length in minutes 

The table below shows the recording duration (in days) for 145 kilobytes (KB) load profile memory size. 

 Interval Length (Minutes) 
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Number of 
Channels 

5 10 15 30 60 

1 126 253 379 759 1519 

2 84 168 252 505 1011 

3 63 126 189 379 758 

4 50 101 151 303 606 
 

 

Instrumentation Profile 

This window displays the instrumentation profile of the meter as instantaneous values. The meter program 

created in the Collection Engine determines what this window displays. 

This feature is available for HW 3.0 and 3.1 meters only. 

 Quantities. The meter program contains up to three energies selected from Watts, VAs, Vars, and Volts. 

(Selection list varies by meter device type and country of deployment.) 

 Interval Length. The meter program specifies the number of minutes apart the instantaneous values are to 

be recorded. This can be different from the meter's interval length. The interval values are displayed in 

separate rows on the Instrumentation Profile Intervals tab. 

 Outage Length. The meter program specifies the number of seconds an outage must last before it is 

recorded in the instrumentation profile. 

 Read Time Offset. The meter program specifies the number of minutes after the beginning of the 

instrumentation profile interval that the instantaneous value is recorded. If the meter cannot read the value 

at the specified time due to power outage or time adjustment then the value displayed is 0. 

The number of channels depends on the number of phases the meter supports (a channel for each phase). 
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The Instrumentation Profile Intervals tab displays the instantaneous value recorded for each energy during 

each interval. The Interval Status column displays any of the following codes: 

Status Definition Cause 

A Time Adjustment The meter time was adjusted during the specified interval. When A appears, you also 

see a status of K, L, or S, indicating whether the time adjustment caused an interval to 

be skipped or to be longer or shorter than normal. 

D In DST The interval occurred during Daylight Saving Time. 

K Skipped Interval The interval was skipped and no data was recorded. Intervals can be skipped due to 

either a power outage or a time adjustment during that interval. 

L Long Interval A time adjustment occurred during the interval causing it to be longer than the normal 

interval length. 

O Outage An outage occurred during the specified interval. The minimum outage length is 

recorded in seconds and is specified in the Collection Engine in the load profile 

section. 

R Power Restoration Power was restored after a power outage during this interval. 

S Short Interval The interval was shorter than normal either because of an outage or a time adjustment. 

T Test Mode The meter was placed into test mode during the specified interval. 

V Overflow The value recorded in this interval was outside of the range that the meter is capable of 

storing. This could happen because there was a large amount of data stored or there 

was a time adjustment backwards. If this occurs frequently for load profile data, try 

using a smaller pulse weight. 

 
 

Voltage Monitoring 

The Voltage Monitoring Data window displays the meter's voltage levels during voltage monitoring intervals 

(which can be different in length from meter intervals). The meter's configuration program determines 

whether voltage monitoring data is recorded. 
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Summary tab 

Number of Intervals. The number of voltage monitoring intervals in the data file. The maximum amount of 

data varies from approximately two months to two years based on meter type and the number of phases being 

monitored. Once this maximum is reached, the oldest data is deleted as new data is added. 

Time of First Interval. The time of the first interval when the meter was configured, or if the maximum 

amount of data has been reached it is the time of the oldest voltage monitoring interval in the file. 

Time of Last Interval. The time of the last interval when the data file was created. 

Threshold fields. These display the values that were selected when the meter program was created. All 

meters with the same meter program display the same values here. 

Interval Data tab 

Vh Phase A, B, C. The average voltage level divided by the number of intervals per hour. 

V Phase A, B, C. The average of the min and max voltage levels for the interval. 

V min Phase A, B, C. The minimum voltage level that occurred during the interval. 

V max Phase A, B, C. The maximum voltage level that occurred during the interval. 

Interval Status. Codes represent any special circumstances about the interval. Refer to the table below. 

Vrms High Threshold. If there is a swell in RMS voltage beyond the threshold defined on the Summary tab, 

A, B, and/or C appear in this column to indicate which phase(s) experienced the swell. 

Vrms Low Threshold. If there is a sag in RMS voltage beyond the threshold defined on the Summary tab, A, 

B, and/or C appear in this column to indicate which phase(s) experienced the sag.  

Thresholds can be set up in the meter program to indicate when events should be logged for sags and swells.  

Graph tab 

Shows the voltage so that you can look at the data over time for sags or swells in the data. For more 

information, see Voltage Quality Sags and Voltage Quality Swells. 

Interval Status Codes 

Status Definition Cause 

B Time Adjusted Backward The meter's time was adjusted backward during the specified interval. 

D In DST The interval occurred during daylight saving time.  

F Time Adjusted Forward The meter's time was adjusted forward during the specified interval. 

I Invalid Service Type The current service type is not valid (the meter may be wired improperly). 

L Long A time adjustment caused the interval to be longer than the specified interval length. 

O Outage An outage occurred during the specified interval. The minimum outage length that can 

cause this status code to be recorded is specified in the Collection Engine in the load 

profile section. 
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Status Definition Cause 

P Partial A time adjustment caused the interval to be shorter than the specified interval length. 

S Skipped The interval was skipped either due to a outage or a time adjustment during the 

specified interval. No data was accumulated during this interval. 

T Test Mode The meter was in test mode at some time during the specified interval. 
 

 

Voltage Quality Sags 

A voltage sag is a momentary (less than a few seconds) decrease in the voltage below a given tolerance on one 

or more phases. Voltage sags affect power-down sensing circuitry on computer and large controllers and can 

cause equipment to shutdown. 

Sag Threshold Start 

For this example nominal voltage is set to 120V and the sag threshold is 90% of nominal. A sag is triggered 

when the voltage drops below 108V (120 volts X 90% = 108 volts). 

 

Sag Event 

For this example, consider a threshold start voltage of 70% and a Threshold Stop level of 75% with a nominal 

voltage of 120V. A sag event starts when the voltage drops below 108V (70 % of nominal) and ends when the 

voltage rises above 114V (75% of nominal). 
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Voltage Quality Swells 

A voltage swell is a momentary (less than a few seconds) increase in the voltage above a given tolerance on 

one or more phases. Voltage swells are often caused by large cyclic loads such as spot welders, induction or 

arc furnaces, and motors when cycled.  

Swell Threshold Start 

For example nominal voltage is set to 120V and the swell threshold is 110% of nominal. A swell is triggered 

when the voltage rises above 132V (120 volts X 110% = 132 volts). 

 

Swell Event 

For this example, consider a threshold voltage of 90% and a Threshold Stop voltage of 5% with a nominal 

voltage of 120V. For swells, a threshold voltage of 90% and a Threshold Stop voltage of 5% with a nominal 

voltage of 120V means that a swell event begins when voltage exceeds 132V and ends when the voltage drops 

below 126V. 

 
 

HAN Data 

Current Block Price Data tab 

This tab summarizes the RIB data that is sent to a HAN device. This feature is enabled whenever the meter is 

configured to use block pricing even if no HAN devices are actively registered with the meter. 

Active Block Price Schedule tab 

This tab shows the customer's current consumption and where that puts the customer within the RIB schedule. 

It also shows the start time and duration of the billing period and block period, along with the prices and 

thresholds of all the blocks defined for the current block period. 
 

12 Max Demands 

Each time a demand reset is performed, the register firmware stores the Max Demand along with the date and 

time when the peak occurred. Twelve records are stored, displaying a year of monthly max demands. 
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Event Data 

The Events Data view contains two tabs: Event List and Event Summary. 

Event List tab 

The meter configuration determines which incidents should cause the meter to log events. This window 

displays all events logged on the meter since the last time it was configured. 

Field Description 

Time The date and time that the event occurred. 

Event The name of the event. 

User ID If a user was logged into the meter when the event occurred, their User ID is recorded. If no one was 

logged in, 0 displays. 

Data Some events have associated details that are known about the event. 

Event Summary tab 

This window lists all events that can occur in the meter from which the data file was created. The Action 

column indicates how many times the event has occurred. "Logging Disabled" indicates that the meter is 

configured to ignore that event. 

Field Description 

ANSI Security Failed An incorrect security code was provided during logon. 

Current Threshold 

Exceeded 
Definition 

This event is logged when the Instantaneous Phase Current (IPC) exceeds the 

maximum current load or threshold percentage for the meter at any moment. 

Another event is logged when the IPC returns to within tolerance. 

Configurable Items 

Utilities can use the following parameters to control the number of events that the 

meter logs. 

 Threshold. Valid values = 1-125. The percent of the meter's maximum load 

that, when exceeded, causes an event to be logged.  

 Hysteresis. Valid values = 0-125 (equal to or less than Threshold value). The 

percent of tolerance below the threshold within which the IPC can move 

without causing the event to be logged again as "returned to within tolerance." 

 Debounce. Valid values = 0-255. The number of seconds the IPC must 

exceed the threshold in order for the event to be logged.  

 Minimum Active Duration. Valid values = 0-65535. The lockout period (in 

seconds) from the time a "returned to within tolerance" event is logged 

(Threshold minus Hysteresis) until the next "exceeded tolerance" event can be 

logged. Each phase has a separate timer. 
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Field Description 

Deregister The process of removing an endpoint's registration information from other cell members. For example, 

if an endpoint changes cells, it sends a message to all of its known cell members to remove it from their 

member lists. 

Demand Reset A meter event triggered when a demand reset occurs.  Demand resets can be configured to occur on a 

timed basis or when triggered by another event.  Checking the event log is a good procedure when 

troubleshooting meter symptoms. 

Event Tamper 

Cleared 

This event is logged when a tamper count is reset to zero. For more information, see the Reset 

Tampers window on page 60. 

Inversion Tamper The meter was turned 180 degrees upside down and power flowed backward. 

Load Profile Error A meter event indicating that a Load Profile error has occurred. 

Load Voltage Present Before the service switch is closed and service is reconnected, the meter checks for load-side voltage 

(consumer has engaged a separate source of energy such as a generator). When load side voltage is 

present, the service switch does not close and this event is logged. 

Loss of Phase 

Restored 

Phase voltage was restored. 

Loss of Phase Error Non-Fatal Error 2: The voltage on each phase is checked every five seconds. A phase must fail twice 

in a row to cause an error. A Demand Reset or a Clear STD or MFG Status Flags after the voltage 

returns clears this error. 

Low Battery A meter event triggered when the battery voltage drops below a predetermined value. 

Magnetic Tamper 

Cleared 

The meter has detected that a high DC offset value has returned to normal. This event is logged one 

second after the value returns to normal. Only HW 3.1 singlephase meters display this event. 

Magnetic Tamper 

Detected 

The meter has detected a high DC offset value, which is caused by a magnet in the vicinity of the 

meter. This event is logged one minute after the high DC offset value is detected. Only HW 3.1 

singlephase meters display this event. 

Meter Firmware 

Download Failed 

The downloading of the meter firmware failed. This applies to all types of firmware, as well as 

downloading RF mesh configurations. 

Meter Firmware 

Download Succeeded 

The downloading of the meter firmware succeeded. This applies to all types of firmware, as well as 

downloading RF mesh configurations. 

Pending Reconfigure A meter event logged when any Pending Table (except Firmware) is activated. 

Primary Power Down A loss of power to an endpoint. 

Primary Power Up An indication that power is once again available at an endpoint.  This indication generally follows a 

power outage. 

Removal Tamper The meter has been removed from the socket. 

Table Written A given table has been written to (the number of the table is provided in the event message). 

Firmware Download Event List 

This window displays records for each set of firmware that has been loaded to the meter. The records are 

grouped by the date and time of each download.  

Note  Firmware downloads are logged as events regardless of the configuration file's event logging 

settings. 
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The log file that holds firmware download events is 48 records long, which should be adequate for the life of 

the meter under normal circumstances. If the 48 records are filled, unsealed meters drop the oldest record and 

add the new record to the log file. Sealed meters do not accept additional firmware downloads. 

Field Description 

Firmware Type Indicates the target processor for the firmware, such as RFLAN, RF Mesh, or register. 

Source Indicates whether the firmware was loaded to the meter through the optical port, ZigBee, or through 

the network. 

Hash All meters with the same firmware set have the same hash value in this field. 

CRC  The Cyclic Redundancy Check is an error-detecting code that ensures that the firmware file was not 

corrupted during download.  "0" indicates that the firmware download was for the comm module. An 

eight-digit number indicates that the firmware download was for the register.  

Previous Firmware 

Version 

The firmware version that was replaced with this download. 

Current Firmware 

Version 

The firmware version that was loaded with this download. 

User ID The identification of the individual or work group that performed the firmware download. 

 
 

Communications Logs 

Communications Log has three tabs: Communication Event Summary, LAN Event List and HAN Event List. 

Each of the tabs contains summary information for events within the meter. 

The number of events that can be displayed is limited; as new events are logged, the oldest ones are deleted. 
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HAN Event Logs 

HAN Events are communications between the utility company, the meter, and in-home HAN devices. These 

messages are for the purpose of controlling load to make sure that demand does not exceed what the utility 

company can generate. 

Examples of in-home HAN devices could be the thermostat, refrigerator, dryer, gas meter, and the in-home 

display that allows consumers to see and control energy usage. 

Use Field-Pro to see recent HAN events when you are logged into the meter, or create a data file and use Shop 

Manager's Data File Viewer. 
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Supported HAN Upstream Events 

Device Added. The meter logs this event when a new device is provisioned to the meter. This event only 

happen when a new device is added. 

Device Dropped. The meter logs this event when an existing device is dropped from the meter. 

Device EUG Changed. This event is logged when a UEG (Utility Enrollment Group) change for a device is 

requested by the Collection Engine, and that device has successfully confirmed that its UEG was changed 

accordingly. 

Device Joined. This event is logged when a device successfully conducts CBKE and is regularly 

communicating with the meter. 

DRLC Delivery Failed. This event is logged if the head-end is unable to deliver a DRLC event to a HAN 

device. The event includes the MAC address of the individual device that did not respond to the DRLC event. 

HAN Communication has Exceeded Defined Threshold. The meter expects to hear from each of the HAN 

devices at regular intervals. When this interval is exceeded, an event is logged. This event is logged after one 

day for powered devices and three days for sleepy devices. The event is only logged once until 

communications are reestablished. Once the meter hears from the device again it is allowed to log this event 

again the next time the conditions are met. 

Load Control Opt Out. Many enrollment programs give consumers flexibility to choose not to participate in 

a load control event. Each time the consumer opts out, an event is logged upstream to the meter so that the 

utility company can track the number of times it happens. This event is logged for each HAN device that opts 

out of a DRLC event. The meter could have up to one opt-out event for each HAN device that supports 

DRLC. 

Load Control Status. The meter logs one event each time a HAN Device indicates that a Load Control Status 

has been triggered on the device. Since this event covers several conditions there could be several of these per 

DRLC event per HAN device, depending how HAN events are configured at your utility. 

Message Confirmation. The meter logs one event each time it receives a confirmation message from a 

device. The meter could receive several confirmations for every message sent, since there could be multiple 

devices in the home that display and confirm messages. 

Message Delivery Failed. The meter logs this event if the head-end is unable to deliver a text message to a 

HAN device. The event includes the MAC address of the specific device that did not respond to the text 

message. 

Ping Event. The meter logs this event to indicate that a device was pinged. The argument data indicates the 

result of the ping operation. One event is logged per device pinged. 

Price Acknowledgment. The meter logs one event each time it receives a price acknowledgment from a HAN 

device. For every price that is published to the meter, several confirmations could be logged depending on 

how many devices are present that support price acknowledgment. 
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Price Delivery Failed. The meter logs this event if the head-end is unable to deliver a new price to a HAN 

device. The event includes the MAC address of the individual device that did not respond to the publishing of 

data by the head-end. 

State Changed. The meter logs this event when the state of a HAN device changes. These state changes 

usually occur during the joining process. Once the devices are successfully joined, this event rarely occurs. 

Submetering Bubble-up Data Missing. This event is logged when the meter notices that part of the interval 

data that the submetering device (gas module) sends at the bubble-up is missing. This event is logged only if 

the submetering device is using a collection configuration which includes interval data (daily or hourly). 

Supported HAN Downstream Events 

Diagnostic System Events. This is one event that has several associated sub-events that provide helpful 

information about the HAN system. 

 Channel Change. This event is logged whenever the network is restarted and the channel changes. The 

Argument Data reports both current and previous channels. 

 PAN ID Change. This event is logged whenever the network is restarted and the Personal Area Network 

(PAN) identifier changes. The Argument Data reports both current and previous PAN IDs. 

 ZigBee halted due to Reset Limiting. This event is logged if the Home Area Network (HAN) ever 

experiences eight resets in a four hour period. All HAN operations cease. For more information, see 

ZigBee Stack Reset Limiting. 

 Config Change. This event is logged whenever any of the HAN configuration values is updated. The 

Argument Data reports the updated value. 

 Gas module told to leave. This event is logged whenever a gas module is commanded to leave the 

network. The gas module is identified in the Argument Data by the last four bytes of its EUI64. 

 Management Leave Requested. This event is logged whenever the meter receives an inbound message 

from a device commanding it to leave the network. 

 Meter has been cold started. This event is logged whenever the meter is cold started. 

DRLC Data Published. The meter logs this event when the head-end system publishes a new DRLC event to 

the meter and the meter publishes the DRLC list out to the appropriate HAN Devices. This event is logged 

even if there are no HAN devices connected to indicate that the DRLC event was received. 

Existing DRLC Event Dropped. The meter logs this event to indicate that the DRLC queue was full when a 

new DRLC event was received and it was one of the existing DRLC events that was dropped. This means that 

the new event occurred before at least one of the already queued events. 

Message Published. The meter logs this event when it receives a new text message from the utility and 

publishes the message out to the appropriate HAN devices. This event is logged even if there are no HAN 

devices connected to indicate that the message was received. 

Meter Network Changed. The meter logs this event when something changes about the meter's HAN 

network. This would occur because of a decommission, the stopping of the stack (happens with Cert Updates) 

or if the network is restarted. 
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New DRLC Event Dropped. The meter logs this event to indicate that the DRLC queue was full when a new 

DRLC event was received and it was the new DRLC event that was not added to the queue. 

Price Tier Changed. The meter logs this event when it receives new pricing data from the head-end system. 

Pricing Data Published. The meter logs this event when the head-end system publishes a new price to the 

meter and the meter publishes the full price list out to the appropriate HAN Devices. This event is logged even 

if there are no HAN devices connected to indicate that the price was received. 

Security Profile Update Notification. The meter logs this event when it receives a command that would 

require the meter to change the security profile of a device. The meter is not permitted to make security profile 

changes without a decommission/re-commission event so the Collection Engine must be notified of the 

meter’s rejection of the command. 

 

HAN upstream events are communications from a home's HAN devices to the meter. 

Field Description 

Time The date and local time on the meter when the event occurred. 

Event The supported events. For more information, see HAN Event Log Summary. 

User ID Reserved for future use. 

HAN Event ID An ID number that uniquely identifies this event at this meter at this date and time. 

MAC Address Identifies the HAN device that sent the event to the meter, such as the thermostat, dryer, or pool pump. 

Argument Data Additional information about the event. 
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HAN downstream events are communications from the meter to HAN devices in the home. 
 

Field Description 

Time The date and local time on the meter when the event occurred. 

Event The supported events. For more information, see HAN Event Log Summary. 

User ID Reserved for future use. 

HAN Event ID An ID number that uniquely identifies this event at this meter on this date and time. 

Argument Data Additional information about the event. 
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Network Status 

Network Statistics are included in the meter's data file if the LAN and HAN Network Data check box is 

selected on the Field-Pro Create Data File window. 

 
 

Network Statistics (RF Mesh) 

Number of 

Registrations Sent 

Number of registration request packets sent by a device. When a device tries to join a network it has to 

send a registration request packet. This is either accepted and the device is connected to the network, or 

it is rejected and the device can try registering again. Reasons for rejection can be low signal strength, 

permissions / security clashes etc.  

Number of 

<acse_pdu> Sent 

An ACSE application data unit with the Calling ApTitle set to the ApTitle of registering node and the 

Called ApTitle set to the ApTitle of the registration authority (C12.22 master relay). This <acse_pdu> 

carries a list of ApTitles to be registered to the network. 

Number of 

Registrations Failed 

Number of registrations requests packets that were not successful / rejected. Usually a device has a 

preset threshold for registration fails. If this threshold is reached, the device attempts to join another 

network (if available) or generates an error and stops trying to join. This prevents a device from falling 

into an infinite loop when trying to join and always failing. 

Network Statistics (RFLAN) 

Number of Bytes 

Received 

The comm module has received this number of bytes of data from the RFLAN network. When the 

comm module is reset, this value clears and begins counting up again. 

Number of Bytes 

Sent 

The comm module has sent this number of bytes of data to the RFLAN network. When the comm 

module is reset, this value clears and begins counting up again. 

Comm Module 

Current Level 

The number of hops the meter is from the Cell Master. 
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Number of Comm 

Module Level 

Changes 

The meter keeps track of the number of times that the number of hops has changed. 

Core Dump State 0. No core dump is currently saved. 

5. A core dump has been saved.  

Network State Not Synch. The meter is looking for neighbor meters.  

Synch not ACK. The meter has synchronized but has not yet heard from neighbors. 

Synch. The meter is talking to neighbor meters. 

Synch Net. The meter is part of a cell; this is the desired state. 

Broadcast State A meter is in "Broadcast State" during the time window in which it is handling or repeating a multicast 

message. At all other times, this field displays "No Active Broadcast." 

Outage ID A unique identifier assigned to track an outage event. 

Is Synchronized Now Yes. Is currently synchronized. 

No. Is not currently synchronized. 

GPD Global Average Propagation Delay (GPD) values are used to sort and select neighbors. They are used 

to select the best access for synchronization or to make a choice between different available cells. The 

network layer uses these values to choose the best path for routing packets. 

Father A network node hierarchically above a child node that may be used for routing information to and 

from the child. A network end point which when compared to another end point of the same cell is at a 

level N+x, where x1.  Therefore, within a cell each node builds a list of other nodes that it can 

communicate with and contains routing information which allows it to determine the best routing up to 

the Collection Engine. Any node that is one level above the current node in the path back to the 

Collection Engine is that node's father. There can be several categories of fathers, such as potential 

synchronization fathers and healthy fathers. 

Comm Module 

Synch Father MAC 

Address 

The MAC address of the RFLAN device's synchronization father: the node it uses to pass data through 

the RFLAN. 

LPD Local Average Propagation Delay (LPD) values are used to sort and select neighbors. They are used to 

select the best access for synchronization or to make a choice between different available cells. The 

network layer uses these values to choose the best path for routing packets. 

RXI The Reception Rate Indicator provides an indication of the rate at which messages are heard from a 

neighbor, although it is not an exact measurement of the actual reception rate. 

Average RSSI The Average RSSI gives an indication of the received signal quality, even in environments with 

Rayleigh fading. Average RSSI participates in the choice of the best synchronization father. 

Comm Module MAC 

Monocast Rx Count 

A MAC layer packet is referred to as a Monocast. This field is a count of the number of Monocast 

messages that have been received by a meter. 

Comm Module Net 

Downlink Packet 

Count 

The number of times an RFLAN Net Download Packet has been received. 

Comm Module 

Uplink Packet Count 

The number of times an RFLAN Net Download Packet has been sent. 

Comm Module Net 

Routing Count 

The number of meters that route through this cell relay. 

Neighbor List (RFLAN) 

Field Description 
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Field Description 

MAC Address The unique number assigned to the meter by its manufacturer to identify the device’s Internet Protocol 

(IP) network adapter.  

Synch Merit Indicates which neighbors are good to synchronize with, lowest being the best. The values used to 

calculate the Synch Merit are GPD, LPD, Level, Cell Size Indicator, and Receive Rate. 

RSSI  Received Signal Strength Indicator is a measurement of the power present in a received radio signal. It 

is formatted as a single signed byte and is measured in decibels per milliwatt (dBm).  

 -100 is very poor; the hardware may have trouble turning the transmission into meaningful data 

and there will be many dropped packets. 

 -70 is average. 

 -50 is approaching saturation. 
 

LPD Local Average Propagation Delay (LPD) values are used to sort and select neighbors. They are used to 

select the best access for synchronization or to make a choice between different available cells. The 

network layer uses these values to choose the best path for routing packets. 

Level The number of hops from this neighbor to the cell relay. Cell relays display "1" in this column. 

Transmit Window The time slot when this neighbor is to send its next packet. It is measured in units of 150 milliseconds. 

The purpose is to randomize the timing of transmissions. 

Receive Rate Counts the number of good messages the meter has received from this neighbor, to a maximum of 

255. This value is reset to zero when the endpoint is powered down, reconfigured, or its RFLAN is 

reset. 

 
 

ERT Data 

The only kind of meter that can generate a data file with ERT Statistics is an OpenWay ICM (cellular) meter 

with an ERT Reader. The meter must be configured to support ERT Data. 

 
 

This window displays the transmission data of all ERT transmissions the meter received in the 24 hours 

before the data file was created. It does not display the consumption data contained in the transmissions. 
 

Field Description 

ERT ID The unique identification of the ERT module in the gas meter. 

ERT Type The type of meter whose consumption data is contained in the ERT transmission. 
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Field Description 

Time Recorded The date and time that the ICM meter received the ERT transmission. 

# Recent Reads The number of times during the past 24 hours that the ICM has heard from each nearby gas meter. 

Average RSSI Received Signal Strength Indicator is a measurement of the power present in a received radio signal. It 

is formatted as a single signed byte and is measured in decibels per milliwatt (dBm).  

-100 is very poor; the hardware may have trouble turning the transmission into meaningful data and 

there will be many dropped packets. 

-70 is average. 

-50 is approaching saturation. 
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SiteScan Toolbox Data 

While you are communicating with a meter or while a Meter Image File is open, the Toolbox Display and 

Power Circle Display options are available. These items are listed under Device Status. 

 The Toolbox window provides per-phase information, instantaneous data, and for OpenWay CENTRON 

Polyphase meters (V&I), SENTINEL and VECTRON devices, diagnostic status counters. This 

information enhances your ability to diagnose and resolve metering and tampering problems. 

 The Power Circle view displays watt, var, VA, and power factor data as a power circle graphic. For more 

information, see Power Circle on page 142. 

The toolbox option is only available for meters that support SiteScan. The SiteScan Toolbox data window has 

three tabs: 

 Toolbox Data 

 Toolbox 

 Power Circle 

 
 

Toolbox Data 

The per-phase volt and amp readings, along with voltage and current angle readings, let you check the site’s 

phase sequencing performance. The diagnostic counters alert you to the frequency of a metering or tampering 

problem. 

If diagnostics are configured in the meter, the counters will show the occurrence of diagnostic events. 
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Toolbox 

The SiteScan Diagnostic Toolbox displays all the metering information used by the meter for individual phase 

measurements including per phase items and diagnostic counters. The information in the Toolbox represents 

the actual electrical signals seen by the meter. The per-phase Volt and Amp readings are Root-Mean-Square 

(RMS) values. The combination of a diagnostics and other information in the Toolbox display enhance your 

utility's ability to diagnose and resolve metering and tampering problems. 

Instantaneous readings for kW, kvar, kVA, and power factor are displayed for each phase. 

The combination of a diagnostic error and the information in the Toolbox display enhance your utility's ability 

to diagnose and resolve metering and tampering problems. 

The phase notation used in the Toolbox identifies each meter element as phases A, B, or C as shown in the 

following table: 

Element in Meter Defined Phase 

Left Element Phase A 

Center (or Rear) Element Phase B 

Right Element Phase C 
 

 

Power Circle 
Area of Power 
Circle  

Description 

Meter Configuration The top portion of the window identifies the meter site and gives the transformer factor and register 

multipliers as well as hardware options. 

Power Circle 

Information 

If you are logged on to a meter, the Power Circle view displays the current meter values for watt, var, 

and VA as a power circle graphic. Watts are displayed on the X axis with vars on the Y axis. VA is 

displayed as an angle between vars and watts. 

For a Meter Image File, the Power Circle reflects the meter values at the time the MIF was created. 

Measurements The measurements represented in the power circle are listed as well as power factor. 

Start/Stop When you view the Toolbox by selecting the Show Power Circle item from the Communications 

menu, the Stop/Start button is available on the dialog. Click this button to pause or resume the 

automatic refresh of data from the meter. 

Note:  This button has no function if you are viewing a Meter Image File. 

Save to File To save the Power Circle view to an HTML file: 

If you are viewing the Power Circle by selecting the item from the Communications menu, the Save to 

File button is available. Click this button to save the view to an HTML file. 

If you are viewing the Device Status item, select File > Export > Current View to HTML. 

Note  The automatic refresh of data stops while a save to file or export to HTML is done. 
 

 



Shop Manager 

 
 

OpenWay Tools User Guide 143  

 Proprietary and Confidential 
 
 
 
 

Creating Reports 

The Create Report option is only available when one or more files are selected. The Create Report dialog 

contains the options needed to generate a report.  

The Report Specification drop down lists three different report types: 

Report 
Specification 

Description 

OpenWay Daily 

Summary 

The Daily Summary report contains the Load Profile Summary for each channel and a Daily 

Summary block for each channel. The Daily Summary block contains Total Energy, Average 

demand, Minimum Demand, Time of Minimum Demand, Maximum Demand, Time of Maximum 

Demand, Number of intervals and Number of status intervals. The report shows Page Numbers, 

Date/Time and Unit ID. 

OpenWay Interval 

Data 

The Interval Data report contains the Load Profile Summary and the Interval data listing, which shows 

the Date/Time of each interval along with the data for each channel and the status bytes for each 

channel. The report show Page Numbers, Date/Time and Unit ID. 

OpenWay Profile 

Summary 

The Profile Summary report contains the Load Profile Summary and the Interval data graph. This is a 

graph that displays channels for the given time range. The report shows Page Numbers, Date/Time and 

Unit ID. 
 

The Report Contents section contains the list of options for setting up the duration of the data to use for the 

report. There are options for All Data in File or Custom Date Selection. If Custom Date Selection option is 

selected, the Report Start Date and the Report End Date date/time calendar controls are enabled to allow 

you to choose the date and an hour. The Start Date must be before the End Date. 

The Save Options section contains the options for saving a hard copy of the report. Select one of the 

following options: 

Save Option Reason for Using 

Microsoft® Excel® Useful for manipulating data or performing calculations. 

HTML Useful for posting information on websites or in e-mails. 

Adobe® PDF A user-friendly report format that is easily sent to others. This format is not easily modified without 

special tools. 

Text A text-only report format. No graphics can be used. 

XML Useful for programmatically using data. 
 

 

If the data set being generated is large (for example multiple intervals or channels), you 

may see undesirable formatting in the .txt format. The Adobe PDF and Microsoft Excel 

outputs are better suited for larger amounts of data. 
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When one or more of these options are selected, the Directory and Browse buttons become enabled. These 

controls allow you to choose the file location of the report. The path you select here is the path used in the 

Data Manager reports view. 

The Print Report option is used to print the generated reports. This feature allows batch printing of multiple 

selected data files using the settings selected in this dialog. You can choose this in conjunction with the Save 

Options. 

The OK button is only enabled if the Print Report or one of the Save Options is selected. It allows a report 

to be printed and/or saved. Saved reports are not overwritten if they already exist. A number is appended to 

the report's name to allow multiple reports being created. You can see the newly created reports in the Reports 

view of the Data Manager. 

 
 

Report Status 

The Report Status dialog lists the status of the report generation for the selected OpenWay Data Files. This 

dialog notifies you once the reports are complete.  

 

Depending on the amount of data in the OpenWay Data File, running a report could be 

time consuming. 
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Firmware Files 

OpenWay Shop Manager provides the ability to import firmware files, delete them, and mark them Active so 

that Field-Pro can download them to devices. 

The Firmware Files window has two tabs, Select Active and All Files.  

All Files tab: Lists all the firmware files located in the Firmware Directory field at the top of the window. 

To sort and display all the activated firmware files together, click the Active column header. (This tab does 

not allow you to select the Active check boxes.) 

Select Active tab: Allows you to filter so that only the firmware corresponding to one type of device displays. 

 

The Select Active tab displays all OpenWay hardware supported by OpenWay Tools. Open the nodes to drill 

down to the particular device for which you need firmware. When you highlight it, the window displays all 

firmware files located in the folder shown in the Firmware Directory field that can be loaded to the selected 

hardware. Click the Active check box to make the firmware file visible to Field-Pro users. 

The Delete option is available whenever at least one file is selected. Import is always available. 

For more information see Downloading firmware to a meter using OpenWay Tools on page 71. 

For more information about OpenWay hardware, refer to the Technical Reference Guide for that device.  
 

 

Delete Firmware 

The Delete Firmware option is available if at least one firmware file is selected. When you click this option, 

you are prompted to confirm the deletion of the firmware file. After the confirmation, the firmware files are 

removed and the list is updated. 
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Import Firmware 

This dialog opens from the Shop Manager Firmware Files view when you click Import. It displays all 

firmware files located in the Source Directory field. The Browse... button allows you to choose a different 

location. Click on any of the column headers to sort the files.  

 

If you attempt to import firmware that has the same name as a program file that already exists on your system, 

you are prompted to overwrite the existing program, cancel the import, or rename the imported file. 
 

Importing Firmware 

1. Open Shop Manager. If prompted, enter your User ID and Password. 

2. Go to the Firmware Files view. 

3. Under the Firmware Options menu click Import. 

The Import Firmware dialog opens. 

4. Click the Browse... button to locate the folder where the files are. Click OK. 

5. Select the check box of each firmware file to be imported or click Select All. To clear all selections, click 

Clear All. To return to the Firmware Files view without making any changes, click Cancel. To import the 

selected programs, click OK. 
 

Downloading firmware to a meter using OpenWay Tools 

In most circumstances utility companies use the OpenWay Collection Engine to download firmware to meters 

over-the-air. When you need to load firmware locally, either by optical probe or ZigBee, use this procedure. 

Note that firmware download via ZigBee is extremely slow. 

1. Open Shop Manager and import the firmware files. Select the Active check box of all files to be 

downloaded. For more information see Importing Firmware on page 146. 

2. If OpenWay Field-Pro is located on a separate computer, create a Replica File. Exit Shop Manager. 

3. If necessary, load the Replica File. 

4. Log onto the meter with OpenWay Field-Pro. 
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5. Go to the Firmware Load window (located under Programming Functions by default). 

6. Select a firmware file to download and click F1 to continue. 

7. Click F1 to begin downloading the firmware into the meter. Field-Pro displays a message when firmware 

download is complete.  

The firmware load is not complete until the CRC check is complete and the meter's display has returned to 

its normal operating state. Depending on the type of firmware that is being downloaded, you may see 

several things flash across the meter's display (such as CrCCALC, SEnd, Rfinit). 

In most cases, you must wait several minutes for the activation of the new firmware to complete. When 

you log back onto the meter the Meter Summary window displays the firmware versions. This indicates 

whether the download was successful. If it was unsuccessful, the meter continues to run the previous 

firmware version. 

8. You may need to re-initialize the device in order to take advantage of new features in the firmware. For 

more information see the OpenWay Field-Pro topic Initialize Device. 
 

 

The firmware file name is recorded in the Activity Log. Hardware 3.1 meters create a 

record in the Firmware Download Event List. 
 

 

Comm Module Files 

The Comm Module Files navigation panel manages RF Mesh Configuration files and PPP Key files. To add 

the navigation panel to the Shop Manager interface, refer to Customizing the Shop Manager Interface on page 

106. 

Meters that communicate via RF Mesh have special configuration requirements. The Comm Module Files 

panel allows you to manage these configuration files.  

 

Unlike firmware files, this interface does not contain an Activate check box. All files are treated as 

active once they are imported into the correct directories.  

To prevent errors, the Field-Pro window Download RF Mesh Configuration can only "see" files 

whose names contain the MAC address of the meter that the Field-Pro user is currently logged into. 
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RF Mesh Config files are downloaded through the meter’s register to the comm module. They contain the 

security certificate that authenticates communication onto the IP network, giving the meter permission to talk 

to the OpenWay Collection Engine. Itron provides one RF Mesh Config file for each meter in your network. 

 

The RF Mesh File Directory is a fixed location to hold all RF Mesh Config files. Click Import to navigate 

and move the files to this location. 

 

PPP Key files tell the meter's register what key to use to encrypt and decrypt information exchanged between 

the comm module and the register. 

The PPP Key Directory is a fixed location to hold all PPP Key files. Click Import to navigate and move the 

files to this location. 
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Import Comm Module Configuration Files 

This dialog opens from the Shop Manager Comm Module Files panel when you click Import on the RF Mesh 

Configs tab. It allows you to navigate and import the configuration files to the fixed directory where they must 

be located in order for Field-Pro users to download them to meters. 

 

Click the Browse... button and navigate to locate the configuration files. Click OK. 

Check the files to be imported (or use the Select All button). To clear all selections, click Clear All. To return 

to the main window without making any changes, click Cancel. To import the selected files, click OK. 
 

Import PPP Key Files 

This dialog opens from the Shop Manager Comm Module Files panel when you click Import on the PPP 

Keys tab. It allows you to navigate and import the PPP Key files to the fixed directory where they must be 

located in order for Field-Pro users to download them to meters. 

 

Click the Browse... button and navigate to locate the PPP Key files. Click OK. 

Check the files to be imported (or use the Select All button). To clear all selections, click Clear All. To return 

to the main window without making any changes, click Cancel. To import the selected files, click OK. 
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RMA Files 

An RMA (Return Material Authorization) is required for all products that need to be returned to the factory. 

Itron recommends that all repairs be performed at the factory. Certain repairs may be performed by the user; 

however, unauthorized repairs void any existing warranty. All surface mounted parts must be replaced by the 

factory. 

If the meter is under warranty, Itron will repair the meter at no charge if the meter has failed due to 

components or workmanship. A return authorization number must be obtained before the equipment can be 

sent back to the factory. Contact your Itron Sales Representative for assistance. 

Use the following address for returning material: 

Service Return Address 

Itron, Inc. 

Customer Repair Department 

313 North Highway 11 Dock C 

West Union, SC 29696 

U.S.A. 

For more information on sending in this information to the factory, please refer to the following: 

 Generate RMA 

 Delete RMA Files 

 Move RMA Files 
 

Generate RMA 

With the addition of the Signed Authorization to meters, the RMA process needs additional information. 

Authorization credentials are needed so that the Itron staff can logon to meters that are sent back. Since it 

takes several days for meters to be sent in, processed and investigated by the appropriate people at our facility, 

credentials are active for a much longer duration than a normal credentials.  

The RMA Credentials Generator Tool generates Authorization Credentials for the RMA meter. This 

application allows you to enter the Itron Serial Number. Using this information, the Credentials Generator 

requests credentials from the URL provided in OpenWay Shop Manager. The default duration is set to 90 

days and the Serial Number is set to the value provided. This value is controlled in the OpenWay Collection 

Engine. Once the RMA credentials have been generated, this file must be included as a part of the RMA 

return process. 

When the Serial Number is entered, you have the option to Preview the key. 

To return to the main window without generating an RMA, click Cancel. To generate the RMA, click OK. 
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Delete RMA Files 

Based on the selections on the previous window, this dialog shows the RMA(s) that were chosen for deletion. 

To return to the main window without deleting a program, click Cancel. To delete the selected programs, 

click OK. 
 

Move RMA File 

This option allows the user to move files from one directory to another (from the Current Directory to the 

Destination Directory). Use the Browse button to locate a new directory. 

The listing at the bottom of the window displays the files to be moved. 

To return to the main window without deleting a program, click Cancel. To delete the selected programs, 

click OK. 
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Activity Log 

OpenWay Shop Manager provides you an easy-to-read display of the activity log. The data view is 

configurable to allow you to select which data items should be shown and to allow you to drill down into each 

record to display all of the information recorded for each event. 

By default the data view lists the following items for each record found in the activity database: 

 Event time 

 Meter's Unit ID 

 Meter's Serial Number 

 Action performed 

 Action results 

You can sort the data displayed by any of the displayed items. 

The event time field is underlined and acts as a hyperlink to display additional information regarding the 

event. When you click on the event time, a modal dialog box is presented to show all of the details regarding 

the selected event.  

You can also limit the display of activity log records by restricting the date range displayed including 

selecting both a starting and stopping date range. 

The activity log data view supports printing and can be exported to Microsoft Excel format. 

 



Shop Manager 

 
 

OpenWay Tools User Guide 153  

 Proprietary and Confidential 
 
 
 
 

To View an Activity Log 

1. Open the Shop Manager application (Start > Programs > OpenWay Tools > Shop Manager). 

2. Go to the Activity Log tab on the left side of the window. 

3. Click on the hyperlink of the Event Time to open the Activity Log. 

4. To limit the number of activity logs shown on this window, click Filter Events (on page 155) or Select 

Items to Display (on page 155). Possible fields that can be displayed are listed below. 

Field Description 

Event Time The time that the event occurred. 

Unit ID A unique meter identifier. The unit ID can be entered when you initialize a device. Programming Options must 

be set up to prompt to enter the unit ID at initialization. 

Serial Number A unique number assigned to the meter; it is the last section of the electronic serial number and is used as a 

device name in the system. Generally, this number is assigned by Itron and used for tracking purposes. 

Activity The function that is being logged. 

Activity Status The result of the activity. Values can be "Succeeded" or "Failed." Any failures are followed by an explanation. 

For example, the activity failed because of a meter time out. 

Application The application where the activity function was logged. 

Workstation The computer name of the workstation where the activity was logged. 

User The name of the user ID from the workstation where the activity was logged. 
 

 

Opening Activity Logs 

To open an Activity Log file click the hyperlink file name of the Activity Log file. 

This opens the Activity log in the Activity Details window (on page 153). 
 

Activity Details 

You can import, export, merge, or roll-off activity log events. This is a read-only view and provides you with 

a quick and easy way to see recently performed actions. 

Field Description 

Event Time The time that the event occurred. 

Activity The function that is being logged. 

Activity Status The result of the activity. Values can be "Succeeded" or "Failed." Any failures are followed by an explanation. 

For example, the activity failed because of a meter time out. 

Unit ID The utility company's unique identifier for the meter. 

Meter Type The type of meter the activity affected. 

Application The software application being used when the activity function was logged. 

Application Version The version number of the software application. 

Workstation The computer name of the workstation where the activity was logged. 

User The name of the user ID from the workstation where the activity was logged. 
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Roll-Off Events 

The topic bar page for the Activity Log view provides an option to roll-off event records. When selected, this 

option deletes all records that are older than the prescribed activity log length. 

Every time the Shop Manager is started, it reads the oldest record from the activity database and, if one is 

found, compares its age to the limit established by the previously mentioned system setting. If the oldest 

record is past the calculated expiration date, you are prompted to go to the Activity Log view and roll-off all 

the expired records. 

 
 

Export Activity Log 

The Export Activity Log option is used to export external activity logs from Shop Manager. These include 

Activity Logs from OpenWay Field-Pro and ZigBee Manager. 

To Export an Activity Log 

1. Open the Shop Manager application (Start > Programs > OpenWay Tools > Shop Manager). 

2. Go to the Activity Log tab on the left side of the window. 

3. Under the Program Options menu click Export Activity Log. 

4. The Export Programs dialog opens. 

5. Locate the import files. Once the directory is located, click OK. 
 

Import Activity Log 

The Import Activity Log option is used to import activity logs into the programs database. These include 

Activity Logs from OpenWay Field-Pro and ZigBee Device Manager. 

To Import an Activity Log 

1. Open the Shop Manager application (Start > Programs > OpenWay Tools > Shop Manager). 

2. Go to the Activity Log tab on the left side of the window. 

3. Under Program Options menu on the left side of the window, click Import Activity Log. 

4. The Import Programs dialog opens. 

5. Click the Browse... button to locate the import files. Once the directory is located, click OK. 

6. Check (or use the Select All feature) the programs needing to be imported. 

7. Click OK to begin the Import. A progress bar is displayed. 
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8. When the process is complete, a Import Status box appears. 
 

Filter Events 

Use the Filter Events option to customize the view of Activity Logs. You can display only failed activities or 

filter the events via a specified date range. 

 
 

Select Items to Display 

By selecting the "Select Items to Display" menu on the view's topic bar, you can customize contents of the 

activity log display. You can include or exclude all of the data items (except event time) that are included in 

the activity log. Display of the event time field is mandatory and cannot be disabled. 
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System Settings 

System Settings includes options that allow you to save changes to the settings, undo changes, and create 

replica files. It has four tabs:  

 General Settings (on page 156) 

 Field-Pro Customizable User Interface (on page 162) 

 User Access Policy (on page 163) 

 Validation Tool Settings (on page 167) 

Click Save Changes to save any customizations made to the System Settings. To undo any customizations, 

click Undo Changes.  

System Replication is the process of setting up a new system on another PC using the same system defaults 

and options as the original system. To create a replica file to load in a separate system, click Create Replica 

File. 
 

General Settings 

These fields control data file creation and security. Refer to the OpenWay Security Reference Guide for 

complete security information. 
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Data File Creation Options 

If you must perform a contingency read use the following fields to set the amount of load profile and event 

data OpenWay Field-Pro will capture from the meter. All register data is captured by default, along with gas 

data if the meter is joined to gas modules. Field-Pro users cannot modify these settings. 

Field Description 

Max. Days of Load 

Profile (CRF Only) 

All Data. all load profile data on the meter; this can be a lot of data, which affects the time it takes to create the 

file. 

nn Days. everything from the most recently completed interval back nn days. 

User Defined Date Range. Field-Pro requires the user to enter start and end dates on the Create CRF File 

window. 

Max. Days of 

Extended Load 

Profile (CRF Only) 

If the meter is programmed to store a second set of load profile data, use this field to specify how much to 

retrieve in the CRF file, or select No Data to prevent the second set of load profile data being shown in the 

CRF file. 

Max. Days of Event 

Data (CRF Only) 

Use Load Profile Date Range. Field-Pro uses the same interval selected above. 

All Data. all events stored in the meter. 

None. Do not include event data in the data file. 

External System ID 

(CRF Only) 

Your installation of Itron Enterprise Edition (IEE) has an External System ID that identifies and connects it to 

your OpenWay system. Enter the same External System ID here; this allows IEE to map the CRF event file 

correctly. 

Meter ID Used in 

Filename 

Choose one of the following to include its ID in the filenames of CRF files and data files (EDL files): 

Electronic Serial Number and Manufacturer Serial Number are unique identifiers determined by Itron 

and set in each meter at the time of manufacture. 

Customer Serial Number and Unit ID are identifiers determined by the purchaser that can be set in each 

meter at the time of manufacture (by arrangement when purchased) or you can set them manually using the 

Initialize Meter window of OpenWay Field-Pro. 

Enable CRF Signing Reserved for future use. 

Signing Certificate 

Distinguished Name 

Reserved for future use. 

 

OpenWay Data File Creation Options 

OpenWay data files include device status, configuration data, and register data by default. The check boxes 

below are optional data sets that can be added. To speed the work of meter technicians and minimize errors, 

use this field to set the defaults in Field-Pro by checking any combination of boxes. Field-Pro displays the 

same set of options and allows technicians to modify the selections. 

 Include History and Event Data 

 Include LAN and HAN Log Data 

 Include LAN and HAN Data 

 Include Load Profile Data 

 Include Voltage Monitoring Data 

 Include Instrumentation Profile Data (available only on HW 3.0 and 3.1 meters) 
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Data Display Options 
  

Show Debug 

Information 

There are several places in OpenWay Tools that display the current firmware versions for the Register, the 

Communication module, and the HAN module. The Show Debug Information check box allows you to 

manipulate how much information is displayed. If you want to display only the version and revision, uncheck 

the box. If you want the build number to display also, check the box. 
 

C12.18 Security Settings 
  

Status Displays the current status of Signed Authorization security: Enabled or Disabled. 

Click the C12.18 Settings... button to open the C12.18 Security Settings dialog and set up security options. 
 

Enhanced Security Validation File 

This security feature prevents unauthorized sniffers, hackers, etc. from accessing the meter network. 
  

Status Displays the current status of Enhanced Security: file loaded or no file loaded. 

OpenWay meters are injected with security keys that encrypt data before it goes out on the meter network. The 

keys are included on a security file that is generated at the production facility and shipped on a disk with each 

pallet of meters. Click the Import… button to load the security file so that Field-Pro can verify that the keys on 

each meter are correct. 
 

Program Signature Verification 

Use the following two check boxes to confirm the authenticity of meter programs using a signature value and 

a certificate listed inside each file. The certificate verifies that the meter program was created by a trusted 

Collection Engine. The signature verifies that the meter program was not changed since the time it was 

exported from the Collection Engine. 
  

Verify Signature 

During Import 

Check the box to have Shop Manager verify the signature and certificate of all program files before adding 

them to the list of files available for import on the Import Programs dialog. The Meter Programs tab continues 

to show all programs, allowing you to continue to view and use existing unsigned programs. 

Uncheck the box to have Shop Manager add all programs to the list of files available for import without 

checking for signature and certificate. 

Verify Signature 

During Configuration 

Check the box to have Field-Pro verify the signature and certificate of all files. It performs this check two 

times: 

 Before populating the list of programs that can be used for configuration 

 Before configuring the meter 

Uncheck the box to have Field-Pro display and use all programs that have been approved by Shop Manager. 
 

Utility Identification Settings 

This function allows meters with OpenWay ICS comm modules to connect to different head-end systems. 
  

Allow Authorized 

Users to Modify 

Settings 

Check the box to enable setup of RFLAN Utility IDs, Cellular Gateways, and ERT Utility IDs. Click the 

Utility Identification Settings... button to open the Utility Identification Settings dialog and establish up to 

five utility ID groups. Once these are set up, qualified Field-Pro users can use the data to configure meters. 

Uncheck the box to disable this functionality. 
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C12.18 Security Settings 

This dialog opens from the OpenWay Shop Manager System Settings panel, the General Settings tab, when 

you click the C12.18 Settings... button.  

These security features are intended to prevent unauthorized users from gaining access to meters.  

 
 

OpenWay Meter Security Codes 

Meters are configured to use either this method or Signed Authorization. The replica file on the Field-Pro 

user's PC contains these passwords, and the meter's register has the password from in the configuration file 

created in the Collection Engine. When Field-Pro attempts to log into a meter, it first tries the Current Security 

Code, then the Previous Security Code, then NULL. If all three fail, Field-Pro displays a dialog that allows the 

user to enter an override security code. For more information, see Override Security Code on page 9. 
  

Current Security 

Code 

Enter the security code in the meter's current configuration file. 

Previous Security 

Code 

Enter the security code in the meter's previous configuration file. 

 

Signed Authorization 

Meters are configured to use either this method or Meter Security Codes. This method provides tighter 

security because access to the meter is for a limited duration. Use the following four fields to tell Field-Pro 

how this feature is set up at your company. 
  

Use Signed 

Authorization 

Check the box if your utility has meters that are configured to use signed authorization. 

Uncheck the box if your utility does not use signed authorization. 

Use Windows Login Check the box to have the system use your Windows user credentials to retrieve the authorization credential. 

You must be set up as a user in the Collection Engine, and your security level determines what permissions 

technicians have when they log into the meter. 

Uncheck the box to have the system use the other login method, certificate exchange (below). 

Authorization Server Enter the name of the Collection Engine server where signed credentials are kept. Field-Pro requests these 

credentials from the Collection Engine every day. The credentials list the user, the level of access the user is 

being granted, and the time period for which the credentials are valid. Field-Pro adjusts the start time back 10 

minutes from the current time on the Collection Engine server to ensure that the user is able to log onto the 

meter immediately after requesting the credential. 



Shop Manager 

 
 

OpenWay Tools User Guide 160 

 Proprietary and Confidential 
 
 
 

Log in to the Signed 

Authorization Server 

If you are not using the Windows Login authentication method (above), this dialog box appears after you enter 

the name of the Authorization Server. Enter the User Name and Password of the Authorization Server. Enter 

the User Name and Password of the individual or user group that will be performing the work on the meter. 

This person or group must be set up as a user in the Collection Engine with correct permissions. This method 

requires that a matching Certificate Authority (to the Collection Engine) be installed on each individual PC so 

that the user name and password can be securely sent over the network. 
 

ICS Communication Module Security Codes 

If your utility has meters with ICS comm modules (cellular connection) use these fields to provide the meters' 

comm module passwords. The replica file on the Field-Pro user's PC contains these passwords, and the 

meter's comm module has the password set up either when the module was manufactured or when the ICS 

Transaction Management System sent configuration information to the comm module. When Field-Pro 

attempts to log into a meter with an ICS comm module, it first tries the Current Security Code, then the 

Previous Security Code, then NULL. If all three fail, Field-Pro displays a dialog that allows the user to enter 

an override security code. 
  

Current Security 

Code 

Enter the security code in the meter's current configuration file. 

Previous Security 

Code 

Enter the security code in the meter's previous configuration file. 

 

Session Timeouts 
  

Enable Field-Pro 

session timeouts 

Check the box to have Field-Pro log off the meter when there is no user input for a selected number of 

minutes. 

Uncheck the box to have Field-Pro remain logged on regardless of user inactivity. 

Session timeout 

minutes 

If the box above is checked, select the number of minutes that Field-Pro should remain logged in with no input 

from the user. Valid range is 5 to 60 minutes. 
 

 

Utility Identification Settings 

This dialog opens from OpenWay Shop Manager's System Settings panel, the General Settings tab, when you 

click the Utility Identification Settings... button. The button is enabled when the Allow Authorized Users to 

Modify Settings check box is selected. 

Use this window to manage settings that allow meters to connect to different head-end systems. You may set 

up a maximum of five groups for production and testing. 

 
 

Field Description 
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Field Description 

check box The Add button is enabled when no check boxes are selected unless there are already five groups set 

up. Click the Add button to navigate to the Add Identification Settings Group dialog and create a new 

group.  

Select one checkbox to enable the Edit button and navigate to the Edit Identification Settings Group 

dialog and modify an existing group.  

Select one or more check boxes to enable the Delete button. The selected group(s) are removed 

immediately with no verification message. 

Group Name Displays the short name for the group.  

Description Displays the description that indicates the purpose of the group. 

RFLAN Utility ID Displays the RFLAN Utility ID that meters in this group are use. If (Not Set) displays, there are no 

meters in this group that transmit data via RFLAN. 

Cellular Gateway Displays the Cellular Gateway that meters in this group are use. If (Not Set) displays, there are no 

meters in this group that transmit data via cellular gateway. 

ERT Utility ID Displays the ERT Utility ID that meters in this group are to be configured with. If (Not Set) displays, 

there are no meters in this group that transmit data via ERT. 
 

Add or Edit Identification Settings Group 

This dialog opens when you click the Add or Edit buttons in the previous window. Each group you set up 

may have one, two, or all three IDs set up, depending on the types of meters included in the group. 

The following Field-Pro windows are enabled when these values are saved in the replica file and loaded to the 

Field-Pro user's PC: 

 The Change Utility ID window is enabled when the RFLAN Utility ID is set up and Field-Pro is logged 

onto a meter with an RFLAN comm module. 

 The Change Cellular Gateway window is enabled when the Cellular Gateway is set up and Field-Pro is 

logged onto a meter with an OpenWay ICS comm module. 

 The Change ERT Utility ID window is enabled when the ERT Utility ID is set up and Field-Pro is logged 

onto a meter with an OpenWay ICS comm module. 
 

 
 

Field Description 

Name Enter a short name for the group.  

Description Enter a description that indicates the purpose of the group. 

RFLAN Settings If this group includes meters that transmit data via RFLAN, select the check box and enter the value 

Itron has provided. 
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Field Description 

Cellular Settings If this group includes meters that transmit data via cellular gateway, select the check box and enter the 

value Itron has provided. 

ERT Utility ID If this group includes meters that transmit data via ERT, select the check box and enter the value Itron 

has provided. 
 

Click OK to return to the previous dialog. Click Save Changes in the System Settings window. Click Create 

Replica File to be able to transfer this information to Field-Pro users' PCs. 
 

 

Field-Pro Customizable User Interface 

This feature allows you to set up which options you want to be able to select in OpenWay Field-Pro as well as 

the menu the feature should appear on. 

The Customizable User Interface window is located under System Settings in the Shop Manager. You can 

make changes, save, and create replica files including these settings. You can even undo changes while 

working with the Customizable User Interface window. 

The left side of the Customizable User Interface window displays the available OpenWay Field-Pro features. 

They have been grouped together in functional groups to make selection easier. If an item is in bold, it has 

been included in the OpenWay Field-Pro Customizable User Interface. 

The right pane of the Customizable User Interface window displays the window layout for OpenWay Field-

Pro. It shows the function key along with the menu or feature in the order that they are presented. 

You can select a feature and add it to the layout by clicking the Add button or by dragging and dropping it. If 

a menu is selected and Add is clicked (or if a feature is dragged onto a menu), then the feature is added to the 

first open function key in the menu. The features on the left side become bold when added to the window 

layout. This indicates that the feature is present in one or more menus. 
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Button Description 

Add Menu The Add Menu button allows you to add new menus to the layout.  If an empty function key is selected, then 

you can click the Add Menu button. A dialog is displayed to allow you to enter the title for the new menu, up 

to 80 characters. The menu is added to the layout and the eight empty function keys are displayed. You are 

only allowed to create menus down to the third level.  If and empty function key is selected on a third level, the 

Add Menu button is disabled. 

Edit Menu The Edit Menu button allows you to change the name used for the menu in the Field-Pro Screen Layout 

tree control, up to 80 characters 

Delete Menu Features and empty menus can be removed from the tree control by selecting the feature/menu and clicking 

Clear or by hitting the Delete key. Menus with items can be deleted by clicking the Delete Menu button. 

Add >> The Add >> button allows you to move a feature to the OpenWay Field-Pro menu set. 

Clear << The Clear << button allows you to remove a feature from the OpenWay Field-Pro menu set. 

Move Up and Move 

Down 

The features can be moved throughout the layout by using the Move Up and Move Down buttons. Items 

within a menu cannot be moved outside of the menu.  The top most items in a menu can only be moved down, 

and bottom most items in a menu can only be moved up. You can also move an entire menu either up or 

down. 
 

 

User Access Policy 

User access groups allow you to map access policies to groups of users, simplifying the administration of user 

accounts.  
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Administrators can enable or disable access to the previously defined functional groups to these user access 

groups. The Administrators group is a special group that provides access to all functionality. This is the only 

pre-defined group where the capabilities of this group are not user selectable. Although the pre-defined groups 

cannot be deleted, if they are not needed, you can effectively disable them by either not providing any 

capabilities to that group or by not assigning any users to that group. 

The intent of the Power Users and the Normal Users is to provide several distinct levels of user access. If a 

user does not belong to any of the above groups and user access policies have been enabled, then the user will 

not be able to use any of the following applications: OpenWay Shop Manager, OpenWay Field-Pro, and 

ZigBee Device Manager. 

 

Typically, Power Users and Normal Users do not have the rights to Manage System 

Settings, Manage Configuration Files, or to Manage Data. These users can use the 

"Limited Installation" which requires a replica file to be loaded prior to using the 

software. 

Initial Setup of User Accounts 

To control the access rights of each Windows user, user accounts are associated with a number of pre-defined 

Windows access groups as well as optional, application specific access groups. Your IT system administrators 

must assign access groups to each individual's logon credentials. Once associated, OpenWay Tools is able to 

associate a user with one of the five access groups and is able to restrict or grant access to specific functions 

according to their previous selections. No additional logons or security checks are required.  

User access policies are disabled upon initial installation. Access policies can only be enabled by a user that 

has previously been granted system administration privileges by an IT system administrator. This check is 

necessary to ensure that at least one user ID has been granted membership to the appropriate Windows group. 

User access policy settings are maintained exclusively by OpenWay Tools and are included in system replica 

files. 

The following user groups and their associated activities are pre-defined in OpenWay Tools. 

User Access Capability OpenWay Tools Functionality 

Manage System Settings Shop Manager: Save System Settings 

Shop Manager: C12.18 Security Settings 

Shop Manager: Utility Identification Settings 

Field-Pro: Disable Signed Authorization 

Field-Pro: M2 Optical Lockout 

Field-Pro: Enable Optical Port 

Field-Pro: Disable Optical Port 

Manage Configuration Files Shop Manager: Firmware Files – Import, Delete, Set as Active 

Shop Manager: Program Files – Import, Delete, Set as Active 

Manage Data Shop Manager: Data Files Delete/Move 

Shop Manager: Data Files Change Current or Upload Directory 

Shop Manager: Activity Log Roll-Off Events 
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User Access Capability OpenWay Tools Functionality 

Comm Module Operations Field-Pro: Register Communications Module with Host 

Field-Pro: Deregister Communications Module from Host 

Field-Pro: Reset Comm Module 

Field-Pro: Opt Out 

Field-Pro: Change Utility ID 

Field-Pro: Change Cellular Gateway 

Field-Pro: Change ERT Utility ID 

Field-Pro: Send Diagnostic Command 

Field-Pro: Switch to OpenWay Mode 

Field-Pro: Switch to ChoiceConnect Mode 

HAN Operations Field-Pro: Add HAN Device 

Field-Pro: Set Data Delivery Config - Gas Meter 

Field-Pro: Set Collection Config - Gas Meter 

Field-Pro: Clear HAN Halt Condition 

Field-Pro: Decommission HAN and Reform Network after Delay 

Field-Pro: Decommission HAN and Reform Immediately 

Field-Pro: Drop Node 

Field-Pro: Enable HAN Joining 

Field-Pro: Disable HAN Pricing 

Field-Pro: HAN Move Out 

Field-Pro: Set HAN Multiplier 

Field-Pro: Update HAN Security Keys 

Field-Pro: Form Network 

Field-Pro: Halt Network 

Meter Switch Operations Field-Pro: Connect 

Field-Pro: Disconnect 

Field-Pro: Connect with User Intervention 

Field-Pro: Service Limiting Mode 

Initialize Meter Field-Pro: Initialize Meter 

Reconfigure Meter Field-Pro: Reconfigure C12.18 Over ZigBee 

Field-Pro: Configure KYZ 

Field-Pro: Reconfigure LED Quantity 

Field-Pro: Reconfigure SiteScan 

Field-Pro: Reconfigure TOU/DST 

Field-Pro: Activate Pending Table 

Field-Pro: Clear Pending Table 

Field-Pro: Clear All Pending Tables 

Firmware Download Field-Pro: Firmware Load 

Field-Pro: Download RF Mesh Configuration 
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User Access Capability OpenWay Tools Functionality 

Reset Demand Registers Field-Pro: Reset Demand Registers 

Reset Billing Registers Field-Pro: Reset Billing Registers 

Reset Tampers Field-Pro: Reset Tampers 

Reset Activity Status Field-Pro: Reset Activity Status 

Adjust Clock Field-Pro: Adjust Clock 

Field-Pro: Force Time Sync 

Clear All Meter Data Field-Pro: Clear All Meter Data 

Enter/Exit Test Mode Field-Pro: Enter/Exit Test Mode 

Clear Firmware Download Event Log Field-Pro: Clear Firmware Download Event Log 
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This tool gives you a quick way to validate that the meter you received matches your order specifications. 

Refer to the following topics: 

 Logging in to a secured meter 

 Starting a Test (on page 168) 

 Test Settings (on page 169) 

 Communications (on page 170) 

 System Settings in Shop Manager (on page 171) 
 

Log in to the Signed Authorization Server 

If the meter is secured by Signed Authorization, you must obtain an authorization credential which grants 

access to the meter for a period of time. The credential is generated by the Collection Engine. For more 

information see "Configuring Security Features" in the OpenWay Collection Engine User Guide. 

This dialog box allows the credential to be loaded to your PC. Enter the User Name and Password that gives 

you access to the server where these credentials are stored. For more information see your IT Department. 
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Starting a Test 

The Home tab is the main location for running tests as well as viewing the test results. As the tests are being 

run, progress is indicated for each meter that is currently being tested. The progress indicators report the 

current status of each test run as well as the number of passed, failed, and skipped tests. The indicator displays 

the manufacturer’s serial number so that you can easily determine which meters have completed a test run. 

Once a test run has completed, you can see the detailed results. 

For more information about setting up the tests, refer to System Settings in Shop Manager (on page 171). 

 

Run Tests 

The start button is only enabled if the communications settings have been set up and no test is currently 

running. The cancel button is only available while the test is actively running. If you click cancel, the 

application cancels all pending tests. It does not stop the test currently running. 

 

You must modify the Communications settings with a Port other than "None" in order 

for the Start button to be active. In addition, ensure one of the probes has been selected. 



Validation Tool Settings 

 
 

OpenWay Tools User Guide 169  

 Proprietary and Confidential 
 
 
 
 

Probe Selection 

Select the appropriate probe(s) to be used for the test. Up to four optical probes can be used for testing. 

Results 

The results of each test are saved in an XML format. To select the directory where these results are located, 

refer to Results Directory (on page 169).  

Use Open Results to open a saved results file. The file opens in a new tab; you can print and export the 

results as if the results were from a test run that had just completed. Multiple result files can be opened at the 

same time; toggle between results using the tabs at the bottom. Close All closes all open result files. 

Once the test has completed, use the Export option to export the results to an Excel spreadsheet. You have the 

option to export all open results tabs or just the tab that is currently being viewed. You can then select the 

location and file name for the new file; the results of each test run are exported to a separate sheet in the Excel 

file. 

Use Print or Print Preview to send the results to a external printer. 
 

Test Settings 

You can modify specific test settings using these options: 

 Program File (on page 169) 

 Results Directory (on page 169) 
 

 

Program File 

Open Program Dialog 

Select the program to be used within the OpenWay CENTRON Validation Tool. Any test that requires the use 

of the program checks the program to make sure that it applies to the current device type. If the program does 

not match the device type, the test immediately fails. 

Clear. Clears the value in the field. 

Browse. Select the program to use. Click OK to select. Click Cancel to close the dialog without making any 

changes. 
 

Results Directory 

Browse to select the location of the results directory. 
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Communications 

The Communications Tab lets the user select the communications port to use, the type of optical probe, and 

the maximum baud rate for each test. These values are saved between each use; they only need to be set if the 

system’s set up changes. 

 Port (on page 170) 

 Probe (on page 170) 

 Rate (on page 171) 
 

 

You can perform tests on up to four devices at a time. 

 
 

Port 

Before you can log on to Itron metering devices, you must select the computer's COM ports and modems that 

OpenWay Tools will use to communicate with the devices. Up to four devices can be used at a time; each 

device has its individual settings. 

The ports for your computer must exist in your system registry and must be available for use by OpenWay 

Tools (not in use by other devices) before you can configure them for use by the software. To see which ports 

and modems are configured for your PC, right-click on the My Computer icon on your desktop and select 

Properties. Click the Device Manager tab and select Modem or Port. To free a port for use by another 

application, close the Itron application or disconnect from the metering device. 

 

You must modify the Communications settings with a Port other than "None" in order 

for the Start button to be active. 
 

 

Probe 

Use this option to identify the optical probe model used at your utility. The model that you select determines 

the voltage on the PC’s RS-232 serial port connector pins to the optical port cable and determines how RTS 

(Request-to-send) and DTR (Data Receive) are set for communications. 

Choose the model of the optical probe that will be used most often for direct-connect communication with 

metering devices. 

The following table shows the data values and optical port head types for the different optical probe models. 

Optical Probe Model RTS Value DTR Values Optical Port 
Head Type 

Generic 1 - Non-powered 0 (low) 0 (low)  

Generic 2 - Powered 0 (low) 1 (high)  

US Microtel 300 0 (low) 0 (low) DIN 

US Microtel 500 0 (low) 0 (low) ANSI 
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Optical Probe Model RTS Value DTR Values Optical Port 
Head Type 

US Microtel 600 0 (low) 0 (low) ANSI 

GE SmartCoupler SC1 0 (low) 0 (low) ANSI 

Schlumberger (no longer manufactured) 0 (low) 1 (high) ANSI 

Schlumberger France 0 (low) 1 (high) DIN 

Schlumberger Spain 0 (low) 1 (high) DIN 
 

 

For the Abacus Electrics A6Z cable, select Generic 2. For the Abacus Electrics A7Z 

cable, select Generic 1. 
 

 

Rate 

Select the baud rate for the system to use to log on to the meter. The same baud rate is used for both receiving 

and transmitting data. Supported rates include: 

 9600 

 14400 

 19200 

 28800 
 

 

System Settings in Shop Manager 

The OpenWay CENTRON Validation Tool settings are set in the OpenWay Shop Manager. Once set, these 

values should rarely change; therefore, the settings are protected by the User Access Policy in order to prevent 

users from performing unauthorized operations. The settings are included in the OpenWay Replica files in 

order to easily distribute settings among several users. 

Refer to Test Selection (on page 172). 
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Test Selection 

You can select the validation tests to include in the test run as well as the order in which these tests are 

performed. The options are included in the System Settings section of Shop Manager. 

 Device Status (on page 172) 

 Validate Program (on page 173) 

 Show Normal Display (on page 173) 

 HAN Radio Test (on page 174) 

 Validate Security Keys (on page 174) 

 Disconnect/Connect (on page 175) 

 Clear Billing (on page 175) 

 Clear Activity Status (on page 175) 
 

Device Status 

This test validates the firmware versions as well as device time. In addition, it displays many of the device 

status items for visual inspection. The active firmware files are used when performing tests that require 

knowing the firmware versions. These tests automatically determine which meter type is currently being 

tested. The system then uses the active firmware files for that particular meter type. If no firmware files are 

currently active for that meter type, the test is skipped. For example, the Device Status test displays the 

meter’s firmware version but indicates that it skipped verification of that firmware if no file is currently 

active. This allows the user to manually verify that the correct version of firmware is selected. This test 

requires the following inputs: 

 Register Firmware (optional) 

 RFLAN Firmware (optional) 

 ZigBee Firmware (optional) 

 Display Firmware (optional) 

 Current Device Time Threshold (optional) 

The following items are displayed in the test results: 

 Meter ID  Register Firmware Version (Indication of 

mismatch if expected version is provided) 

 Serial Number  RFLAN Firmware Version (Indication of 

mismatch if expected version is provided) 

 Manufacturing Serial Number (MSN)  ZigBee Firmware Version (Indication of 

mismatch if expected version is provided) 

 Electronic Serial Number (ESN)  Display Firmware Version (Indication of 

mismatch if expected version is provided) 
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 Hardware Version  Time Zone (Indication of mismatch if 

expected Time Zone is provided) 

 TOU Enabled  Current Device Time (Indication of mismatch 

if  variation from PC time exceeds time 

difference if it is provided) 

 DST Enabled  Device Errors (If any present this is treated as 

an error; “None Found” displayed otherwise) 

 Meter in DST (This field is invisible if DST 

Enabled = No) 

 Minutes on Battery 

 DST Calendar  Date Last Programmed 

 From Date 1  Date of Last Demand Reset 

 To Date 1  Date of Last Outage 

 From Date 2  Date of Last Test 

 To Date 2  Normal Kh 

 RFLAN MAC Address  Load Profile Running 

 RFLAN Synch Level  Enhanced Blurts MeterKey Enabled (Single 

phase only) 

 HAN MAC Address  Basic or Advanced Polyphase MeterKey 

enabled (Polyphase only) 
 

 

Validate Program 

This test validates the meter against the selected program and requires the program file that was used to 

configure the device. A valid program must be provided or the test option cannot be executed. 

The following items are displayed in the test results: 

 Passed (If no discrepancies) 

 List of discrepancies and a count if there are any validation errors. 
 

 

Show Normal Display 

This test shows the normal display list as displayed in OpenWay Field-Pro. No validation occurs during this 

test. There are no inputs required for the test. 

The following items are displayed in the test results: 

 Display the Normal Display List as it is shown in OpenWay Field-Pro. 
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HAN Radio Test 

This test attempts to establish communications to the meter using the ZigBee radio. In order for this test to 

succeed, the ZigBee radio must be enabled in the meter, communications through the Itron private profile 

must be enabled, and C12.18 over ZigBee must be enabled. There are no inputs required for this test; 

however, network keys must be installed for this operation to work correctly. 

The following items are displayed in the test results: 

 Pass/Fail Indication if communication through ZigBee was successful.  

 Failure give some indication of what failed. 
 

 

Validate Security Keys 

This test validates the various security keys used in the OpenWay CENTRON meter. Optical and DES/3DES 

passwords are validated against the values in the selected configuration file. The Enhanced Security Key 

validation test requires that a valid key file is selected or the test fails. This file is selected using the existing 

option in the System Settings view in the OpenWay Shop Manager, which is currently used for the Enhanced 

Security Validation feature in OpenWay Field-Pro. This file is included in an OpenWay Replica File. The 

HAN Radio Test requires that a ZigBee radio is connected to the test computer and that it is currently 

available. It also requires that the correct HAN keys are installed. These keys can be installed using the 

customer specific supplemental install that Itron provides upon request. These keys are not replicated and 

therefore must be installed on each computer individually. This test requires the following inputs: 

 Program File used to configure the device 

 File that contains the Enhanced Security Keys (valid file must be provided or operation cannot be 

executed) 

 HAN Keys installed 
 

The following items are displayed in the test results: 

Pass/Fail indication if keys matched. 

 Optical Passwords 

 DES/3DES Passwords 

 Enhanced Security Keys 

 HAN Keys 
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Disconnect/Connect 

This test ensures that the disconnect/connect feature works as expected in the OpenWay CENTRON meter. 

There are no inputs required for this test. 

The following items are displayed in the test results: 

Pass/Fail indication if following steps succeeded: 

 Perform a Disconnect 

 Check the Load Side Voltage Status – Should be False 

 Perform a Connect 

 Check the Load Side Voltage Status – Should be True 
 

 

Clear Billing 

This tool provides a way to clear the billing registers once all testing is complete. This test is typically done in 

conjunction with Clear Activity Status (on page 175). There are no inputs required for this test. The following 

items are displayed in the test results: 

 Show Energy Registers  

 Perform the Clear Billing  

 Show Energy Registers again to show they have been cleared. 
 

 

Clear Activity Status 

This tool provides a way to clear the activity status once all testing is complete. This test is typically done in 

conjunction with Clear Billing (on page 175). There are no inputs required for this test. The following items 

are displayed in the test results: 

 Clears Demand Reset Count  Display Demand Reset Count 

 Clears Outage Count  Display Outage Count 

 Clears Program Count  Display Program Count 

 Clears Inversion Tamper  Display Inversion Count 

 Clears Removal Tamper   Display Removal Count 

 Clears Event Log  Display Event Count 
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ZigBee was created to address the market need for a cost-effective, standards-based wireless networking 

solution that supports low data rates, low power consumption, security, and reliability.  

ZigBee Protocol is the set of specifications built around the IEEE 802.15.4 wireless protocol. 

For more information on ZigBee, ZigBee Protocol, and the ZigBee Alliance, refer to the ZigBee Alliance 

website (http://www.zigbee.org). 

The ZigBee Device Manager application consists a single view displaying the status of the Radios. 
 

Starting ZigBee Manager 

From the Windows Start menu, select Programs > OpenWay Tools > ZigBee Device Manager.  

 

Be sure that a ZigBee dongle is attached to the PC before you open the ZigBee Device 

Manager. 
 

 

Navigating the ZigBee Manager 

Navigation in the ZigBee Device Manager is mouse-driven. Hyperlinks allow you to automatically open 

existing radios. 

The following buttons are available on all windows: 

Icon Description 

 

Field-Pro. Launches Field-Pro to communicate with meters. 

 

ZigBee Manager. Launches the ZigBee Device Manager. 

 

Export. Click this icon to export the current data. 

 

Print. Click this icon to print the current screen. 

 

Online Help. Click this icon to open the online help. 

 

Itron Metering Website. Click this icon to automatically go to the Itron Metering website. 

 

Some windows allow you to resize columns in case a description or value is too long to fit into the default 

column width provided. To expand a column, use the mouse to drag the column width to the desired width. 

The "+" and "-" buttons allow you to expand or contract individual sections. 
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Using the Itron Button 

The Itron button allows a user to perform basic operations. The Online Support includes a link to the Itron 

User Forum (Knowledge Exchange) as well as Technical Support and the Itron Metering website. 

 
 

Testing to see whether the heading has text.  It's supposed to be empty. 
 

Radios 

The Radios panel displays a list of all the ZigBee radios that are connected to the PC. It shows radios 

connected through a USB port. The Itron Belt Clip Radio must be connected to the PC using a USB cable.  

When a new radio is connected to the PC it is automatically added to the radio list. This list of radios can also 

be cleared and repopulated at any time using the Refresh button at the top of the view. 
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Reset Radio 

The Reset Radio option is available when one radio is selected. 
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Accelerometer 

 micro-electronic mechanical sensor (MEMS) that detects motion in three planes. 
 

advanced meter 

An electric meter that is capable of measuring and recording usage data in time differentiated registers. This 

meter allows electric consumers, suppliers and service providers to participate in price-based demand 

response programs and provides data and functionality to address power quality issues. 
 

Advanced Metering Infrastructure (AMI) 

The communications hardware and software and associated system and data management software that creates 

a network between advanced meters and utility business systems which allows collection and distribution of 

information to customers and other parties such as competitive retail suppliers, in addition to the utility itself. 
 

Advanced Metering System 

A system that collects time-differentiated energy usage from advanced meters via a fixed network system, 

preferably two-way, on either an on-request or defined schedule basis. The system is capable of providing 

usage information to electricity customers, utilities and other parties on at least a daily basis and enables them 

to participate in and/or provide demand response products, services and programs. The system also supports 

additional features and functionality related to system operation and customer service, e.g. outage 

management, connect/disconnect, etc. 
 

ANSI C12.22 

An application protocol designed to carry ANSI C12.19 table data over a network. 
 

Automatic Meter Reading (AMR) 

Automatic Meter Reading system where aggregated kWh usage, and in some cases demand, is retrieved via 

automated means such as a drive-by vehicle, or walk-by hand-held system.  
 

Baud 

Unit of data transmission signaling speed, roughly analogous to bits per second (bps). 
 

Broadcast Message 

A message destined for all nodes in the network. 
 

Calendar Schedule 

Schedule that determines items such as seasonal changes, Daylight Saving Time (DST) changes, holidays, or 

daily switch points. 
 

Glossary 
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Cell Relay 

An OpenWay communication device that routes messages between the smart meters that make up its cell and 

the OpenWay Collection Engine (CE).  
 

ChoiceConnect® 

Itron’s comprehensive suite of ERT module-based automated meter reading (AMR) systems. ChoiceConnect 

includes walk-by, drive-by, and fixed network meter data collection solutions, all using Itron’s 900-MHz 

endpoint technology. 
Itron produc t names|  

 

Continuous Cumulative Demand 

The sum of the previous billing period maximum demands and the present period maximum demand. 
 

Critical Peak Pricing (CPP) 

A type of dynamic pricing whereby the majority of kWh usage is priced on a TOU basis, but where certain 

hours on certain days where the system is experiencing high peak demand are subject to higher hourly energy 

prices that reflect market conditions for peak generation and delivery during peak demand periods. These 

critical period prices may be known to electricity customers under conditions such as “day-ahead” or “hour 

ahead” and are typically employed a limited number of times per year. 
 

Cumulative Demand 

The sum of the maximum demand values at each demand reset since the cumulative register was cleared. It is 

updated at each demand reset by adding the maximum demand register to the cumulative register. 
 

Daylight Saving Time (DST) 

The practice of advancing the clocks one hour in the spring and setting them back one hour in the fall. In the 

United States, Daylight Saving Time (DST) begins on the second Sunday of March and ends the first Sunday 

of November. Each U.S. time zone switches at a different time. 
 

Demand 

The average value of power over a specified interval of time. Demand is expressed in kilowatts, 

kilovoltamperes, kiloVARs, or other suitable units. An interval may be 5, 6, 10, 12, 15, 20, 30, or 60 minutes. 
 

Demand Delay 

Also referred to as Cold Load Pickup (CLPU). The configurable amount of time required before demand 

calculations are restarted after a power outage. 
 

Demand Interval 

The specified time over which demand is calculated. 
 

Demand Reset 

When all the current maximum demands are set to zero. 
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Demand Response 

Demand response refers to the reduction of customer energy usage at times of peak usage in order to help 

address system reliability, reflect market conditions and pricing, and support infrastructure optimization or 

deferral. Demand response programs may include dynamic pricing/tariffs, price-responsive demand bidding, 

contractually obligated and voluntary curtailment, and direct load control/cycling. 
 

Demand Subinterval 

The smaller blocks of time that are used in rolling demand calculations. 
 

Demand Threshold 

A configured value that, when exceeded by calculated demand, initiates a contact closure, a log entry, or a 

phone home event. 
 

Firmware 

The computer program stored in a read-only memory (ROM) or an erasable programmable read-only memory 

(EPROM) integrated circuit. 
 

Head End System 

The head-end system receives the stream of meter data brought back to the utility by an AMR system. Head-

end systems may perform a limited amount of data validation before either making the data available for other 

systems to request or pushing the data out to other systems. Head-end systems typical interact only with 

billing systems. The Itron Network Collection Engine is one example of a head-end system for AMR 

solutions. 
 

History Log 

Log used to record historical events that occur in the meter. The events to be logged must be configured via 

the Configuration Editor software. 
 

Home Area Network (HAN) 

For Itron metering purposes, refers to the network into the home that allows load control and other functions. 

See ZigBee. 
 

IDM 

The Interval Data Message (IDM) contains consumption data for timed intervals that can be used for 

calculation of demand and Time of Use billing. 
 

In-home Display 

An easy to use, AMI (Advanced Metering Infrastructure) ready display that allows consumers to closely track 

their electricity consumption and receive messages or alerts from their utility provider. The LCD display 

shows messages that are clear and intuitive, making it easy for consumers to manage their energy usage and 

costs in real-time and wireless communication allows for use anywhere in the home. Messages are generally 

from a residential smart meter using the ZigBee® Smart Energy Profile. 
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Internet Protocol (IP) 

Refers to the core protocol that defines the basic packet structure for transport over the internet. Examples of 

technologies that use IP protocol are Ethernet, GPRS, WiFi, WiMax. etc. 
 

Itron Security Manager (ISM) 

A component of Itron Security Manager suite. Utilities use ISM to facilitate encryption, authentication, 

decryption, and validation of meter reading data and commands to and from Itron ChoiceConnect endpoints. 

ISM also manages the key exchanges and security state for endpoints and repeaters. 
Itron produc t names|  

 

LAN Radio 

Itron metering component that converts an electricity meter into a node of a wireless mesh network; thus, 

conveying the metering data to a cell-based extraction point. 
 

LED 

A Light-Emitting Diode (LED) is used to signal the occurrence of an event or the presence of a pulse. 
 

Load (Service) Limiting 

Load (service) limiting is triggered by the present demand threshold value.  When the load exceeds the 

programmed value for demand threshold, the customer will be disconnected.  The meter will remain 

disconnected for a programmed number of minutes up 65535.  A programmable setting specifies if the 

homeowner can override their disconnected service by pressing the switch on the face of the meter. 
 

Load Profile 

The functionality of a meter to accumulate pulses in proportion to accumulated energy in configured intervals. 

Often referred to as Mass Memory. 
 

Local Area Network (LAN) 

A data communications network which is confined in a limited geographical area. For Itron metering 

purposes, the connection between electricity meters and collection points that contain backhaul technology 

back to the head end system. 
 

Maximum Demand 

The largest demand calculated during any interval over a billing period. The Maximum Demand quantity 

displayed in Test Mode is that value calculated over the test interval only (this can differ from the Normal 

Mode demand interval). 
 

Normal Mode 

One of the operating modes of the meter. It includes all routine meter operations. 
 

Optical Port 

Optical interface located on the face of the meter. The meter can be configured and communicated with 

through the optical port. 
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Power Outage Notification 

The Itron Power Outage and Restoration solution provides utilities with the most reliable, precise and easily 

managed AMR/AMI-based outage detection and restoration notification system available in the industry.  

When deployed as an integral component of Itron Fixed Network 2.0 meter reading technology, outage and 

restoration alerts based on programmable parameters are transmitted immediately from CENTRON Solid-

State R300 meters and processed by the network to quickly pinpoint the location and determine the extent of a 

power outage. That report can then be passed immediately to the utility’s Outage Management System (OMS) 

to expedite response and optimize dispatch of restoration resources. 

The Power Outage and Restoration solution helps utilities reduce outage duration, increase system reliability 

and improve overall customer satisfaction. 
 

Real-Time Pricing 

Energy prices that are set for a specific time period on an advance or forward basis and that may change 

according to price changes in the generation spot market. Prices paid for energy consumed during these 

periods are typically established and known to consumers a day ahead (“day-ahead pricing”) or an hour ahead 

(“hour-ahead pricing”) in advance of such consumption, allowing them to vary their demand and usage in 

response to such prices and manage their energy costs by shifting usage to a lower cost period, or reducing 

consumption overall. 
 

Register Multiplier 

A configurable value which is used in calculations of displayed energy and demand readings. This can be used 

by setting the register multiplier equal to the CT ratio times the PT ratio of the installation. 
 

Remote Disconnect/Connect 

See Service Disconnect Switch Control. 
 

RFLAN 

For Itron metering purposes, refers to the Itron proprietary two-way network. Connection between electricity 

meters and collection points that contain backhaul technology back to the head end system. 
 

RFLAN Protocol 

An implementation of Itron proprietary wireless mesh network protocol based on the LinkNet2 specification. 
 

Rolling Interval Demand 

A calculation of maximum demand derived from the moving average of the smaller consecutive subintervals. 
 

Season 

A configurable amount of time that a rate schedule is in effect. Season start dates are configured in the format 

MM/DD (Month/Day). 
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Self-reading Registers 

Register data that is captured in the meter at a configured interval of time and is stored in non-volatile 

memory. 
 

Service Disconnect Switch Control 

A device that provides the ability to remotely disconnect and reconnect power to residential electric meters. 
 

Service Limiting 

See Load (Service) Limiting 
 

Sliding Window Demand 

A calculation of maximum demand derived from the moving average of the smaller consecutive subintervals. 
 

Smart Meter 

A term used to refer to an advanced meter.  See Advanced Meter. 

 
 

Test Mode 

A mode of register operation. It allows testing of the register without altering billing data. 
 

Time of Use (TOU) 

A metering method which records demand during selected periods of time so consumption during different 

time periods can be billed at different rates. 
 

VT Ratio 

The voltage transformer ratio to use for viewing voltage quantities for a service point. 
 

Wide Area Network (WAN) 

For Itron metering purposes, refers to the backhaul communications link to the collection system and head-

end software application. 
 

ZigBee 

Communications network specification created by an alliance of sensor manufacturers, semiconductor 

manufacturers, and end users. For Itron metering purposes, the application chosen to run the Home Area 

Network (HAN) to create an open system between the meter and the home to facilitate appliance load control 

in a utility demand response program. Examples include water heater, HVAC control, and an in-home display 

unit. 
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